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Chapter 1

1.1. Introduction

Components of the Stereoscan 440

The Stereoscan 440 is a software-conh'olled scanning electron microscope, whose
major components are (see Figure 1.1)

Figure 1,'

1.1.1. The Column and Chamber

The Stereoscan 440 column is used to generate and focus a fme beam of electrons
upon the specimen mounted in the specimen chamber. The electron gun has a
thermionic emitter as a source of electrons - the normal source is a tungsten

hairpin filament, although the Stereoscan 440 may have the lanthanum
hexaboride LaB6 option fitted (recognised by the presence of two valves - one at
the interface of column and chamber, the other near the top of the gun pumping
tube - and an ion pump mounted at the rear of the gun). Three electromagnetic
lenses beneath the gun, focus and shape the electron beam before it strikes the
specimen in a scanned, or rastered, fashion. The energy of the electron beam is
adjustable from 300 volts to 30 kilovolts in 10 volt steps and the electron beam
current is continuously adjustable from 1 pico-amp to 1 micro-amp to suit the
type of examination in progress.
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The specimen chamber of the Slereoscan 440 holds the specimen to be viewed in
such a way that it may be freely manoeuvred during examination. The ~n
stage which holds the specimen is attached to the door of the chamber and may
be of the normal cartesian type or the Optional eucentric type. The cartesian stage
pennits movements of lOOmm in both X and Y directions, 3Omm in the Z
direction, 0 to 9(}° tilt and 360° rotation. Control of the stage move~nts may be
either manual, from the front of the stage door. or motorised using the Optional
stage motorisation package. The stage may be opened for examination once the
vacuum within the chamber has been released.

1.1.2. The Vacuum System

The operation of the electron optical column and specimen scanning is dependent
not only on the presence of a vacuum, but also the degree of vacuum, i.e. the
system is safely interlocked so that it is not possible to switch on any of the high
voltages until an adequate vacuum is reached.

The vacuum system is simple and efficient. A turbomolecular pump, backed by a
rotary pump, is mounted on the lower face of the specimen chamber and
commences pumping when the system is being evacuated and comes to rest
during system venting. The electron gun and column are pumped through the
tube running from the left side of the chamber up to the gun section. The only
valve in this system is the air-admittance valve attached to the rear of the
chamber, which automatically opens when venting is requested. Normal
operating vacuum should be in the range to 10-4 to 10-6 torr. No water cooling is
required.

If the lanthanum hexaboride option is fitted. a greater degree of vacuum is
required in the gun section and for this reason provision is made to independently
pump the gun and column to a level of about 10-7 torr using an ion-getter pump
The pump is mounted on the rear of the gun section and the column may be
isolated during specimen exchange by the two valves associated with the LaB6
option.

1.1.3. The Control Console

Complete software control of the Stereoscan 440 ~ that operation of the
instrument is rather like operating a desktop computer - all operations are

controlled through the moose and keyboard. Within the console of the
microscope, the computer is used to communicate your operations and commands
into actions by the SEM. The PC environment used is Microsofi@

WindowslM 3.11 and the SEM control application (LEO) runs within this well
known and easy to use system. Section 1.2 provides an introduction to
Window~ and how to use the system of Help provided. If you are unfamiliar
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Selecting Help from a Menu

Where Help is displayed in a menu (e.g. at the extreme right of the LEO top
window) selecting it will display the index to help relating to that window.

Selecting Help from a Button

Where a button labelled Help appears in a dialog box selecting it will display an
index of help relating to the dialog box functions.

Context Sensitive Help

This is frequently the most useful method of using Help.

To select this mode press the shift key and while holding it down press special
function key Fl.

While in Context sensitive help mode the cursor will be displayed as

wherever help infonnation is provided. In this mode mouse selections do not
perform their normal operations but display help on the specific item selected

Some examples of what may be selected are:-. A menu item - describes its function. A window background - describes the function of the window
. A displayed parameter - describes the parameter. and under what

conditions it is enabled (useful to discover why a parameter is greyed
out).. A toolbar Icon - describes it's function.

. A Panel Background - describes its use and components

To switch off Context help mode press the <&c> key while the context help
cursor is displayed.
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The User Interface

Overview

The user interface is used to control the Stereoscan 440 and is a nonna!
WindowslM application. The minimum that may be on display is the Top
Window within which appears the Image Window. Other components may be
called up as required, either explicitly (eg by menu selection) or implicitly as an
implied response to some action or event. When the system is started up, you will
also usually have the Toolbar displayed.

The Mouse

FIgUre 1.2

The mouse is the primary adjustment and selection control of the microscope. As
such there are carefully defined conventions governing its use:-

Selection and Dragging1.

The nonnal Window~ convention of pointing and clicking with the left mouse
button is used for menu selection, dragging and sizing of objects.

For example, the status window can be selected from the View menu by clicking
with the left mouse button on View in the menu bar and then clicking on the
status entry. The position of the status menu can then be altered by clicking on
the title bar of the status window and moving the mouse with the left mouse
button held down.

2. Icon Selections

The left mouse button is also used to select icons. Selecting an icon will either
assign the adjustment parameters (displayed in the top right comer of the
toolbar), or cause the icon to execute immediately.
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1-6 ~pter 1 ~g Started

Examples of ~ter assignment icons include the EHT icon, the Signal Level
icon and the Mag/Focus icon. Immediate action icons include Scan Rate + and -
icons and the Start icon.

3. Parameter Adjustment

The left and middle nK>Use buttons are used for ~ter adjustment when the
cursor is over the image window while adjust mode is selected. To adjust the
parameter displayed in the toolbar:-. Move the cursor over the image area.. Select the left nK>Use button for the left toolbar ~ter. or

. Select the middle mouse button for the right tbolbar parameter.

. Move the nK>Use to the left (while holding down the IIK)Use
button) to decrease the parameter. or to the right to increase the
parameter.

There are two speeds of adjustment available, coarse and fine. The selected
speed is displayed to the left of the adjustment parameters in the toollHlr.
with « » for fine and « < > » for coarse. The speed can be toggled by
pressing the 1Gb key.

For example. to adjust the magnification. select the Mag/Focus icon. This assigns
magnification control to the left mouse button. Now move the cursor over the
image and press the left mouse button. By holding the button down and moving
the mouse to the left. the magnification can be decreased. A movement to the
right will increase the magnification.

Some parameters such as Gun Align and Stigmatioo provide adjustment in both
the X and Y directions. This is indicated by the appearance of the adjustment
icon in the bottom left comer of the image.

Pop-up Menus4.

The right DnIse button is used to display a pop-up !Mnu while over the image.
Once the pop-up menu has been displayed. all selections on it are made with the
left mouse button.

The image is not the only interface component which has a pop-up menu
associated with it. Most objects which do not have their own menu have a
pop-up menu which is displayed with the right mouse button.
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5. Panel Selection

There is one other use for the right mouse button which is to bring up the control
panel associated with each icon. This is done by putting the cursor over the icon
and selecting the right mouse button.

~~
The control panels are not unique to the icon, so more than one icon may
bring up any given control panel.

Once the conb'Ol panel has been displayed selections can be made with the left
mouse button.

With the mouse pointer positioned over the image, the right mouse button obtains
a pop-up menu allowing further mode selection, eg Annotation.

A little practice will be required to gain familiarity with the three button mouse.
However. it is an extremely quick and convenient method of SEM control.

1.3.2. The Keyboard

In addition to mouse control of parameters, many keyboard keys have been
assigned special functions and these can sometimes be a valuable aid to
instrument operation. The keys have been designated (also to be found by
pressing F9 - keys Help) as follows:-

Fl Help (see 1.2)

Fl + Shift Context sensitive Help (see 1.2)

F2 Performs a lens hysteresis correction for all column lenses. This has
the effect of improving the accuracy of both the Probe current indication
and the magnification, which in turn improves the accuracy of on-screen
measurement.

F2 + Shift Toggles the toolbar at the top of the screen on and off.

F3 Closes all additional Windows other than the toolbar and status
window. This also closes any currently iconised Windows.

F3 + Shift Toggles the PC-plane (ie the Windows plane) on and off.
When the PC plane is off, the space bar can be used to switch it back on.
This is particularly useful for viewing the full size image without
obstruction by any menus which might need to be kept open.
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~ AU keyboard commands remain active.

F4 is used to step through each entry in the magnification table (Tools
Mag Table). Selection of a mag-table entry does not lock out normal
operation of the instrument.

F4 + Shift exits from mag-table mode. Re-entry into mag-table m<x!e
then re-commences at the first entry.

FS,F6,F7,F8 (with or without shift) Executes the installed macro (if it
exists). If the macro docs not exist. a 'beep' is given.

F9 Help on key usage

FII Selects the Annotate/Measure function and toggles between Move
and Edit modes.

FII + ShJft Toggles the Datazone overlay on and off.

F12 Stage scan step to next field.

F12 + Shift Stage scan step to previous field.

Tab Toggles coarse and fme adjustment mode « > to« ».

<Ctrl>+<Tab> Centre point.

<Home> Resets Beam shift to zero

<ScroD Lock> Toggle freeze

<Pause> Pauses/resumes execution of a macro

. Performs a Fmd Image function

Esc Aborts Stage movement or current Macro execution or context
sensitive help mode.

A Performs a combined auto-stigmation and fme auto focus routine
This may be aborted by pressing the Esc key.

A + Shift Performs an auto stigmation routine
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B If B is pressed. the arrow keys may be used to conttol Beam Shift, or
fine image movement.

F starts a fme autofocus routine. This may be aborted by pressing the
Esc key.

The area used for autofocus, a reduced area at the centre of the screen,
may be moved after obtaining the image pop-up menu and selecting Focus
Area.

F + Shift Performs a coarse auto focus routine.

<Ctrl> F Starts a focus scan where the focus distance is cycled between
limits. The space bar is used to stop the cycle.

G Auto Gun Alignment.

I If I is pressed the arrow keys may be used to adjust the two parameters
currently displayed in the image window. The left/right keys decrease
and increase the left parameter and the up/down keys increase and
decrease the right parameter. If the arrow keys are temporarily allocated
to any other parameter (eg by pressing B.M.S or Z). the keys may be
returned to the default mode by pressing I.

M If M is pressed the arrow keys are temporarily assigned to control
magnification and focus. The left/right keys increase and decrease the
magnification whilst the up/down keys increase and decrease the focus.

Optibeam is switched on, focus means Working Distance. If Optibeam is
off', focus means C3 lens current.

S If S is pressed the arrow keys can be used to control the Stage XY
position, or stage tilt/rotate position if shift is used with the arrow keys.

S+Shift If this key sequence is pressed the arrow keys can be used to
control the Step field.

V Displays the vacuum status panel.

Z If Z is pressed the arrow keys are temporarily assigned to control the
stage Z position. While an up or down arrow key is held down, the stage
moves in the appropriate direction, with the speed controlled by the
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coarse/fme selection (tab). If stage motorisation is not installed, this
function has no effect.

+ is used to increment through the available scanning rates.

- is used to decre~nt through the available scanning rates.

Space is used to reveal the PC plane if hidden by shift F3 or to stop a
focus scan started by <Ctrl> F.

Alt followed by arrow key movements allow navigation of the pull-down
menus of the currently selected (highlighted in the title bar) window.

~ These key designations are in addition to the keys already designated for
WindoWSTM operation - consult WindowSTM Help for a list of these keys.
One particularly useful keyboard shortcut is AltI1'ab which enables fast
switching from one WindowsTM application to another. To use, hold down
the All key and repeatedly press Tab until the title of the required
application is shown and then release the All key. The selected application
then becomes the current application.

1.3.3. The Top Window

11

1

FIgUfe 1.3 Top ~
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The top window, see Figure 1.3, provides the environment within which the other
Windows reside. It contains:-

The caption bar, which displays the Version number of the
LEO software in use together with the release date. In some
circumstances, the caption bar displays messages to the user.
The System button pennitting the system to be shutdown or put
into Standby mode.
The minimise button which enables the user interface to be
iconised while leaving the SEM operational.
The reduce/full size button allows you to work with the Top
Window at a reduced size or at full screen size by alternate
clicks.
The top level ~u from which all system operations may be
selected. Help may also be selected from this level. Context
sensitive Help (shift-Fi) may be used to obtain help on each
function.

The Image Window

The image window is used to display the live image. and may either occupy the
whole screen or a quarter of the screen as selected by the top menu selection
View->Full screen image. When in quarter screen mode it may be moved with
the mouse by dragging the caption bar. The caption bar indicates the current
mode and implies how the mouse is to be used.

Quarter screen mode is especially useful when other Windows - such as the
profile window, status window, etc - must all be displayed simultaneously with
the image since they can be positioned so as not to obscure any of it.

The Too/bar

The toolbar, see Figure 1.4, is displayed at the top of the main window and
provides access to commonly used functions. The toolbar consists of a fIXed
portion and a variable portion. The fIXed portion makes up the right half of the
toolbar and displays the current mouse adjustment parameters (eg Mag and
Focus), the state of the vacuum system (eg Ready, Venting or Pumping), the state
of the E}fr system (eg Beam On, Beam Off or Standby), coarse/fme adjustment
icon « > for fme,«» for coarse) and the identity of any currently executing
macro function.
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FIgUre 1.4 Toolbar

The variable portion contains icons which may be selected with left or right
mouse buttons to perfOmt required operations. A standard set of icons is
provided, although different sets of icons may be loaded according to the
application requirements and operator skill level, ie Novice or Expert. Novice
mode provides three rows of large icons whilst Expert mode provides two rows of
small icons. The operational convention adopted is that the left mouse button
initiates an action or adjustment mode, the right button displays a panel
associated with the selected function which may be used for more detailed setting
up or control.

The toolbar itself may be disabled from the top menu View->Toolbar.

1.3.6. Other Components

As a result of menu actions or other events, various other interface components
may be displayed. These are:-

Status Window

The Status Window, see Figure 1.5, displays a user selected group of insttument
parameters which are continuously updated.

Figure 1.5 Status Window
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Individual items can be selected or deselected from within the status IrenUS select
window. In addition files of status menu selections can be saved and loaded from
within the Status File Menu.

Datazone

The datazone displays infomJatioo concerning the current state of the system,
and since it is a fonn of annotation (displayed in the overlay plane), it may
therefore be included in exported and hard-copied images etc.

The datazone is only displayed in full screen image mode. Its contents and
position is user definable from within the annotation plane conttol pop-up menu.

The datazone may be switched on and off from the main window menu selection
View->Datazone.

Magnification Control Window

This window. see Figure 1.6 may be invoked from the top menu
Image->M8I/Foc function and is used to set the base magnification of the
instrument to a specific value. The use of the magnification conb"ol window is
fully described in Section 2.3.4 Setting Focus and Magnification.

Figure 1.6 Mag1ification Control Window

Navigation Box - (Top menu selection Vklll->Nav box)

The navigation box, see Figure 1.7, provides visual indication of the range and
current value of one and two di~nsional parameters. Any variable may be
selected to the Navbox by selecting the parameter within the status window or
tooIbar, however not every parameter is well suited to this type of control (e.g.
parameters with non-linear control characteristics such as magnification and
probe current).
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FIgUte 1. 7 Na~ Box

The edges of the box represent the limits of the variable range (eg - 100%, +
100%) and cross hairs indicate the centre of the box, not necessarily the centre of
the range. The cun-ent parameter value is indicated by a red marker. The
parameter value may be adjusted by dragging the marker to the required position.
Alternatively the X and Y values may be individually adjusted using the scroll
bars and the parameters set to zero using the origin button (labelled with 0) at
the junction of the X and Y scroll bars. H this button is selected the current
parameters are set to zero.

This method of adjustment is also to be found within control panels such as
Stigmation.

]Stage Window (if stage molorised)

This Stage Window, see Figure 1.8, represents the XY co-ordinate space of the
stage and provides both joystick and absolute move~nt facilities for a motorised
stage. Pressing the right mouse button over the window displays a popup ~nu
which gives access to the stage functions from which co-ordinate storage (if
installed) can be obtained.

Move~nt of the stage is controlled by dragging the blue dot within the stage
window. The blue dot represents the joystick and its deflection causes the stage to
move in the direction of deflection. The speed of stage move~nt is linked to
both the extent of joystick deflection and the current image magnification. For
further infonnation on Goto mode and co-ordinate storage, see Appendix E,
Options . 1
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Shutting Down

When a working session on the microscope has fmished and the microscope is to
be left overnight, over the weekend or longer, there are two ways to close down
the system:-

Standby

This is the reco~nded state to leave the system in overnight and is again

selected from the system button at the top left of the screen. Note that this is a

software standby, not to be confused with the standby button above the disk drive

which switches off power to the computer. Having selected SEM Standby, the

software puts the SEM into standby JIl(xje. This includes setting the EIff, Lens

cun-ents, HRRU (if fitted), imaging and overlay planes to standby conditions.

This is indicated by the user interface iconising with the text SEM Standby.

Shutdown

If
This is the recommended state to leave it for two days or longer. Click on the
system button at the top left of the screen and select SEM Shutdown. You will be
asked if you wish to save the cun-ent operating conditions - if you choose yes,
then the conditions are stored in a file called Restore.Leo, which is a macro and
can be used to restart the system later. The software then goes through a
controlled shutdown, during which important files are written to disk - on no
account press the Standby button or power off at this point. When the Program
Manager can again be seen, close this down in the same way i.e. from the system
button, then press the Standby button. Starting up again is then as described in
Section 1.4.1 To Obtain an Image later in this Chapter.

~ It is quite a good idea either to switch off the viewing monitor or switch on
a screen-saver (such as provided in the Program Manager/MainiControl
PaneVDesktop menu) to prevent any burning of the screen.

Some Important Do's and Don'ts1.3.8.

11DO

.

.

.

Use the softw~ routines provided for shutting down and standby mode
Check filament saturation. as described. after the first runup of a new
session
Create user directories as necessary and keep all user data within them
Read the Help provided. It is there for your guidance
Try to keep a note of any important error messages for diagnostic

purposes
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Call your local Leica customer care office in the event of problems
Keep the chamber door and gun "0" rings clean

DON'T

. Fill the hard disk with images, use floppies where possible or use a mass
storage disk
Try to edit or alter, in any way, the system ftles. This will cause

operational problems
Try to install any peripheral without fIrst seeking advice from Leica

Cambridge

Common Operating Routines

To Obtain an Image

Before commencing to turn on the filament there should be a sample inside the
chamber and there should be a satisfactory vacuum, i.e. Vacuum Ready
displayed. The vacuum status and operating status are displayed towards the
right of the toolbar.

If the vacuum is satisfactory Ready will be displayed, and the operating status
will display Shutdown. If the operating status displays Beam Off, this indicates
that a run-up file has been loaded but the filament has subsequently been turned
off.

After loading the control program the image area may be displayed at 1/4 full
screen size. The operator may. at any time. change the displayed image to full
screen size. This can be done by selecting View (with the left button) from the
top row of the toolbar and then selecting Full Screen Image from the drop down
menu. Similarly the datazone can be displayed by selecting Datazone from this
~ drop down menu.

~ The datazone will not be displayed while the image area is displayed at 1/4
full screen size, and while this mode is set the option of displaying the
datazone is greyed out, so that it cannot be selected.

Clicking with the left button over the Run Up icon

will cause a macro called RESTORED.LEO to be loaded and executed. n is the
ordinal number of the current filament type (eg Tungsten = 0). This macro holds
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all the operating conditions of the SEM and corresponds to the last set of
operating conditions that were saved when the microscope was shutdown.

Should the operator require other specific operating conditions please refer to
Saving and Loading Conditions in Section 3.7.2.

This operation will take several seconds, during which time the macro will
appear and then be executed. When the macro has been removed and BEAM ON
displayed in the toolbar the SEM is ready to use. Nmmally there will be so~
form of recognisable image displayed on the screen, at worst it may show only as
a change in signal brightness.

The following steps should provide the operator with an image of the sample with
which to work.

Adjust the Image Brightness to a Suitable Level

Set the mouse control to Brightness and Contrast control by clicking with the
LEFT button over the icon

With the mouse pointer over the image hold down the LEFT button and slide the
mouse either left or right to decrease or increase the image brightness to a
satisfactory level.

Select a Very Low Magnification, i.e. about lOX

Set the mouse control to Magnification and Focus by clicking with the LEFf
button over the Mag/Focus icon. Then, with the mouse pointer over the image
hold down the LEFf button and slide the mouse to the left to reduce the
magnification. The value of the magnification will decrease while this operation
is continued, or repeated, until the minimum value is attained. .
Focus the Image

Unless already selected. set the mouse conb"Ol to Magnification and Focus
control. by clicking with the Left button over the Mag/Foc icon. Place the mouse
pointer over the image and hold down the CEN1RE button and then slide the
mouse to the left or right until the image beco~s more recognisable and into
focus.

.
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If difficulty is experienced, note the value of the focus displayed in the toolbar.
Most samples will usually be in focus somewhere within the range 5mm to
30mm. If the sample is out of the field of view altogether, then an image of part
of the stage mechanism or even of the mesh covering the turbo-molecular pump,
may be produced, to do this a focus distance greater than about 3Omm is required.
If this is the case, the sample will have to be moved into the field of view by
manually moving the stage X and Y controls mounted on the door of the
chamber. The simplest thing is to move the controls until both X and Y position
counters indicate approximately 0500. This will place the stage at the centre of
its travel and, if a single stub is mounted in the chamber this will now be under
the beam, or if the carousel is present, the centre of this will be under the beam.
Repeat the above focusing operation to achieve a recognisable image.

Optimisation of Settings

Once a recognisable image has been obtained the operator can optimise the
conditions prior to examining the sample in detail. The following procedures
should be done at the start of a session, but any part of the following can be
repeated subsequently, should the operator feel it necessary.

Setting kV and Probe Current

The accelerating voltage to be used will depend greatly upon the sample being
examined, and will require some experimentation by the operator to achieve the
best results. As a rough guide, uncoated non-conductive samples should be
examined using between I and 3 kV, non-conductive but coated samples should
be examined using between 5 and 15 kV and conductive samples can be
examined using between 10 and 25 kV.

It is recommended that inexperienced users start with a conductive sample and
set the accelerating voltage to 15 kV and the probe cwrent to 200pA.

To Adjust the kV

Set the mouse connot to kV and probe current connot by clicking with the Left
button over the icon

The current values of the k V and probe will be displayed in the toolbar. Then
with the mouse pointer over the image. hold down the Centre button and slowly
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move the mouse to the left or right to decrease or increase the kV to the desired
value.

To Adjust the Probe Current

If not already active, set the IOOUse control for kV and probe adj~nt by
clicking on the icon with the Left button. With the mouse pointer over the image
hold down the Left button and slowly slide the IOOUse to the left or right decrease
or increase the probe current to the desired value. It may then be necessary to
adjust the brightness of the image as described above.

The value of the probe cun-ent chosen will affect the signal to nQise level within
the displayed image, and also the achievable resolution. A large probe cun-ent
will produce a good noise free image, but it will not be possible to obtain good
resolution at higher magnifications, and conversely a low probe cun-ent will
enable high resolution images to be obtained but the image will beco~
progressively more noisy as the probe current is decreased. Inexperienced
operators may choose to run in the Auto-probe mode when the magnitude of the
probe cun-ent is varied as the magnification is changed, see Section 2.3.2 Setting
EHT and Probe Curren/.

~: Any parameter assigned to mouse control may be set directly by double
clicking on that parameter display in the toolbar. A number entry box
appears allowing the value to be typed in.

Setting the Filament Current and Beam Alignment

Simple Alignment

The optimum alignment of the beam down the column may be checked at any
time by clicking with the Left button over the icon

and then with the mouse pointer over the image hold down the Left button and
slide the mouse to the left or right and up or down until the brightness of the
image is at a maximum. This is a quick. way of checking the alignment during
operation having first carried out a full alignment at the start of a session or when
the filament has been changed, as described below.
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Filament Setting

The setting of the filament current will have a large effect of the brightness and
stability of the image, as well as influencing the lifetime of the filament. As the
filament current is increased the brightness of the signal increases until a small
plateau is reached, this is known as the "flfSt peak" (see Figure 1.9), increasing
the filament further will again cause the signal brightness to increase until
another plateau is reached, further increase of the filament current will not
improve the signal brightness, this is referred to as the fully saturated condition.
The lifetime of the filament decreases as the filament current increases, there is
no advantage in increasing the filament current above the just saturated
condition.

Figure 1.9 First Peak

The filament should be operated at one of two conditions, either at the first peak
setting or where the filament has become just fully saturated. These two
positions will provide conditions for stable brightness operation. Operating at the
first peak setting will give a long filament life, but is not satisfactory for high
resolution imaging, while the fully saturated condition will give the brightest
signal and allow the best resolution images to be obtained, but the lifetime of the
filament will be reduced. The above conditions can easily be achieved by using
the Emission Image mode.

Emission Image Mode

Using the Right button, click on the align icon, this will display the Gun
Alignment panel. With the Left button, select Emission Image to switch the
display into the emission imaging mode. This enables the operator to determine
the setting of the filament current by the image displayed on the screen. The best
effect will be achieved if the beam is NOT focused on the sample. The emission
image will vary as the filament current is changed. The images corresponding to
First peak and fully saturated, which are shown in Figures 1.10 and 1.11
respectively.
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FIgUre 1.10 Image of First Peak Setting

The filament current may be varied by using the associated scroll bar within the
Gun Alignment panel. either by SLOWL Y dragging the slider in the appropriate
direction. or by clicking over the arrow at the appropriate end of the scroll bar.

of) This should be done carefully and slowly, otherwise a blown filament may
result.

Alignment

For the best performance of the microscope the electron beam should pass down
the column along the electron optical axis, and any aperture in use should also be
centred about this axis. As no column can be perfect, various adjustments are
provided to compensate for this.

Final Aperture Alignment

The centring of the final aperture can easily be checked by having a recognisable
feature at the centre of screen and then taking the focus through focus and back
again. When aligned. the image will only rotate and not shift laterally. If the
aperture is mis-aligned the image will move backwards and forwards across the
screen in a slight arc. If the aperture is mis-aligned it will be necessary to move
the position of the aperture using the X and Y micrometers on the side of the
column until the image ceases to shift laterally.
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Focus Wobble

To facilitate setting the optimum aperture position the operator may find it
helpful to select Focus Wobble. This may be selected from the Gun Align panel
or directly from the drop down menus under Beam.

When selected, this automatically sweeps the objective lens backwards and
forwards through focus, the speed and amplitude of the sweep can be altered from
the Wobble panel. Selecting or de-selecting Fast will change the speed from fast
to slow, and using the Amplitude scroll bar will enable a suitable excursion of the
sweep to be set. Selecting reduced raster and a fast scan speed will also facilitate
this operation.

Adjust the X and Y aperture micro~rs carefully until the images ceases to
shift laterally and only rotates. The Focus wobble can then be de-selected by
selecting Off from within the Focus Wobble panel.

Beam Alignment

The beam is correctly aligned down the column when the emission image is at
the centre of the screen, when viewed in resolution mode and in depth mode.
Correct alignment will be affected by the alignment of the fmal aperture, it may
therefore be necessary to repeat the final aperture alignment after aligning the
beam. The beam may also be aligned using the Auto Gun Align function
selected from the Alignment panel (or by selecting 'G' on the keyboard).
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Chapter 2

This chapter contains the information necessary to operate the standard functions
of the Stereoscan 440. The Sb1)Cture of this chapter is as follows:-

Overview of the user interface
Operation of the insb11ment
Customisation of the user interface

In many cases additional infonnation on a given topic is available within the on.
line help mechanism. It is good practice to refer to it when a difficulty with the
user interface is encountered (see Section 1.2 Microsoft@ WindowSN and How
to Use Help).

2.1. User Interface Description

2.1.1. The Menus

The following text is a brief outline of the functions provided on the main menu
bar. Details of how these options are used is included in the Instrument Operation
section of this chapter.

~~
Some of the options listed below only appear if the system is switched into
Expert mode (selected on the File menu).

File

The file menu provides options to:-. Select the user directory
. Restore and load states (including the last state and

the standard state)
. Import and export images
. Select Novice or Expert mode

View

The view menu provides the means to allow the user to control the appearance of
the user interface. This includes options to:-

. Display the image as full screen or quarter screen

. Select which planes are to be displayed (Windows.
Image and Overlays)
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.. Toggle the toolbar on and off
Display a Status windowand/or a Datazone
Assign the current control paralMters to a
Navigation Box

Beam

The beam menu provides options to:-. Turn the beam on and off
. Select the gun and column control panels and

parameters. Control the Optibeam operating nxJde
. Identify the current aperture and check whether it is

appropriate for the current operating conditions

Detectors

The detectors menu provides options to:-

. Select and configure the detectors assigned to the
current zone. Adjust the collector bias

. BSD setup (option)

. X-ray setup (option)

Image

The image menu provides options to:-

. Assign the signal level and magnification parameters
for mouse control

. Select the noise reduction and signal mixing panels. Freeze or Unfreeze the cunent zone

. Display a histogram or a line profile of the current

image
. Apply beam shift and centre points of interest on the image. Image mats (option)

Edit

The edit ~nu provides options to:-

. Edit save and load the display LUT

. Edit save and load the toolbar
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Select the pressure units for the vacuum level

display
Select annotation and measure nxxIe

Scanning

The scanning menu provides options to:-

. Select the scanning speed

. Select the scanning mode (Normal, Reduced,
Emission or Line scanning)

. Static or dynamic stereo (options)

Stage/Vac

The stage and vacuum menu provides options to:-

. Inspect the vacuum status

. Control the beam and vacuum system to perfonn a

specimen change
. Initialise and DK>ve the motorised stage (if fitted)

Tools

The tools menu provides options to:-. Select the mKro editor

. Define the magnification table

. Specify the links between certain functions

. Go directly to any system control panel

Help

The help menu provides infonnation on topics related to the control of the
Stereoscan 440. Items on the menu include:-

. An introduction to using help (Help on Help)

. Help with the Leo interface (Leo Help - FI)

. Help with special keys used by the interface
(Keys Help - F9)

. The Release Notes for the version of software

currently running
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2. 1.2. The Icons

The icons in the standard toolbar provide a set of operations associated with the
left and right mouse buttons. It is possible to modify the arrangement of icons
and actions (or even to define completely new toolbars) using the toolbar editor
(see Section 3.7.4 The Toolbar Editor).

~ The icons described in this section are those for the novice toolbar.
Selecting Expert Mode will cause a more extensive set of icons to appear.
Context sensitive help can be wed to examine the functions associated with
each icon.

Icon:
Left:
Right:

RWl Up
Executes the Restore Conditions macro
Previews the Restore state

Icon:
Left:
Right:

Align
Assigns Gun Tilt control to the mouse
Selects the Gun Alignment Panel

Icon:
Left:
Right:

kV/Probe Cun-ent
Assigns Elff and Probe Current to the mouse
Selects the Gun Set Up Panel

Icon:
Left:

Right:

Normal Mode
Selects Normal scanning
Selects the Scanning panel

Icon:
Left:
Right:

Reduced Mode
Selects Reduced scanning
Selects the Signal Adjust panel

Icon:
Left
Right:

Scan -
Decrements the scan speed (pixel averaging)
Selects the Scanning panel

Icon:
Left

Right:

Scan +
Incre~nts the scan speed (pixel averaging)
Selects the scanning panel

Stereoscan 440 Operator Manual



Chapter 2. Operation 2.,.,5,- . .. - -~~-~ - -_c--- - - - --, , c

Icon:
Left:

Right:

Signal
Assigns Brightness and Conb'aSt to the mouse
Selects the Signal Adjust panel

Icon:
Left:
Right

Mag/FOCUS
Assigns Magnification and Focus to the mouse
Selects the Auto FocuS! Auto Stigmation panel

Icon:
Left:
Right:

NoR Reduction
Assigns N (number of frames to average) to the mouse
Selects the Noise Reduction panel

Icoo:
Left:
Right:

Photo
Initiates an image record sequence
Selects the Image Export panel

Icon:
Left:
Right:

Stigmation Conoection
Assigns Stigrnator X and Y to the mouse
Selects the Stigmation panel

Instrument Operation

Specimen Handling and Vacuum Control

The routines described below are required to get the specimen into the chamber.
under vacuum and in the right P'JSition to be scanned by the beam. In addition
some less frequent operations such as changing the filament and installing the
anode spacer are also included here.

Changing the Specimen

The beam must be switched off before opening the chamber for a specimen
change. Proceed as follows:-

2.

3.

Select the drop-down box for beam state in the toolbar.

From the list. choose Beam Off.

A message will be displayed to show that the filament current is being
decreased before the state Beam Off is displayed.
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AItematively:-

From the menu Stage/Vac, select Specimen change

A conb"Ol panel will be displayed from which the beam can be switched on
and off and the chamber vented or pumped.

2.

When Beam On is selected, the beam conditions used when Beam Off was
selected are restored.

Before loading a specimen into the specimen chamber, the chamber must first be
brought to abnoSpheric pressure by selecting Vent in the vacuum Stanis drop-
down box in the toolbar. Safety interlocking of high voltage supplies results in
the Vent command being disabled unless the beam is fIrst switched off. To open
the chamber and change the specimen:-

Ensure that the beam is off (indicated in the toolbar). If it is not, switch it off
using the previous routine.

2. Vent the chamber using the dropodown box in the toolbar.

3, Release the chamber door catch

4. When the chamber is at atmospheric pressure, the door can be pulled open.

s. Remove the previous specimen, if there is one, by loosening the small
locating screw holding the specimen stub in position.

Anyone of a variety of specimen holders may be in use - however, they are
all held in position with a small locating screw. To loosen the screw, use the
smaller of the two ball-ended drivers provided.

I

6. Insert the new specimen and tighten the locating screw

Close the chamber door and fasten the door catch. -
8. Select Pump from the drop down box in the toolbar. The pumps should now

start.

9. Within 5 minutes. depending on the specimen and the length of time the
chamber was left open, the vacuum status should reach Ready. This is
indicated both in the toolbar and in the vacuum status panel, obtained using
keyboard key V. If vacuum is not achieved within this time. see Section 2.2.6
Getting a Vacuum.

StereO$can 440 Operator Manual

.



, , Chapter 1. ~ 2-- 7- ""a-uu""

10. Resu~ speci~n examination by selecting Beam On.

Some stage movement may b. required to locate the specimen area
requiring examination.

2.2.3. Specimen Handling

Cleanliness of all items to be placed within the vacuum system is essential
Anything that has any oil or grease on it must first be cleaned with
solvent, preferably using an ultra-sonic bath. Anything to be handled
should be done so using lint free gloves to avoid contaminating it with
finger grease. Failure to do so will eventually cause a degradation of the
vacuum and resultant contamination of the sample over the area being
examined.

Specimens should nonnally be fixed to a stub prior to loading onto the stage
within the chamber. The sample can be fixed down into the stub by the use of
conductive glue, either carbon or silver. It is also possible to use conductive
double sided sticky tape. If this type of tape is used there is the possibility that
the sample may move very slightly during examination, this may become
apparent at high magnifications or if the sample is heavier dtan DOnnal.

Larger samples should be fixed to the 4 inch di~ter holder. This may be
achieved by making use of the many tapped holes present in this holder to either
tie the sample down using uncoated wire or to use sc~ws to secure the sample.

The ideal sample is one that is elecbically conductive as no other preparation is
required. However if the sample is non-conductive such as plastic or a biological
sample the operator must decide whether or not to coat the sample with a
conductive layer. The subject of specimen preparation and the selection of
operating conditions is covered in Chapter 3 Advanced Operation.

2.2.4. Changing the Filament

Whenever the filament blows. or is otherwise open-circuit, a message is displayed
OD the screeD to inform the operator that the filament has blown.

To change the fll~nt

Admit air to the column and chamber and open the gun. Remove the emitter
assembly by loosening the three locating screws holding the emitter assembly
in place. close the gun and pump down the system.
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2. Take the emitter assembly to a clean area for cleaning and reassembly

3 Place the assembly on. a clean sheet of paper with the grid aperture
downward. Using the flat metal key unscrew the height adjusting ring. As
this is done the filament will move away from the grid.

4. Grip the filament pins with the tweezers provided and lift the filament
assembly oot of the grid cap.

s. Release the filament clamp screws (visible in the four large holes) and, using
the tweezers, lift out the filament.

6. If the cathode assembly or grid aperture is not excessively contaminated a
new filament can be fitted. If any contamination is present, dismantle the
unit and clean the components, paying particular attention to the inside of
the grid aperture. This must be free of all contamination and particles.

7 Using the tweezers, put the new filament into the filament holder, first
ensuring that the pins are clean. Align the filament legs with the marts and
ensure the ceramic is centralised when tightening the filament clamp screws.
Do not overtighten as this can cause the ceramic to crack when the ftlament
beco~ hot.

8. Replace the filament assembly in the grid cap. Replace the height adjusting
ring and screw it down until it touches the sleeve.

9. Adjust the filament height and centralising as described below.

To adjust the tip position:-

Using a low power magnifier and a good source of illumination, ideally a
stereo zoom microscope, look through the grid aperture hole and locate the
filament tip. It may be necessary to adjust the height adjusting ring to move
the filament forward so that the tip can be seen. Do not move the tip forward
so that it touches the grid.

As soon as the tip can be seen through the grid aperture hole, adjust the
filament centralising screws to centre the tip in the grid hole. Set the height
adjusting ring so that the tip of the filament is level with the front face of the

grid aperture.

3. When in this position the tip is inside the hole in the grid. so care must be
taken to ensure that the tip is correctly centred before adjusting its height.
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1. Admit air to the gun. Open the gun.

2. Lift out die anode.

3. Fit the anode spacer on the top of the gun align coils. Take care, this is a
high precision fit.

4 Fit the anode back. on top of the spacer. This is also a good fit.

S. Select Low kV anode in the Gun Setup panel.

~ This automatically restricts the acceleration vollage to 3kV.

6 Close the gun. pump down. select the desired low voltage and obtain an
image.

The Slereoscan 440 should not be used at an acceleration voltage higher than
3k V with the anooe spacer fitted. It is important to ensure that the state of the
anode spacer p~ter reflects the state of the machine.

2.2.6. Getting a Vacuum

If the vacuum ready state is not achieved after several minutes of pumping, the
following guidelines provide an ordered approach to diagnosing the problem.

Investigating a vacuum leak. few simple rules:-

Before looking for a vacuum leak give the vacuum system time to pump. If
you have just changed a speci~n in a very humid atmosphere the pump
down may take longer. If the specimen is wet it may take several minutes
(up to I hour with a very large. very wet specimen has been known.) If the
stage has been left open for long periods it will take longer to pump. If the
column or chamber have been washed with solvents then it may take several
hours to achieve a good vacuum.

2. Vacuum leaks rarely happen by themselves; they are often caused. If you
have just done anything to the column or chamber then that is the most likely
cause of the leak. If the s~ has just been changed. check the stage
door '0' ring. Similarly if the filament has been changed check the gun '0'
ring.
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3. The most frequent cause of leaks is dust or fibres on !O' rings. '0' rings may
be cleaned with a fluff free tissue. '0' ring grease should never be used.
Grease traps fibres and may cause leaks.

4. Do not use any metal tools to remove '0' rings from their grooves. A small
scratch in the bottom of a groove causes a big leak.

s. If the pump down is slow, check the air admittance drier and renew the
desiccant before looking for a leak.

If none of the above point to the cause of the leak. refer to Section 5.4 Looking
for Vacuum Leaks.

2.2.7. Initialising the Stage

If a motorised stage is fitted it must be initialised before it can be used with the
absolute stage movement function (or with any of the stage options). Stage
initialisation is the process by which the system finds out the actual position of
the stage relative to its limits. There are two ways of performing stage
initialisation: -

Manual
The stage initialisation panel is selected from the Stage/Vac menu. It contains
fields for X, Y and Z stage positions.

The field on the stage initialisation panel which reports the initialisation
status cannot guarantee that the stage position is correct (it cannot detect
the fact that the stage might have been manually moved while the system
was switched oft). The test to see if the stage is correctly initialised is to
compare the actual stage position (read off the stage motors) to the stage
position displayed in the status window. If they are the same then the
stage is correctly initialised.

To initialise the stage:-

1.
2.
3,

Read the stage X position from the stage X motor.
Select stage set X and enter the X position.
Repeat for Y and Z.
Select Stage: set position to send the new position values to the stage
controller.

This last action will cause the stage position in the status window to update (if it
is being displayed).
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Automatic Stage lnitialise

The stage can also be initialised automatically by selecting the Auto Initialise
Stage lnit button on the initialise panel. The stage is then driven to its limits in
X. Y and Z to locate and set the stage origin. It is then moved off the limits by a
small amount to allow normal operation of the stage.

Moving the Stage2.2.8.

The stage can be moved in two ways from the Stage Move panel (selected from
the Stage/Vac menu). Joystick mode simulates the action of a joystick with a
window. While Goto mode allows absolute movements to be made. A pop up
menu on the stage move window allows selection different modes.

Joystick

In joystick m<xie the stage position is represented by a red square on the stage
window. A blue square represents the joystick position. To move the stage select
and drag the blue square in the required direction (horizontal for X, vertical for
V). The speed of movement is proportional to the displacement of the blue square
from the centre. When the roouse button is released the blue square returns to the
centre and the stage stops rooving.

Stage Z movement is performed using the scroll bar on the right of the stage
window. This is done by selecting the scroll box on the scroll bar and dragging it
up or down. The scroll box acts like a one dimensional joystick. so the speed
increases with the displacement from the centre position. On release the scroll
box will return to the central position and the stage will stop.

Goto

In Goto mode the red square in the display still represents the stage position. But
the blue square now represents the stage target position. Clicking with the left
mouse button anywhere in the window will cause the stage to move to that
position (the edges of the box represent the stage limits).

The stage Z position is indicated by the position of the scroll box within the scroll
bar. Movement in Z is achieved by clicking with the left mouse button at the
desired position within the scroll bar.
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Electron Gun and Column

Setting Filament Cu"ent and Aligning the Beam

Filament Setting

Optimum perfonnance of the SEM is achieved only after satUration and
alignment of the electron gun. The gun runup function sets the filament current
at the value it was last set, so it is important to keep a check on this as the
f~nt ages and after large changes to accelerating voltage, so that its working
life is maxirnised.

Saturation and alignment can both be adjusted, quite quickly from the same
operating panel - Gun Alignment. This panel is obtained by pressing the Align
icon with the right mouse button. Adjust as follows:-

For Tungsten:

Press the Emission button. The fll~nt emission profile can now be seen -
adjust the manual brightness. if necessary. or switch on autovideo peak from
the signal adjust panel. The profile should be roughly egg-shaped. depending
on the present value of fil~nt cun-ent.

2. Using the arrows at each end of the Filament current scroll-bar. adjust the
filament current so that the profile jmt condenses down to an egg-shaped
mass. This is the saturation point (or second peak see Figure 2.2) and usually
occurs at about 2.75A for a new filament. If "first peak" operation is
required. reduce the filament current to about 2.25A when a bright cenb'al
emission image will be seen surrounded by an outer "halo". Operation at this
point gives reduced resolution but much longer lifetime.

2nd peak
1 st peak '"

\
Source
Brightness

Filament I

FIgUre 2.2 Seoond Peak
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For LaB,:-

1 Press the Emission button. The ftlament emission profile can now be seen
Adjust the manual brightness so that the bright control region can be seen.
Ensure Auto Signal Level is OFF.

2. Adjust the filament cunent until the central image is at its smallest, then
reduce the cunent slightly.

Using a line profile (selected from the Annotations Measurement popup
menu) through the cenb'al image adjust the filament current to maximise the
height of the central peak on the line profile. This will only require a small
adjustment.

~ If the filament current is increased beyond 2nd peak saturation. no
advantage is gained but the life will be cons_rub" shortened (the
emission profile also does not change for currents higher than saturation
point).

For Automatic Alignment:-

Press Auto Align. When complete (the text on the button no longer greyed-
out), the profile should be at the centre of the screen - this can be checked by
enabling Crosshairs from the View ~nu. Now go to 7 below.

For Manual Alignment:-

Select emission image from the Gun Align panel

~

I

2. From the Status Panel select the parameter Emission Zoom and set this to be
2. (Please retUl notes below regarding Emission Zoom Factor Settings)

EMISSION ZOOM FACTOR SETflNGS
A SXstems with the Modified Gun Alien Modules
BuDd Standard 3/10 or later
(i) Software Version 2.01 and earlier

Use an Emission Zoom Factor of 2 to display an emission image
of the correct size.

(ii) Software Version 2.02 and later
Use an Emission Zoom Factor of 1 to display an emission
image of the correct size.
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B SIstems without the Modified Gun Ali2D Modules
Build Standard 3/9 or ealier
(i) Software Version 2.01 and earlier

Use an Emission Zoom Factor of 1 to display an emission image
of the correct size.

(ii) Software Version 2.02 and later
Use an Emission Zoom Factor of 1 to display an emission image
of the correct size (will be slightly bigger).

3. Select Optibeam mode depth in the Gun Align panel.

Select Gun Shift.4.

,. Defocus the image.

Adjust the magnification until an oval spot is clearly visible, - lOOx.6.

Centre the spot using the crosshairs if required.7.

Undo Optibeam depth mode.8.

9. Select Gun Tilt.

10. Centre the emission image. if required

Select normal image.

12. Select reduced raster

13. Select the gun alignment icon.

14. Adjust for maximum brightness in X and Y directions.

15. Press the normal icon to resume normal imaging.

If the image moves laterally when you adjust the focus, it may be necessary to
adjust the aperture position. If so, consult Section 2.3.3 Adjusting the Aperture.
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1~ A Check filament saturation about once a day. Saving conditions when you
close down ensures that new values of filamenl current will be used when you
restart the system.

B As an aid to fast manual alignment, a useful facility is provided under
Tools->links. This provides the ability to select auto-contrast, a particular
scan speed, and crosshairs to be set when Ellliuion is pressed.

C If only minor optimisation of the gun tilt is required. this can be achieved
by pressing the Align icon with the left mouse button and use mouse
adjustment to optimise the signal.

2.3.2. Setting EHT and Probe Current

Accelerating Voltage

The accelerating voltage and probe current can be assigned to the mouse buttons
from the Beam menu or by clicking on the kV icon. Whenever the accelerating
voltage is changed it is important to check that the beam and the final aperture
are correctly aligned.

In addition to adjusting these parameters with a mouse it is possible to double
click on the p~ter display (in the toolbar) which will bring up a dialog box
allowing the value for the selected parameter to be entered from the keyboard
(this applies to any parameter assigned to the mouse).

The accelerating voltage must be set for the type of specimen under
examination: -

. For low atomic number or beam sensitive speci~, choose a voltage
between IkV to SkV

. For high atomic number specimens, a voltage of illV to JOkV is
nonnal

. For atomic numbers in between (say 20 to SO), a voltage of 10kV to
20kV is best

. For X-ray analysis, the voltage is dictated by the elements under analysis

The subject of selecting appropriate operating conditions for the specimens is
explored further in Chapter 3 Advanced Opera/ion.

Probe Current

The probe current effectively conuols the spot size of the beam on the speci~n.
Optibeam Auto Resolution mode (selected on the Beam ~nu) sets the probe
current to give the best resolution. If auto resolution is left on then changes in
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magnification win result in changes of probe current, so it is advisable to enable
auto brightness.

Further guidance on selecting the correct probe current is given in the Chapter 3
Advanced Operation.

Optibeam

The Optibeam program takes the require~nts for probe current. working
distance, etc and determines the optimum lens settings to achieve the best
performance from the column. Usually the best performance is defined as the
highest resolution, but Optibeam can be told to optimise for the greatest depth of
focus instead. This is done by selecting Depth Mode on the Beam menu.

2.3.3. Adjusting the Aperture

Oprimum imaging can sometimes depend on the correct choice of aperture size.
The internal software model. Optibeam. continually calculates the best setup for
the selected aperture. however it will sometimes recommend using a different
aperture. This message is displayed in the Beam->Apertures menu. as
Recommended Aperture =. If preferred. this infonnation can be displayed
automatically on screen by switching off Suppress Aperture Warning.

The four apertures installed (sizes as displayed in the Apertures menu) are all
located on the Y axis of the aperture changer mechanism. To reach another
aperture, simply rotate the Y micrometer either clockwise or counter-clockwise
according to the direction of the required aperture - refer to the X and Y positions
displayed in the Apertures menu.

As the micrometer is rotated. the signal will disappear as the cunent aperture
moves out of position. The signal returns as the next aperture moves into
position. however there will either be much less or much more signal according
to the change in aperture size. For this reason. it is sometiux:s easier if auto
brightness is enabled during the change.

Having located the aperture in position. click on the "radio button" next to the
new current aperture selection and OK the menu. This ensures that Optibeam
will continue to achieve the best column performance.

Finally, it is necessary to make a fine adjustment to the aperture position to
ensure that it lies exactly on the electron optical axis. Select a focused field of
view at about lOOOx and switch on focus Wobble under the Beam menu. The
speed and amplitude of the wobble can be adjusted from the operating panel that
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appears, and should be adjusted so that the change of focus of the image can be
easily followed. This requires a fast scan speed, and preferably reduced raster.

Reduced mode can be automatically enabled with focus wobble in the links
menu under TooL\'.

Carefully adjust both X and Y micrometers until no lateral movement of the
image can be seen during the focus wobble. Switch off focus wobble.

If adjusted carefully, preferably just after gun alignment. further aperture
align~nt adjustments can be avoided except when large changes in either probe
current, working distance or accelerating voltage are made.

Setting Focus, Stigmation and Magnification2.3.4.

Focus

The focus can be controlled by clicking on the Mag/Focus icon. This will assign
focus control to the centre mouse button. Alternatively it can be set directly by
double clicking on the Focus=display in the toolbar.

In some places the focus value is displayed as the Working Distance. these
two parameters describe the same thing.

Optibeam uses the working distance value to set the lens cunents to M:.bieve the
required focusing. If Optibeam is not active the focus is adjusted by controlling
the C3 lens current directly.

Auto Focus

.Auto Focus can be initiated from the keyboard or from the Auto
Focus/Stigmation Panel (see Fi~ 2.3), which can be called up from the Mag
Focus icon. The algorithm uses a portion of the image to select the best focus.
By default this is the centre of the image, but the user can adjust this by selecting
Focus Area on the Image pop-up menu. The right mouse button cancels
adjustment of focus area.
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Figure 2.3: Auto FocusIStigmation Panel

You may select Coarse Auto Focus (Shift F on keyboard) and Fine Auto Focus
(F on keyboard). You may also select a new function Focus Scan by Ctrl F on
the keyboard. This scans the focus between defined limits and will stop when the
spacebar is pressed. While active the direction of scan may be changed by
pressing the left or right cursor keys.

If a large change in working distance is made, then it is recommended that the
Remove Hysteresis function (F2) to ensure the accuracy of the magnification
and probe cun-ent values.

Stigmation

High resolution images can only be obtained after correct adjustment of the
stigmators. Astigmatism (non-roundness of the beam) is caused by microscopic
contamination within the column charging up and applying an asymmetric field
that affects the focus of the beam usually in one direction. It can be corrected, if
not too serious, as follows:-
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Select the Stigmation panel by pressing the Stig icon with the right mouse
button.

1

Choose a suitable field of view at about 5kX to 10kX containing a round
feature.

2

Focus normally to optimum focus so that the fearure does not "s~" in any
direction.

t

4. Select the reduced raster icon and, using the Beam Shift function in the
Stigmation panel, bring the feature to the centre of the reduced raster.

Press Stigmation in the navigation box and adjust for best focus.s

Repeat 3 and S as necessary.6.

Alternative methods are provided:

Press Auto Stig in the Stigmation panel.A

Press Stigmation on the Auto Focus/Stimgation PanelB

Press Dynamic Stig and, using the mouse pointer click on the region of best
image focus using the left mouse button.

c

Press the Stig icon with the left Dk>Use button and adjust the Stig X and Stig
Y parameters as normal parameter adjustments with the mouse.

D

~ It is a good idea to align the aperture correctly before adjusting stigmation.

It is generally considered easier to adjust just one stigmation area axis at a ~.
The best way to do this is to use the scroll bars for X and Y adjustment picking
up the scroll box with the mouse and dragging it to find the best stigmator

setting.

Auto Stigmation

The Auto Stigmation Correction function now perfOmlS a combined focus/stig
COn'ection. Press A on the keyboard or the Stigmation button on the Auto
Focus/Stigmation Panel (see Figure 2.3)
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Find Image

A new Find Image function is introduced which is useful when you have just
changed specimens. This function will perform an auto focus with the focus
scanning between the defmed working distance limits. It is the same as the
Coarse Focus operation but in addition it will set the magnification to the highest
value at which it is able to set the focus. whereas the Coarse Focus operation
returns to the initial magnification.

This can be selected by pressing * on the keyboard or the Find Image button on

the Auto Focus/Stigmation Panel (see Figure 2.3).

Magnification

Before describing how to adjust the magnification, it is important to understand
the precise defmition used on the Stereoscan 440. Each output device (HRRU,
video printer, etc) is calibrated and the magnification relates to the selected
output device. So the magnification for a video printer is larger than that for an
HRRU (because the print is larger). The process of calibrating an output device
is described in Section 2.6.

Like many other parameters magnification can be adjusted by assigning control
to the mouse. In addition the magnification conttol window can be selected from
the Mag/Focus option of the Image menu. Due to the wide range of available
magnification, the window is divided into two parts. At the top is the coarse scale
bar which presents a logarithmic scale, with a green marker indicating the mid
range value of the lower fme scale bar. The required scale is selected with the
mouse, the nearest graduation to the cursor will become the fme scale centre.

~ Because the green marker only indicates the range centre it only changes
position when there is a range change.

The fine scale bar presents a linear portion of the magnification range. The red
marker indicates the current magnification, which is also display in the caption
area in the magnification control window. The required magnification is simply
selected on the lower control bar.

A further facility for setting the magnification is provided by the mag table which
can be accessed using the F4 and Shift F4 keys. The table is defmed by selecting
Mag Table on the T~ menu. Each non zero entry is active and pressing F4
will step the magnification through the values defined in the table. Pressing Shift
F4 returns the magnification to the value it had before the fIrst selection of F4.
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If the word 1..0W' is entered in the mag tab. the magnification will be set to the
lowest value achievable when that entry is selected.

Low Mag

If the word "LOW" is placed in a mag table entry, selection of that entry will
cause the magnification to be set to the lowest achievable value. Subsequent
changes to other electron optic parameters may cause this low value to change,

Adjusting Beam Shift

Beam shift appears as an option on the Stigmation panel. Selecting it allows the
beam shift to be conb"olled from the navigation box on the panel. The beam shift
function allows a small amount of move~nt across the speci~n and can be
used at high magnifications where it is impossible to position the specimen with
the stage.

The beam shifts are also used in the Centre Point Function on the Image menu.
Centre point can be used to bring any point of interest to the centre of the screen
(if it is within the range of the beam shifts). Select image->Centre Point and
the click on the image feature required.

The beam shifts can be zeroed by selecting the Home key on the keyboard.

Blanking the Beam

The beam can be blanked by selecting the Beam Blanked check box on the Gun
Align panel.

Blanking the beam while scanning is not required will reduce electron beam
damage to sensitive specimens.

2.4. Imaging and Image Processing

Adjusting Signal Level

m
Signal level can be adjusted manually or automatically. Automatic signal
adjustment is controlled from the Signal Adjust panel (right mouse button on the
Signal Level icon).

.
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Manual

The signal level can be adjusted using the brightness and contrast controls
assigned to the mouse with the signal level icon. If more than one zone is
displayed, then the detector controlled is the detector assigned to the current zone
(which is indicated by the anchor symbol). The concept of zones will be described
in the Section 2.4.2 Scanning Modes.

Auto Signal Level

The Signal Adjust panel provides the controls for the auto signal level functions.
Brightness and contrast can also be controlled directly from this panel using the
slider bars labelled accordingly.

There are two types of auto signal level function which each operate in two ways.
The auto signal level function will either control the Mean signal level or the
Peak signal level. The mean signal level is defined as being the average
brightness of all the pixels in the image, while the peak level is defined as the
brightness of the brightest part of the image.

Peak and mean signal level controls each operate in two ways. The Find function
is a single shot activation which sets the peak or mean to the level defined in the
associated Auto Video slider bar. The Keep function activates the auto video
function to maintain the video level (peak or mean) of the image at the time of
selection.

Typically the Find function will be used to set the required video level if the
image is a long way from the required brightness. The Keep function is useful
when the content of the image is likely to change, for example if the stage is
being moved across a specimen with distinct light and dark phases, or if the
probe current is being adjusted.

Auto video conttol can be disabled at any time by selecting the Auto Video Off
button.

2.4.2. Using Scan Modes

Before considering the different scan modes available, it is necessary to define
some tenDS which will simplify the whole issue of scan modes, signals and
Windows.
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The Zone

The basic concept underlying all the display and scanning modes it that of a
ZONE. A zone is an area of image store which can be mapped onto part of the
image window. In normal imaging only one zone is used, but for split or quad
modes two or more zones are required. n
Inputs

Associated with each zone are two input signals A and B which can be selected
from the list of detectors configured on the system. The full chain of processing is
shown in Figure 2.4.

FIgUre 2.4

The signal mixing and Input LUT can be adjusted by the user if the appropriate
software option has been purchased. otherwise the default settings will apply (no
mixing, output = input LUT).

The Anchor Symbol

When working in a display mode with multiple visible zones the anchor symbol
will appear.
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It signifies which zone on the display is the current zone.. This is important
because many operations act on the current zone, these include:-

. Detector selection

. Frame averaging

. Freeze and unfreeze

In addition to these, the signal level controls adjust the settings of the detector
assigned to the current zone.

It is easy to select a new zone to be the current zone. Select the anchor symbol
with the mouse and drag it to the new zone. Thus whichever zone the anchor is
in is by defInition the current zone.

Double clicking on the anchor symbol will select 'All Zones' (denoted by a blue
border to the symbol). When' All Zones' is selected any zone specific function
will apply to aU the zones on the display.

Scan Rotation

This allows electronic rotation of the image by rotating the scanning of the beam.

Scan Rotation is selected from either the Scanning menu or from the Scan Rotate
icon in the Expert Toolbar. It is switched on and off using the Scan Rot check
box on the RotatelTilt panel.

The angle of rotation can be adjusted using the slider bar on the Rotate/filt
panel, or by assigning control to the mouse (using the Rotate icon). It is also
possible to enter the exact value by double clicking on the rotate value on the
Rotateffilt panel.

Scan rotation can be used to set the orientation of an image to the desired angle
without having to rotate the specimen. Care should be taken when using stage
controls while scan rotation is active as the actual direction of stage movement
will not correspond to the screen axes.

Split Screen

In split screen mode (selected from the Scanning menu), the image area is
divided into half with a different zone being displayed in each part. Different
detectors can be assigned to each zone and each zone can be frozen
independently of the others.
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Quad Mode

Quad mode is selected from the ~~!1JD-g menu or the Quad Mode icon in the
Expert Toolbar.

When in quad m<xie scanning the anchor symbol indicates which zone is being
con~lled by any zone specific function. A different zone can be selected by
dragging the anchor symbol into it. Zone specific functions include:-

Detector selection
Frame averaging
Freeze and unfreeze

.

In addition to these. the signal level controls adjust the settings of the detector
assigned to the current zone.

Quad mode can be used to display four different images acquired in different
ways. For example the flfSt image might be a low magnification image of the
specimen. the second a higher magnification detail. the third might be the ~
detail using a different detector and the fourth might be the same image inverted

This type of effect can be set up by freezing each zone when its contents are
acceptable and moving the anchor symbol to the next zone. Once all the zones
are set up, the whole image can be printed. recorded or exported in the usual way.

Normal scanning can be returned to by selecting the Nonnai icon. or by selecting
the Normal option from the Scanning menu.

Reduced

When adjusting focus or stigmation, it is often convenient to use the Reduced
function to increase the frame rate without having to increase the pixel rate.
Reduced is selected from the icon or the Scanning Menu.

Detector Control2.4.3.

The detector conb'Olled by the brightness and contrast functions is determined by
the detector assignment to the current zone. A detector is assigned to a zone
using the Select Signal A field in the Detector menu. Selecting this field
displays a list of the available detectors from which the required detector can be
selected.
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Each zone has its individual detector assignment, so in quad mode as many as
four different detectors could be displayed. The detector controlled by the signal
level functions is detemlined by the current zone, although if that detector is
assigned to more than one zone then more than one part of the quad image may
be affected.

~ It is possible to set up different auto signal level controls for different
zones. If there is a conflict between two zones which have the same detector
assigned to them, then the first zone with that detector will take precedence.

Collector Bias

The Collector Bias can be assigned to mouse control from the option in the
Detectors menu. It can be varied in the range -250V to +4OOV. For nonnal
operation of the secondary electron detector this value should be set to maximum.

Four Quadrant BSD

The four quadrant back scattered detector has a configuration panel dedicated to
it, which can be selected from the Detectors menu. Each quadrant of the detector
can be in one of three states (Off, Normal or Invert). When normal the signal
from that quadrant is added to the total signal, when inverted the signal is
subtracted. Clicking on the quadrant fields allows each one to be configured as

desired.
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FIgUre 2.5

Two predefined configurations of quadrants are available to set the detector to
give best perfonnance for composition (Compo), that is atomic number contrast,
or surface topography (Topo). Selecting these predefined configurations will set
up the detector quadrants according to Figure 2.5.

Stereoscan 440 Operator Manual



2-28 Chapter 2 Operation . - -, , ".

Other mountings for the BSD may require different settings for Topo - these may
be defined by setting the individual segments to the required values and pressing
the Defme Topo buttons. These settings will then be used for future selections of
Topo.

There are two other fields on this panel. The Four Quadrant BSD: Gain field
indicates which range the amplifier is currently on. it is set automatically from
the signal level controls and need not be changed by the user. The Four Quadrant
BSD: Fast field selects the bandwidth from the detector. it should be set to FAST
for normal visual scan rates and to SLOW for slower scan rates and photo
recording.

2.4.4. Scan Rate and Noise Reduction

Scan Rate

There are 4 scan rates available as standard on the Stereoscan 440. They are
represented by the Pixel Average parameter which can have values 1. 4. 16 or
128. The scan rate is usually changed using the scan rate icons. but there are also
options on the Scanning menu and on the Noise Reduction panel to do the ~.

Noise Reduction

The Noise Reduction panel is selected with the right mouse button on the Filter
icon. It allows the type of noise reduction to be selected (Line average or Frame
average) as well as the number of lines or frames the averaging is to be
performed over. In addition the freeze options allow the current zone to be frozen
or unfrozen. The Freeze At EDd option freezes the zone when the image
acquisition has completed (detennined by the number of frames in frame average,
or just I frame if line average is selected).

..There is one important difference between line and frame average. In line
average mode the same noise reduction is applied to all the active zones. But for
frame average it is possible to set different frame counts for each zone.

The use of noise reduction is explained further in Chapter 3 Advanced Operation

2.4.5. Live Line Scanning

The Line option on the Scanning menu selects live line scanning. In this mode a
single line of the image is scanned repealedlY and a profile of that line is
displayed. The rest of the image is frozen during line scanning and a line cursor
is used to select the line to be scanned.
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The profile's appearance is controlled through the pop-up menu associated with
it. The following fields are used:-

X Scale - determines the width of the profile (displays every
nth pixel)
Y Scale - detennines the height scaling of the profile
Static! Active - Determines whether the profile is redrawn at
the end of each line scan
Copy - Link for transfer of data to spreadsheets.

Selecting normal scanning will deselect line scanning

One special case of live line profiling exists when the system is also in split
screen scanning. In this mode two traces are displayed on the profile, the usual
green trace represents zone 0 and a red trace represents zone I (the left and right
hand sides of the image respectively).

2.4.6. Spot Mode

Spot mode is selected from the Scanning menu. On selection the image is frozen
and a crosshair cursor appears to indicate the beam position. The cursor may be
moved by dragging with the mouse. Selecting normal scanning deselects spot
mode.

Histograms2.4.7.

Selecting the Histogram option on the Image menu displays a grey level
histogram of the image, that is a bar chart showing the number of pixels at each
grey level. A pop-up menu controls the appearance of the histogram with the

following fields:-

.

.

.

.

Bin Width - Sets the width of each bin on the display
Height - Sets the height of the histogram display
Source - Selects the source of the histogram data
Sample, Start and Stop - Control the updating of the
histogram data
Copy - Link for transfer of data to spreadsheets.

The source can be defined as either the stored image, the current zone or a
specified zone. If the stored image is selected then the histogram data will only be
updated when the Sample option is selected. If the data source is a zone, then the
Start and Stop options conb"Ol the updating of the data. The source of the image
is important because stored data has been processed by the input LUT and the
noise reduction, whereas the zone data is entirely unprocessed.
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On the histogram display there is a black cursor which may be positioned by the
mouse, the selected bin number and its contents are displayed below it (B and N
respectively). m

2.4.8. Dynamic Focus

The dynamic focus licence enables the dynamic correction of focus within the
frame for tilted specimens.

The dynamic focus control panel (see Figure 2.6) is displayed by selecting Top
Menu - scanning - dynamic focus.

~ Dyn.F ocus On

FCF Tilt Angle~ 0.0 Deg
~ ~

Figure 2.6 Dynamic Focus Panel

The Dynamic focus function is switched on/off using the checkbox on the panel.

The FCF (Frame Corrected Focus) Tilt angle is the angle of tilt about the middle
of the image frame (i.e. about a horizontal line mid way down the image). The
procedure is as follows:-. Switch on Dynamic Focus

. When Dynamic focus is switched on the scan rotation is

automatically switched on, this should be set to 0 degrees so that
the angle of tilt goes down the frame

. If the specimen is itself tilted adjust the scan rotation so that the
angle of tilt is down the frame. Adjust the focus so that the middle (horizontal) is in focus

. Adjust the FCF Tilt Angle so that the top and bottom of the frame
is in focus

2.5. Annotation and Measurement

The annotation and measurement functions are accessed via the image pop-up
~nu (press right mouse button while over the image area). To get the
annotation menu select the Annotation option, then press the right mouse button
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again to bring up the annotation pop-up menu. This menu can now be used to do
any of the following:-. Display a user defined datazone

. Place annotation text on the image

. Display a system parameter on the image

. Place a magnification marker on the image

. Perfonn point to point or linewidth measurement

. Save or load a file of annotation objects

When in annotation mode the image window title bar displays additional
information concerning the annotation state. Annotation mode is deselected
when the Adjust option is selected from the pop-up menu and also when a
parameter is assigned to the mouse for adjustment.

Before considering how the annotation menu is used to achieve the above effects,
it is important to clearly defme some concepts upon which the annotation system
is built.

Annotation Modes

There are three annotation modes Move, Edit and Delete. The current mode is
indicated in the title bar at the top of the image window. In move mode an item
can be selected and dragged to any position on the screen. Edit mode allows the
contents of text strings to be edited, but the precise edit operation depends on the
kind of object selected. Delete mode is used to remove any annotation object
selected.

The annotation mode is set using the Mode option on the pop-up menu.

Annotation Objects

An annotation object is any item which is displayed on the image which is
contained in the overlay plane. Turning the overlay plane on and off from the
Planes field of the View menu will cause any annotation objects to appear and
disappear. There are several different kinds of annotation object, including:-

. Text

. Parameters. Panels. Measurements

The use of each of these objects is described below.
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Panels

A panel is a special kind of annotation object in that it is essentially a collection
of other objects. Panels provide a convenient way to manipulate a collection of
other annotation items, in fact a datazone is a panel although it does have a
special status within the annotation system. Panels are created from the
Annotation->Panei field on the menu, then other annotation objects can be
moved into them. A panel can be locked (using the Panels->Lock option) which
prevents the selection of objects within the panel and means that any operation
will be on the whole panel. Panels can be moved by dragging with the mouse aDd
resized by selecting and dragging the edge of a panel in edit mode.

A special type of panel can be selected from the annotation menu
Annotation->ZPanel. these are Zone Panels. A zone panel will display
parameters which relate to a particular zone display. Please refer to the on-
line help text for further information concerning zone panels. ~

2.5.1. Datazone

IThe datazone can only be displayed on a full screen image. It is selected using the
Datazone field on the View menu.

The datazone is normally not part of the annotation system and is therefore not
affected by annotation operations. In particular it is not removed when the Reset
option is selected from the pop-up menu (which removes all other annotation
objects from the display). However for the purposes of customising the datazone
it can be brought into the annotation system. This is done by selecting
Panels->DZone->Edit from the menu and results in the datazone becoming a
panel in the annotation system. It can then be unlocked (Panels->Unlock and
select on the panel) to allow its contents to be edited.

A new customised datazone can be created from any panel by selecting
Panels->DZone->Install and selecting on the panel in question. This operation
takes the panel out of the annotation system and saves it in the user directory as
the file DZ.ANN. The default datazone ftIe is not overwritten, but any previous
user defined datazone will be.

When the datazone is displayed the system looks for the file DZ.ANN in the user
directory and if it does not fmd one there, it looks in the LEO directory for the
system default.
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Annotation Files

A file of annotation objects can be saved as either a panel, or a complete set of
annotation. To save a panel, select FUe->Save and click on the panel to save. A
file dialog will then appear to allow the file ~ to be en~. To save a set of
annotation, make the same menu selection, then click on any part of the image.
Again a file dialog will prompt for the file name.

There is a small difference between loading panels and sets of annotation. If a set
is loaded (by selecting FUe->Load), it replaces any existing annotation (except
for the datazone), whereas if a panel is loaded, it is merged in with the existing
annotation.

Text Annotation

To add text annotation to an image, select Annotation-> Test from the pop-up
menu. A dialog box then appears which allows annotation text to be defmed. The
actual text is entered in the scrollable text window, foreground and background
colours can be selected, as well as text fonts and styles. It is also possible to add a
t1 symbol or any other special character available in the selected font.

When the text has been typed select OK on the dialog and the text will appear on
the image. To move the text to the desired position. select and drag it with the
mouse (move mode must be selected to do this).

If it is necessary to change some existing text. it can be edited by selecting it in
edit mode. The text dialog then reappears with the selected text already in the
text window.

Special Characters

The 11 symbol is probably the most common non standard character required for
annotation, so a panel button has been dedicated to it. Selecting this button will
insert the 11 character into the text string at the cursor position. Other special
characters are available from the special character scroll box. The characters are
scrolled until the desired character is displayed, then the Insert key is selected to
place it into the text string.

Text Attributes

The foreground and background colours for the text can be set by selecting the
appropriate colour panel (this does not change the system defaults, only the
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current text string). In addition the font and style of the text can be modified.
The fonts available are:-

. Leica 29

. Leica 24

. Leica 16

. Arrows 31

. Arrows 25

. Maths 24

. Maths 16

The f1 character is only available in the Leica fonts.

~
~

Each text string is of a single font. Mixed strings can only be achieved by
placing two or more strings of different fonts next to each other on the
image. It is recommended that all annotation and measurement is
perfonned in full screen mode (using the large fonts). If quarter screen
mode is selected, then the small fonts will be substituted for the large ones,
but the proportionate sizing is not exact and may cause the text to change
size or position slightly.

~
The style of the text reflects the way in which the foreground and background
colours are used to display text. The different selections available are:-. Unbacked Normal - Text on a transparent background

. Backed Normal - Text on a solid background colour

. Halo - Text with a transparent background but with a single
pixel halo of background colour

. Unbacked Bold - Bold text on a transparent background

. Backed Bold - Bold text on a solid background colour

Pins and Links

It is possible to indicate the area of the image referred to by some text by using
pins and links. Both these objects are selected from the Annotation menu. A pin
is a round dot which can be placed anywhere on the image. A link is a line which
can be attached between any two annotation objects (usually one is a pin). If
either object attached to a link is moved, then the link will be redrawn to follow
the shortest line between the two objects.

Attributes

Each object displayed by the annotation system has a set of attributes which
describe the way in which the object is displayed. For each attribute a default can
be set up using the Attributes->Defaults menu. When an attribute has been
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changed. existing annotations can be made to reflect that change by selecting edit
mode and selecting Attributes->Modify Item and clicking on the appropriate
object. All existing objects can be made to reflect a change by selecting the
Attributes->Modify AU option.

The set of atbibutes available are:-. Text Foot
. Text Foreground
. Text Background
. Text Style
. Panel Colour
. Line Style. Line Width. Line Colour

Oearly so~ of these atbibutes only apply to a subset of the objects displayed by
the annotation system.

Parameters

A display of any system parameter can be placed as annotation on the image.
These options are selected from the Annotation->Analogue and
Annotation->DigitaI options which each display a list of available parameters.
When displayed the parameter's value text is updated as the parameter changes.

Time and Date

In addition to the system parameters, it is also possible to display the ti~ and the
date as annotation objects. They are selected directly from the Annotation menu
and inherit the same default attributes as annotation text strings.

Zone Magnification

The zone magnification object is similar to the analogue parameter Mag. But
unlike Mag it changes its value according to the magnification of the zone it is
placed in. Apart from this difference in behaviour, there is no way of
distinguishing between the Mag parameter and a Zone Mag object. It is therefore
recommended that zone mag objects be used to display the magnification to avoid
confusion.
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.
Micron Markers

ITwo types of micron marker can be placed on the image. fIXed and variable. Both
types of maJt.er show a line and a length. the line size will change according to
the magnification of the image. However the variable marker will change scale
according to the magnification. while the fixed one will not.

If multiple zones are displayed, the micron marker will display the magnification
of the zone in which its top left corner appears.

Editing a variable micron marker changes the maximum size limit for the line.
Editing a fixed micron marker allows its fixed size to be changed. If a fIXed
micron marker is inserted into a datazone it will be converted to a normal micron
marker using base magnification.

.
Point to Point

The point to point measurement facility consists of a pair of related pointers and
a ~urement panel and is selected from the Measure~nt ~nu. The points are
labelled Ph and PnR where n is the number of the instance of the point to point
object (it is possible to have multiple point to point objects concurrently).

I
FIgUre 2.7 Point to Point Measurement Facility

In the measurement panel the distance between the markers is displayed along
with the angle of the line joining the markers. The angle is defined as the angle
between the line PnR and Pn and the line scan direction. measured in a clockwise
direction (see Figure 2.7).

Either point may be moved by selecting and dragging with the mouse. but this
nM::thod of control has two disadvantages:-
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The mouse CUrsor may cover the area of interest.

2:

Precision AdjUShnent

Select annotation edit mode.

Select the object to be moved.

3.

4.

5. Release the mouse key to end the precision adjustment.

2.5.8. Linewidth
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~
Graticule and Crosshairs

IGraticule and crosshairs are toggled on/off from the View menu. A grid of
evenly spaced horizontal and vertical lines or intersecting 45° lines in the overlay
plane is displayed. The spacing of the lines is user defmed from the View menu,
an appropriate pixel distance is entered between the values of 50 to 512.

Recording an Image
IThere are three ways of recording an image on the Stereoscan 440:-

~
1 Micrograph on HRRU (if fitted).

2. Image print on a Video Printer (if fitted).

3. Image Save to disk (as a 11FF file).

The last of these is available on all systems, the others require the necessary
options to be fitted.

The photo icon provides an interface to all the record methods. In the File menu
the Export/Pboto set up option allows the output device to be selected from those
fitted. The selection is made by clicking on the Output to: field, which displays a
dialog box of the available selections. Once a destination has been set up,
selecting the photo icon with the left mouse button initiates a record sequence.
Selecting it with the right mouse button brings up the appropriate record set up

panel.

In addition to the icon, record sequences can be initiated from the File menu
Export/Photo option, while the set up panels can be accessed from the Set up
option on the Export/Photo set-up panel.

Magnification Calibration

The magnification is defined as the scaling between the size of a pixel scanned
on the specimen and the size of that pixel on the final image. Clearly the latter is
dependent on the way in which the image is recorded. An image recorded on an
HRRU will not be the same size as one recorded on a video printer. The
Export/Photo set up panel provides a means of calibrating the magnification
according to the user's own requirements.
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An output device can be calibrated in the following way:-

1 Freeze a full size image.

2. Select Calibrate on the Export/Pboto set up panel.

3 Move the markers so that they are well apart.

Take a photo (or print).4

Measure the physical separation of the line on the print.oS

6. Enter the separation in the calibration panel

The displayed magnification value will then be adjusted for the fmal image size.

2.6.1. The High Resolution Record Unit

If the HRRU is con'ectly set up. a micrograph can be taken by selecting the photo
icon with the left mouse button. The right IrK)Use button on the ~ icon will
display the HRRU set up panel. When a photo record is completed. the ~ra
status returns to idle and a dialog box appears to confirm that the record sequence
has fmished.

The set up page allows several parameters of the camera, HRR U and film to be
set up (some of these parameters are located on the IIRRU settings submenu).

Camera Image

This can be selected from Stored. Live. Cal Bri or Cal Con. Of these only Stored
or Live should be used. A live image is used to take a micrograph which has
more pixels (thus higher resolution) than can be held in the image store. For
more information on Cal Bri and Cal Con see Appendix E, at Section 2.2.

Camera Overlay

When set to Yes, any annotation, datazone or other items in the overlay plane
will be included with the photographed image. For more infonnation on Cal Bri
and Cal Con see Appendix E. at Section 2.2.

Film Speed

The film speed in use, 800, 400, 200, 100 or SO ASA.
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HRRU Camera

This sets the type of camera being used, this will affect the magnification value of
the fmal image.

HRRU Brightness and Contrast

These parameters are best set using the grey wedge (from the output LUT set up
menu). The brightness should be adjusted until the darkest level is just black and
the contrast should then be adjusted until the brightest level is white.

Development Timer

The Development Timer is a simple count down timer which 'Beeps' on
completion. The duration (in seconds) can be entered by clicking on the time.
The timer is initiated with the start Development Timer button.

Photo Number

The photo number increments each time an image export is performed
(regardless of output device). Besides appearing in the HRRU panel, it can also
be displayed in the status window or used as annotation. It can be set to a new
value by clicking on it whenever it appears.

In addition to the fields mentioned above, the Photo and Abort photo buttons
operate in the obvious way.

2.6.2. Video Printers

The sequence of operation to take a video print is as follows:-

Ensure the video printer is selected as the current output device.

2. Optimise the brightness and contrast of the image.

3. Apply any noise reduction and freeze the full size image to be printed.

4. Select photo icon with the right mouse button.

5 Set up the required size and orientation.

6. Select OK to initiate the print sequence.
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When the record is complete the Video print to do field will return to zero. If the
settings are known to be correct for the next print. then operations 4 to 6 above
can be replaced with a single selection of the photo icon with the left mouse
button.

Image Content

The Image, Overlay and PC Plane check boxes on the set up page detennine what
appears on the final print. The grey data is part of the image, annotation and the
datazone are in the overlay plane and the ~nus are all in the PC plane. A plane
will appear in the image if its check box is selected.

One other field is relevant to the image content. but only applies to Monochrome
printers. The As seen check box will cause the image data to be passed through
the display LUT to make the recorded image the same as the displayed image
(only the red part of the LUT is used to produce the monochro~ output). If the
box is not checked. then the stored image will be sent directly to the printer.

Image Orientation

Two orientations of the image are possible, porb"ait or landscape. Printing an
image in landscape format will take slightly longer than pomait. The format used
will depend on the printer resolution and the size of the image to be printed.

Image Size

Three options are available for image size. A full size image could be printed
(whole image), or a portion of the image (adjustable) using the mouse to position
and size the red box which selects the part of the image to be printed. The third
selection (best) uses the known resolution capabilities of the installed printer to
select the largest possible image which can be displayed at full resolution.
Selecting this option will also override the image orientation setting.

Paper Size

The Large Paper checkbox is used to set Large rather than Standard paper size
for the CPlOO. CP210 and CP200BH printers. The setting of this checkbox
affects the best resolution image dimensions.

Form Feed

Selecting this checkbox causes a form feed code to be b"ansmitted to the printer
following the video print.
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I2..42 Cbapter 1. Operation~

It has been reported that in some cases, Mitsubishi P78 printers are
affected with a particular problem in which a grey-scale is printed rather
than an image. This tends to be associated with the length of time in which
the printer is left in standby mode (powered on at the rear, but off on the
front panel). The ,oll.tion is asfollows:-

If the printer has been in standby mode for several minutes. the following
procedure will prevent the above problem: -
J. Switch the printer on at the front panel. This will enable the "Ready"

lamp.
2. Switch the printer off and on again immediately. again using the front

panel switch.

The copier is now reset and should not print grey scales.

2.6.3. Saving nFF Files

Tag Image File Formatl (TIfF) provides a standard format for various kinds of
image files. Images can be binary. grey. grey with a colour palette. or tlue colour.
They can also be of various sizes with additional data stored with the image. It is
to enable easy use of Stereoscan 440 images that TIFF import and export
facilities are provided.

.TIFF export can be set up as the action taken by the photo icon by setting the
Export/Pboto setup to FIle/Display.ln addition the TIFF File Export panel is
always available from the TIFF Export option of the FOe menu.

The TIFF Export Panel allows various image parameters to be set up before the
image is written to disk. When all the parameters are correctly set. pressing the
OK button will save the image to disk.

Image Content

The type of file saved is detennined by the radio buttons of Save Binary. Save
Grey or Save Colour. It should be noted that of these only Binary and Grey files
may be reloaded into the Stereoscan 440. If grey is selected then the Palette
option can be selected tp save the colour LUT with the image. The As seen box
may also be selected to save the image after it has been processed by the display
LUT. rather than as it is in the image store. The Reduced option saves a reduced

1 Tag Image File Format Specification Version 5.0 - The Aldus Corporation
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If the file type is selected as binary, then the image content is detennined by the
RGB colour setting. Any pixel in the image which is the colour defined in the
threshold will be saved as a binary I. The RGB levels can be set by typing
absolute numbers in to the RGB fields, or by selecting Threshold and then
clicking on the part of the image which represents the colour to be saved.

~~ The binary condition is detennined by the colour on the display. It is
possible to set up the display LUT so that several grey levels are mapped
onto the same display colour.

Image Size

Info

Subsequently, this data can be read by selecting the Info option from the Import
Tiff panel after highlighting the filename of the appropriate image.
Alternatively, after importing the image into the frame store, the list can be
recalled as annotation by using the Annotation-> nFF data option from the
Annot/Meas panel.

Save State
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current when the image was saved. These macros can be found from the
Tools->Macro option of the drop down menus and then by selecting
Macro->From Tiff.

~
File Name and Directory

The directory in which the image file will be saved is shown on the panel and can
be changed with the file dialog selected from the Change Dir option. The
filename generated for the file is also shown. It consists of a 5 character name
with up to 3 digits. The digits are automatically incremented each time a file is
saved. A list box of the TIFF files in the selected directory is also displayed on
the setup panel.

2.7. Recalling an Image

Unlike the options for recording an image. there is only one way to import an
image to the Stereoscan 440. The TIFF Import panel is selected from the File
menu and allows a file to be selected for import as well as controlling the way it
is displayed.

Before an image can be recalled Freeze must first have been selected.

rn
File Selection

IThe current directory and the list of TIFF files in it are displayed on the Import
panel. The required file is selected from this list. The directory can easily be
changed using the Change Dir dialog. I
Image Infonnation

IWhen a file is selected information contained in the 11FF file is displayed,
including:-

. The type of image

. The size of the image

. The size of any reduced image saved with it. The description text saved with it. Whether a colour palette is present

The only type of 11FF file that cannot be imported is true colour files. Binary
(compressed or uncompressed) and Grey (with or without colour palette) can all
be imported. If a grey file has a colour palette, it is optional whether the palette is

I
I
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imported into the display LUT when the file is loaded (click on the palette box to
import a palette).

Loading Grey Images

For a grey image the only other consideration when loading it is where on the
screen it should be positioned. Clearly if it is a full size image then there is no
option, but if it is smaller it can either be loaded at (0,0) screen co-ordinates, or at
a position defmed by moving the red outline with the mouse. The red outline
appears when the Load at 0,0 option is deselected.

~ Care must be taken when loading grey images which have been saved with
the As Se.n option. Because the saved image has already be.n processed
by the display LVT. it is necessary to reset the display LVT (to linear) so
that the image will appear as it did when it was saved.

The Grey Dir button can be used to display the reduced images of all the grey
files in the current directory, then selecting with the mouse on any of the reduced
images will load the full image associated with it. Individual reduced images can
be loaded with the Reduced button.

Once a grey image has been selected and the red outline box has been position (if
not at 0,0) then the load is initiated with the OK button.

Loading Binary Images

If the image being loaded is binary. then two other fields come into play. Firstly it
is necessary to defme the binary plane into which the image is to be loaded and
secondly the other bits option must be set to the required state. If a binary image
is to be loaded with no reference to anything in the image store at present, then
the other bits option must be set to aear other bits. If the binary image is to
overlay another binary image. then the bit plane must be changed and the other
bits option must be set to Keep other bits. To overlay a binary image on a grey
image select Grey backed as the option for other pixels.

In all cases it will be necessary to define a suitable display LUT to allow the
binary infonnation to be seen. This process is described in Customising the User
Interface.
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I2-46 Chapter 2 Operation

The Clipboard
IThe clipboard is a WindowslM feature which allows infonnation to be copied or

cut to it and pasted from it. Many Window~ applications make use of it to
exchange data. The Stereoscan 440 makes use of the clipboard for the following
purposes: - I

To import certain types of image data from other applications.
To temporarily store part of an image.

The Clipboard option is selected from the File menu. Its appearance is similar
to the TIFF import and export panels with many of the fields being common.
The actual operation is defmed by the Copy Grey. Copy Binary and Paste buttons.

2.8.1. Copying to the Clipboard

The following procedure copies a portion of the image to the clipboard:-

..

.
Freeze the image
Select image type (Copy Grey or Copy Binary)
Select portion of the image with red outline (or select Whole
Screen)
Select OK I

IThe selected area of the image is then copied into the clipboard. If Overlays or
PC Plane options are selected, then the relevant data is merged with the image as
it is copied. The format of the data put into the clipboard by the LEO user
interface is application specific and therefore cannot be read by other
applications. ~
Pasting from the Clipboard

mGrey image data can be copied from the clipboard by selecting Paste on the
Clipboard panel. The position for the past can then be adjusted with the mouse
before selecting OK to copy and therefore cannot be read by other applications. I
The clipboard contents will be determined by the last copy (or cut) made to the
clipboard by any application. If the fonnat of the data is not supported by the
Stereoscan 440, the OK button will be disabled when Paste is selected. The
following types of image fom1at are supported:

~
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Monochrome as a binary image
4 bit grey as a grey image (as bits 4 through 7. other bits
cleared)
4 bit planes as a grey image (as bits 4 through 7. other bits
cleared)
8 bit grey as a grey image
8 bit planes as a grey image
24 bit colour as a pseudo colour image

If the format of the data in the clipboard is supported the Paste function will be
available.
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Having now become familiar with the Stereoscan 440 controls. sample insertion
and basic micrography the operator may find that there are still a number of
effects limiting image quality. This section describes some of these effects and
ways to reduce them. Complete elimination of all problems is often impossible.
and a compromise is usually reached. In order to get the best results from the
Stereoscan 440 it is important to consider the following:-

. Instrument familiarity

. Photographic considerations. Choice of instrument parameters

. Specimen charging

. Specimen preparation

These factors are b'eated separately below. In addition the ways in which the user
interface can be customised to ~ the individual user's needs are described and
fmally a section on troubleshooting is included.

Instrument Familiarity

To get the best results from the Stereoscan 440 it is important to be familiar with
the operations described in this document. If possible attend a Leica Cambridge
operators course which can be arranged by your local Leica representative listed
in Appendix D of this Manual.

Photographic Considerations

A good micrograph is sharply focused. free of astigmatism. noiseless, with
optimum contrast and brighmess. These factors are very user dependent but are
easily achieved with a little practice. Setting image levels correctly results in an
image which is better looking and more readily interpreted. Understanding how
to manipulate grey levels allows tailoring of images for specific purposes.

The camera and record CRT or video copier/printer should be correctly calibrated
and the signal wavefonn should be evenly distributed between the upper and
lower video level markers, nearly spanning the range but never going outside the
limits set by them. Try to select the profile scan position on the image to span
the brightest and darkest areas to give a representative sample of grey or video
levels. The display look-up table editing facility can be used to create a 'visual'
exposure meter that clearly indicates lower and upper levels in the grey scale.
This is a modification of the display look-up table, where the black level is
changed to blue and the white level changed to red. Hence, an image containing
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a good grey scale range will just begin to show areas shaded blue and red. With
this look-up table active, areas of too Iowa signal show blue whereas areas of too
high a signal show red. See Section 3.7.1 The Display LUT Editor.

Other fonDS of display LUT can be used to enhance the contrast or adjust the
brightness of the frozen image.

Many samples exhibit a small amount of charging due to oxide layers or other
surface coatings. These samples show changes in signal level and contrast with
scan speed. For live micrographs of these samples, the signal should be set up
using a scan speed similar to that to be used for the photograph. The image store
is particularly useful, as it can be used to save film by allowing the image to be
acquired and checked before photographing it. Also, many identical prints may
be taken without the need to scan the sample again.

3.3. Choice of Instrument Parameters

Instrument parameters have a large effect upon the fmal image quality. To some
extent the parameters chosen are dedicated by the sample and its interaction with
the beam. For each different specimen, some experimentation will usually be
required before arriving at the optimum conditions. Having achieved these
conditions, they may be saved on disk (as a Macro file) for future reference, see
Section 3.7.2 The Macro Editor.

Accelerating Voltage (EHT)3.3.1.

The accelerating voltage, or beam energy, is one of the most important factors in
achieving a satisfactory sample examination. It will affect:-

. Damage to the specimen by the beam

. Visible surface detail

. The production of X-rays for analysis. Image resolution

In detenIlining the accelerating voltage, the following factors must be
considered: -

Beam Damage

If the specimen is beam sensitive, a higher accelerating voltage will result in a
greater risk of the sample being damaged by the beam. This can introduce
artefacts into the image which may appear as cracking or darkened areas in the
image. The cause of this phenomenon is a localised heating or ionisation of the
specimen in the area of examination, hence the problem worsens as the
magnification is increased. Beam damage can also be the result of using too
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high a probe current, thus the accelerating voltage and probe current should both
be adjusted together to detennine the optimum settings. This problem is usually
exhibited by low atomic weight specimens such as plastics or biological samples.
Coating the specimen with conducting film such as gold often helps to dissipate
the heat generated by the beam. However. better results are usually obtained by
operating at lower voltages. A beam-blank facility is provided on the Stereoscan
440 so that. for sensitive samples. electron beam exposure can be minimised.

Surface Detail

The accelerating voltage of the electron beam directly affects the amount of
surface detail seen in the image. This is most easily understood by considering
the simplified beam-specimen interaction volu~ shown in Figure 3.1.

FIgUre 3.1
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The zone ofp~mary excitation increases in depth and diameter with a high
accelerating voltage. Backscattered electrons which are generated mainly
beneath the specimen surface possess enough energy to ionise one or more
specimen atoms before escaping from the specimen surface. Each of these
ionisations produces more secondary electrons which are added to the true
secondary electron signal and result in a loss of surface detail. The use of too
high a voltage also results in parts of the sample exhibiting very bright edges.
The 'edge effect' is caused by the electron beam completely penetrating the edge
of the feature, so that secondary electrons are produced from a larger effective
surface area, see Figures 3.2(a) and 3.2(b) below.

rn

I

Figure 3.2(a) Sample of fractured aluminium at
high voltage showing edge effect
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, Chapter 3 Advanced Operation 3-5

FIgUre 3.2(b) Sample of fractured aluminium at
low voltage without edge effect

X-Ray Analysis

The production of X-rays from the spec~n is caused by the reDK>val of an
elecb'on from one of the atom's shells and the subsequent re-arrangement of the
remaining electrons. The initial removal of an elecb1m is caused by the primary
elecb'on beam. therefore the beam energy must be sufficient to overcome the
binding energy of the electron to be removed. X-rays may be emitted as a result
of ionisations within any of the elecb'on shells - K. L or M and are then temled,
K, L or M X-rays. The energy required to stimulate a particular X-ray is known
as the critical energy, therefore if the energy of the primary beam is less than the
critical energy, no X-ray is produced. Thus, for example if analysis for iron is
required, then the beam energy must be at least 6.4KeV (to produce an iron K
peak). In fact. for ideal analysis (especially quantitative) the accelerating voltage
should be 1.5 to 2 times the critical energy of the highest energy peak to be
analysed; this is known as the 'overvoltage'. Samples that charge, or are non-
conducting should be coated with a suitable material chosen to give electrical and
thermal conductivity, but not to interfere with the elements specifically being
analysed. For example, if caJbon is the element of interest in the spectrum then it
would not be a good idea to coat the sample with carbon. In this case, aluminium
would be better because it has a sufficiently low atomic number not to attenuate
too much of the carbon signal (whereas coating with gold probably would).
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I
Resolution

IResolution can be defmed as the minimum distance by which two adjacent
features can be seen to be separated. as two discrete points. The best resolution is
usually obtained at high accelerating voltages since the shorter wavelength of
electrons at high voltages minimises any diffraction.

Other instrument parameters also significantly affect the resolution achievable
including Probe Current, Working Distance and Aperture Size. I
Probe Current

IThe probe current is defined as the total electron current reaching the specimen
surface. The value can be adjusted from the user interface in the range I pA to
I~. In most cases, a value of lOOpA gives a good video signal without over
exposing the sample to electron bombardment. Other settings would be as
follows:- I

High Resolution: 5pA to 25pA

Backscattered electron imaging: 200pA to 500pA

X-Ray analysis: 600pA to loA

Charge or beam sensitive samples: lOpA to 2OpA

The improved resolution performance at low probe currents is achieved because
the diameter of the beam on the specimen is reduced. A larger beam diameter is
acceptable for X-ray analysis because of the larger volume of interaction (see
Figure 3.1).

Working Distance

Working distance is defmed as the distance in millimetres between the bottom of
the lens and the sample surface. In common with many of the other SEM
parameters, choice of working distance for the specimen may have to be a
compromise. The factors to be considered are:-

l.' As the working distance is decreased the available resolution increases.
The optimum position is in the range 3 to lOmm.

2. If a large sample is to be examined and there is a danger of contact with
the BSD or lens, it is wise to use a longer working distance.
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3. The retractable backscattered electron detector occupies a fmite space
beneath the fmallens. All parts of the sample should therefore be just
clear, particularly when the dete~r is to be moved in or out of position.
A safe working distance is 12mm.

,4.- The geometry used for X-ray analysis, at a 350 take-off angle, dictates
that the surface to be analysed should be at a working distance of 25mm.

~ An improvement in depth of focus, the vertical distance over which the
sample appears to be in focus, can usually be made by increasing the
working distance. An increased working distance has the effect of
decreasing the angular aperture of the electron beam. (See Figure 3.3)

BEAM

FIgUre 3.3 Enhancement of Depth of Focus

Item 5 above directly conflicts with item 1. However, improvements in depth of
focus are usually required at relatively low magnifications where the minimal
loss of resolution caused by using a longer working distance would not be
noticed. Depth of focus can also be improved by using a smaller aperture, say
30Jlm or 20Jffi1, or by selecting Optibeam depth of focus mode. This selects the
lens settings which give the greatest depth of focus while maintaining the
selected probe current.
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3-8 Chapter 3 Advanced Operation

ISpecimen Tilt

Tilting the specimen can greatly affect the SEM image, not only by changing the
area excited but also by altering the zone of secondary electron emission. The
size of this zone varies with the angle at which the primary beam strikes the
specimen. When the specimen surface is perpendicular to the beam, the zone
from which secondary electrons are emitted is smaller than when the specimen
surface is tilted. Since more secondary electrons are emitted. the tilted surface
gives a brighter signal. Tilting in the range 20 to 40° gives the best result. Very
often, a small amount of tilt adds some depth to the final image which gives more
visual appeal than a flat image.

Other Parameters I
In addition to the parameters mentioned previously. the following should all be
checked:- I

I.
.
.

Electton gun con-ectly aligned

Stigmators correctly adjusted
Aperture centred
Correct film speed selected
Gamma and derivative as required

I
~
I
~
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I~.." - Chapter 3 Advanced Operation 3'-9

3.4. Specimen Charging

Electrons incident upon the sample which do not escape as backscattered or
secondary electrons are absorbed by the sample. Unless these absorbed electrons
can fmd their way to ground (as in a conductive sample) they will remain in the
sample resulting in a negative charge build up exhibited as one of the following
image defects:-

. Loss of image contrast (see Figure 3.4)

. Very bright or dark areas (see Figure 3.5)

. Image or beam shift (shearing) (see Figure 3.6)

Dust and other debris on the sample surface can also charge up, and appear as a
bright area on the image surrounded by a dark region. The charged debris may
deflect secondary electron emission and sometimes the incident beam, causing
dark region and possibly image 'shearing' (see Figure 3.6). H the sample itself is
charging, beam deflection will occur during scanning, the effect being seen as a
slow image drift followed by a jump back to its original position.

FIgUIe 3.4 Loss of Contrast Due to Charging
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FIgUre 3.5 BrightIDark Areas Due to Charging

Specimen charging of non or badly conducting specimens is dependent on the
charge equilibrium inside the sample. The secondary electron yield (S) is defmed
as the number of secondary electrons which leave the sample for one incoming
primary electron. The corresponding number for backscattered electrons is the
backscatter coefficient (B). If the total electron yield T=B+S equals I, the charge
balance is zero and therefore no charging occurs. If T increases above I, the
sample should charge up positively because more electrons leave the sample than
primary electrons enter it. If T falls below I, the sample will charge up
negatively. One of the most important parameters for changing the total electron
yield T is the primary beam energy. This is shown in Figure 3.7 which shows the
typical dependence of T on the primary beam energy Eo. If the primary beam =
Ec2' then no specimen charging occurs. Typically, Ec2 lies between 500e V and
2KeV.
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Figure 3.6/mage Shearing Due to Charging

Figure 3.7 Relationship Between Primary Energy Eo

and Total Electron Yield T
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The total electron yield can also be increased by tilting the specimen. A tilt in
the region of 20 to 40 will greatly reduce charging.

i~
The other most important factor affecting charging is electron "dose rate". This
can be defined as the total number of primary electrons per unit area of the
specimen as a function of time. In other words, the scan speed of the beam is
critically important. It can be seen that on some beam sensitive materials a fast
scan speed gives a good screen image with good contrast and topography (see
Figure 3.8(a» whilst a slow scan speed, ie for live photography, (see Figure
3.8(b» causes the image to display the defects mentioned previously. The
following diagrams illustrate this effect.

~

n

I
~

FIgUre 3.8(a) Taken at a fast scan speed
The above shows a sample of Ceramic

In this case, the image store can be used to acquire the image, with noise
reduction if necessary, at a fast scan speed. The stored image can then be
photographed or stored to disk.

r:I
Stereoscan 440 Operator Manual



" Chapter 3 Advanced Operation 3-13

Figure 3.8(b) Taken at a slow scan speed
The abow shows a sample of Ceramic

3.5. Specimen Preparation

Specimens which are studied in the SEM can be divided into two main
categories, namely conductors and non-conductors. Factors to consider during
specimen preparation are given below:-

The size of the specimen must be reduced (if necessary) to fit the
available specimen holders and specimen stages, but there is often an
advantage in selecting an even smaller sample size for ease of
roservation.

2 The object must be able to withstand being in the high vacuum of the
SEM; it must not change its shape, and it must not outgas. A cold stage
may help here.

3, It should be clean, ie free of dust, oils and greases. (Their presence can
lead to charging and contamination effects.)

4. It may be treated to improve the secondary yield if this is low, eg coating
of the sample with gold.

s. Any disturbance in the surface structure caused by preparation
procedures should give rise to surface details which are too fme to be
resolved at the magnification used to record the images.
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H an artefact is suspected as a result of a preparative procedure. a control
specimen should be utilised.

6.

7. The speci~n stub should be in good elecbical contact with ground
potential.

8

.8

There should be good elecbical contact between the surface of the
specimen and the specimen stub, ie attach sample to stub with
conducting paint such as Silver-Dag and coat the specimen adequately if
necessary .

9. The speci~n stub should give rise to as few backscattered and
secondary electrons as possible. Aluminium stubs are normally used,
although carbon stubs are used for some X-ray microanalysis
applications.

10. Very small particles are best mounted on a low mass foil to give rise to
minimal background signals. eg nylon film stretched over an aluminium
ring.

11 The sample must be attached to the s~n holder (stub) so that it
does not move whilst being irradiated by the electron beam.

12, The sample should be attached to the specimen holder (stub) so that all
the surface can be studied using the existing stage movements (eg tilt,
rotate, X, Y, Z).

-
Conductors

These fall into two groups:-

. Metallic: these are generally excellent conductors and need no

preparation. Semi-conducting samples with a resistance of less than
10-10 ohms can be examined without special preparation

Non-Conductors

This group includes all samples which are not electrically conducting, eg dIOse
generally not containing volatiles, eg fibres, plastics, polymers, semi-conductors
with a resistance greater than about 10-10 ohms.

Those generally containing volatiles, eg biological and tKJtanical material
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Non-Volatile, Non-Conductors

If it is not possible to obtain suitable resolution by using a low accelerating
voltage and leaving the sample uncoated. then the following applies:-

For most non-conductors which contain no volatile components, eg water, that
would outgas in the vacuum system it is sufficient to coat the sample with a thin
layer of conducting medium such as Au, C, Au/Pd. Al etc. This layer is typically
20-3Onm in thickness. There are several reasons for this coating:-

. Increased conductivity of the sample, thus minimising sample
charge up, which results in deflection of the incident beam and
severe degradation of the fmal image. (see Section 3 .4 Specimen

Charging)
. Increased mechanical stability of the sample due to increased heat

condition.
. Increase in primary and secondary electron emission.
. Decrease in beam penetration, resulting in better spatial resolution.

The two important current techniques of applying a coating are
vacuum evaporation and ion sputtering.

Gold is generally used for the following reasons:-

. High secondary emission co-efficient.. High conduction of electrons and heat.. Does not oxidise.

. Good granularity of evaporated or sputtered particles.

Carbon coating by evaporation is generally used if X-ray microanalysis is to be
undertaken on the sample unless, of course, the element under investigation
happens to be carbon. Aluminium could be used in this case.

More recently Pt/Pd and Au/Pd have been used since their granularity is smaller.
Aluminium can also be used, but it has low mechanical strength and can oxidise

Non-Conductors (Volatile)

Biological and botanical samples, by their nature, require relatively more
complex preparation procedures. The samples fall into two main categories: a)
hard, b) soft.

Hard samples (eg bone, teeth, wood). These, if necessary, can be
washed to remove extraneous fluids such as blood and mucus, dried in
air and coated in the normal way.

8.
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b. Soft Samples

. Untreated - Soft tissue needs more specialised treatment. Most soft
tissue contains up to 90% water which must be removed without altering
the structure. If this is not done, there will be difficulty in achieving
adequate vacuum in the SEM, and complete or partial sample collapse
and distortion will occur.

So~ ~ca1 speci~ns can be observed successfully for short perl<xls
provided that thought is given to the selection of instrument parameters,
eg using a low accelerating voltage and beam current.

. Replication - Although it is usually only adequate for low

magnification work and for comparatively simple surface topography,
replication has the advantage that the sample can be totally preserved.
One method of replication uses an elastomeric material such as silicone
rubber to obtain an impression. A positive replica is then obtained from
the impression by coating it with low-viscosity polymethylmethacrylate
solution, allowing this to dry and then stripping the resultant film away.
Coating and examination follow in the usual manner.

With suitable modification, transmission electron microscope replication
techniques can be utilised.

. Chemical Pre- Treatment - This technique involves chemical
fixation of the material to strengthen the tissue. There is a large range
of chemicals used in this process (eg glutaraldehyde and osmium
teb'Oxide) and there are numerous publications discussing the benefits of
each. After fiXation, it is necessary to displace the water in the sample
by a solvent to aid drying. The method must be such that the specimen
suffers no physical change. The commonest drying agent used is a
series of ethanoUwater mixtures through to 100% ethanol. Having
replaced the water present in the sample there is a choice of three
methods for drying:-

i) Freeze Drying
This is a complicated procedure, and may not be too
successful. The sample is quench-frozen and maintained at low
temperanlre (about -130°C) until the sublimation process is

complete.

U) Air Drying
It is worthwhile flfSt transferring the specimen to a solvent of
low volatility (eg amyl acetate) as the last stage of dehydration.
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The solvent is then allowed to evaporate from the sample under
carefully controlled temperature conditions. As this is a gentle
process, there is little chance of any specimen damage.

Iii) Critical Point Drying
The specimen is dehydrated as previously described and the .
solvent replaced with a liquified gas in small pressure vessel.
The vessel is then heated to above the critical temperature of
the selected gas. Under these conditions the liquid and vapour
phases have the sample physical properties, so that on venting,
the liquid vapourises across cell boundaries and therefore
minimum sample distortion occurs.

The sample may however, undergo some mechanical shock
during the venting stage. The choice of gas for this process is
limited by the number of available gases which have a critical
temperature relatively close to ambient, a safe pressure level
and low toxicity, whilst at the same time being completely
miscible in all proportions with the solvent selected in the final
stages of dehydration. It is important to replace the solvent
completely with the liquified gas (usually carbon dioxide)
before venting.

General Considerations
The methods described above for soft tissue preparation are mainly for
secondary electron imaging. The problems facing the biologist or
botanist who wishes to undertake X-ray microanalysis are different in
that the requirements in this case are to maintain the element(s) of
interest in their original position in the sample. There is not one major
preparative technique for biological/botanical samples. Where possible,
several combinations should be tried for a particular type of sample,
giving prime consideration to the information sought. Once a technique
has been established, instrument parameters and specimen coating
methods must be carefully considered.

Using the Digital Image Store

Noise

The image store of the Stereoscan 440 is particularly useful in situations where
use of poor signal-to-noise conditions is forced. In these circumstances, noise
can be removed from the image before photography. For example, samples that
exhibit charging often require the use of a very small probe current. Noise arises
from the electronics of the video system and gives a grainy appearance to the
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image. This occurs in situations where there is little signal detected from the
specimen and the photomultiplier gain (or amplifier gain for BSD) is increased to
compensate. A low signal can be the result of a small electron emission co-
efficient of the sample or of the choice of microscope operating conditions, eg
low probe current. The amount of signal compared to the noise content is known

as the signal to noise ratio.

Noise Reduction3.6.2.

Prior to the use of digital techniques the only way to reduce the noise in the
signal was to use a slower scan speed. This allows the beam to dwell longer on
each scanned point of the specimen so that more signal is collected. Digital
methods of noise reduction utilise the fact that the noise is random in nature. If
the signal from a single specimen point is sampled repeatedly and the average
taken, noise will be averaged out and the signal will be reinforced.

On the Stereoscan 440 the concept of scan rate is replaced by pixel averaging.
The pixel average parameter detennines the number of times each pixel is
sampled with the average making up the signal to the image store. Increasing
the pixel averaging has an effect similar to using a slower scan rate (thus the
image takes longer to acquire, but will have less noise in it). Reduced raster
mode does not change the pixel averaging, but does reduce the cycle time (the
time taken to perform an image acquisition) which makes adjusting certain

parameters easier.

Additional noise reduction of two other types may be applied.

Frame Average

When frame average is selected the live signal is proportionally mixed with the
store signal so that the image reflects the average of the recent frames. The
proportion of live to stored can be adjusted with the parameter N which
represents the number of frames to be averaged. Frame average can be selected
with any level of pixel average, but is generally most useful at the faster speeds
(lower pixel average) where a larger amount of noise reduction can be obtained
without introducing a long cycle time.

Line Average

Selecting the line average causes each line to be scanned a number of times

before the scan moves on. The average line signal is stored and displayed.
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Choice or Tecbnique

The decision as to which noise reduction technique is to be used will depend to
some extent on the specimen being imaged. If it is sensitive or prone to charging
then frame average may well be the best option because the beam does not dwell
at one place for a long period of time. Line average is used when the result of the
noise reduction needs to be seen without waiting for the cycle to complete.
Increased pixel average is most useful when doing live photo records (where the
image goes directly to the HRRU without being processed in the image store).

On the Noise Reduction panel there are two options for freezing the store. At
End is used to freeze the store when an acquisition cycle completes, whereas
Now causes the image to freeze as soon as the button is selected.

Customising the User Interface

Careful thought and design has gone into producing a user interface which ~ts
the requirements of Stereoscan 400 users. However it is recognised that user
requirements are so diverse that it is impossible to provide one interface which
~ts every requirement. Therefore several feab1res are provided which allow the
user to customise the interface to meet their individual needs. The following
parts of the user interface can be customised:-

. The display look up table (LUT)

. The action of function keys FS - F8 (Macros). The status display

. The appearance and operation of the tool bar

The Display LUT Editor

The display LUT editor provides a mechanism for altering the mapping between
the grey level in the image store and the way in which the pixel is displayed on
the monitor. The LUT is really three LUTs in one, a mapping exists for each
video colour (Red. Green and Blue). If these three mappings are the same then
the image will appear as Dk)Dochrome (grey) on the monitor.

There is one important rule to bear in mind when editing LUTs, which is

Each grey level must have one and only one LUT value.

It is however permissible for several grey levels to be mapped onto a single colour
(or shade). in fact this is one of the more useful features of the display LUT.
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The LUT Editor

The display LUT editor is selected from the Edit ~nu. Its own ~nu provides
option for both grey and colour LUTs as well as facilities for loading and saving
LUT files. Before considering the menu options in detail it is necessary to
understand the concept of a LUT. as seen by the system.

A LUT is a collection of points which are connected by arcs. The simplestLUT
has just two points (0.0) and (255.255) connected by a straight line. Various
operations can be performed on points (they can be added, moved or deleted).
other operations are performed on arcs (actually on the two points defining an
arc) including level and threshold.

In the LUT editor, the middle and right mouse buttons have a special meaning
The middle button is used to select the colour being adjusted (when editing a
colour LUT). The right button is used to select between move, add and level
1JK)(jes, which detennine the operation on the points.

Move
When in move mode, selecting a point in a LUT allows it to be moved. A point
can be positioned anywhere on the vertical scale, but must lie between its
neighbouring points along the horizontal scale. It is always the point nearest to
the cursor when the left mouse button is clicked which will move.

There is one further restriction required to ensure the LUT remains consistent.
that is the two end points of the LUT can only be moved vertically.

Add
On a click. of the left mouse button a point will be added at the cursor position.
The LUT curve will be redrawn so that the point is included at its proper place.
Note that point delete mode can only be selected from the Points menu appearing
in the Grey and Colour options.

Level
In level mode, a click on an arc of the LUT will cause that arc to beco~
horizontal. This is accomplished without moving the end points of the arcs either
side of the selected arc, so it is so~times necessary to inb'oduce a new point at
either end of the selected arc. Once the arc is horizontal it can be dragged
upwards or downwards to the desired level.

A similar function exists for the vertical steps in the LUT curve, that is the
Threshold function which can be selected from the Points menu. It allows a step
in the LUT to be moved left or right.
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Other Menu Features
The display of the LUT diagram can be scaled as 1 or 2 pixels per grey level in

the horizontal scale. This is done with the Scale menu option.

The Reset menu option should be used with care. It will replace the existing LUT
with the default linear grey LUT. Although Reset appears in several menus, its
operation is always identical, with one exception - when it is selected from the

Colour->Points menu, only the currently selected colour is reset. In all other
cases the entire LUT is reset to linear.

When setting up a LUT it is sometimes useful to refer to the grey level of an area
of the image, the atPoint function allows this. Selecting atPoint displays a line
cursor on the LUT profile. Then when the mouse is clicked on a point of the
image, the grey level at that point is reflected by the position of the line cursor.

There is one further feature which is often helpful in setting up LUTs, that is the
Grey Wedge option on the Grey menu. If the store is frozen, this option can be
selected to fill the store with a grey slope image (black on the left, to white on the
right). This image clearly shows the effect of any changes to the disp.1ay LUT in

either grey or colour mode.

Colour LUTs

Colour LUTs can be set up to achieve a variety of effects. It is possible to have a
normal grey LUT, with a different colour set up for the low grey levels, to achieve
a background effect for an image. A blue/red LUT for the low and high grey
levels (described earlier in this chapter) may be useful for setting brightness
levels, the operations to set it up are described below as an example.

A higbllow limit LUT:-

1. Select Red colour (middle mouse button)
2. Select Add Point mode (right mouse button)
3. Add a point on the red line at the lowest grey level required

(using grey wedge and atPoint if necessary)
4. Add a point at the highest grey level required
5. Repeat the above steps for green and blue
6. Select Level mode (right mouse button)
7. Select blue (if not already selected)
8. Select the low arc (between 0 and the low point)
9~ Move the blue level to maximum (highest point)
10. Select the high arc
11. Move the blue level to minimum
12. Select Green
13. Select the low arc
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14. Move the green level to minimum
1'. Select the high arc
16. Move the green level to minimum
17. Select Red
18. Select the low arc
19. Move the red level to minimum
20. Select the high arc
21. Move the red level to maximum
22. Save the LUT as points or a LUT if requ~ (see Saving and

Loading LUTs)

Monochrome LUTt

Monochrome LUTs operate in two distinct ways. Points mode is similar to colour
LUTs, Fonnula mode is an entirely different approach. In points mode the LUT
consists of a series of points connected by straight lines, but in fannula mode an
equation is used to calculate the grey level at any given point. In this mode
changes to the LUT are made by changing the coefficients of the LUT equation.
Different equations are used for the different types of control required. The
equation can be either Bliahtness aDd Contrast or Gamma. In addition to these
the whole grey profile can be inverted with the Invert option (only available in
fonnula mode), and plotted on the LUT display with the Plot option.

Brightness and Contrast
When Brightness or Contrast is selected a scroll bar appears at the bottom of the
display LUT window. For brightness it controls the vertical position of the curve.
for contrast the slope of the curve is adjusted. The effect of these CODb"Ols is
similar to the signal level brightness and contrast CODb"Ols and can be used to
adjust the overall appearance of the image. The LUT is determined by the
straight line equation:-

y=ax+b

where a is the contrast and b the brightness. Any point which is less than zero is
set to black and any point exceeding 255 is set to white.

Gamma
The Gamma option allows the LUT to be defined as a curve. The gamma
parameter can be adjusted either way from a straight line so that the LUT can be
made to expand the low or high grey levels. This function can be used to enhance
an image where a large amount of detail is contained within a few grey levels.

Slereoscan 440 Operator Manual



Points and Steps
In addition to the fonnula mode monochrome LUTs, it is possible to use a
monochrome LUT in points mode (in the same way as colour LUTs). Points can
be added, moved and deleted in the same way as for colour and the level and
threshold functions are also available.

One further function is defmed for monochrome LUTs. the Steps function. When
steps is selected. the LUT is turned into a monotonic series of grey level steps.
The height of each step (Amplitude). the position of the first step (Offset) and
the number of steps (period) can all be adjusted. It is also possible to
subsequently modify the LUT using the point functions.

Saving and Loading LUTs

The are two ways of saving and loading LUT files. A LUT can be saved as a
series of values (one for each grey level), or it can be saved as a series of points.
Both types of LUT can subsequently be reloaded, but only a points file can be
modified after it has been reloaded. Points and LUT files have different default
extensions, .OL T for LUT and .DLU for points files.

~ Monochrome LUTs defined in fonnula mode can only be saved as un
files.

3.7.2. The Macro Editor

A macro is a sequence of instructions which can be executed by the user to
achieve a specific result. Macro execution is initiated in several ways:-. From icons. By panel buttons

. By function keys. When restoring conditions

In addition it is also possible to edit, load and save macros and macro libraries. It
is also possible to record a sequence of user instructions to generate a macro.

Each macro has a name which is displayed on the right of the toolbar while the
macro is executing.

Macro execution may be tenninated by pressing the Ese on the keyboard or by
clicking on the macro name in the toolbar. Execution can be suspended by use of
the keyboard PaUR key. A paused Macro is indicated by the! character before
the macro name in the tool bar. The macro may be resumed by a second selection
of the Pause key.
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Instructions

The following types of instruction can be used within macros:-

Calls
A call instruction executes another installed macro. The maximum nesting level
of calls is 5.

Comments
A comment provides the user with the ability to annotate a macro and performs
no action when executed.

~Commands
A command executes a specific SEM command. If the command is disabled, the
macro will not step on to the next instruction.

ISet Digital State
Sets the specified digital parameter into the defmed state. It will not step on to
the next instruction if the parameter is currently disabled.

Set Analogue Value
Sets the specified analogue parameter to the defined value. If the value is outside
the parameter's allowed range, then the parameter will be set to the nearest limit.
It will not step on to the next instruction if the parameter is disabled.

Set Co-ordinate Valoe
This instruction perfonns the same action as set analogue value except that it
sets the value for a pair of parameters making up a co-ordinate pair (x and y).

Stage Goto
This instruction moves the stage to the defined X, Y and Z co-ordinates. It does
not step on to the next instruction if stage movement is currently disabled.

Wait For
The wait for instruction waits until the specified state is achieved. An optional
timeout parameter may be specified (in seconds) which limits the amount of time
the instruction will wait. If no timeout parameter is specified (not zero seconds,
but no characters) then the instruction will wait for the state indefinitely.

Delay
This instruction waits for the specified number of seconds before continuing.

Pause
The pause instruction acts in the same way as the pause key. It causes the
execution of the Macro to be suspended.
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Confirm
This instruction check that the instrument configuration matches the defined
configuration. If the configuration is different, the user is given the option of
continuing the execution or aborting the macro.

Message
The defined text is displayed in a dialog box until the user clicks on the OK
button. Execution of the macro then continues.

Show/Hide Panel
The show and hide panel instructions are used to display and remove panels to
and from the screen.

Load Display LUT
The load display LUT instruction loads the display LUT from the specified .OL T
file. When this instruction is inserted into a macro, the current display LUT is
used to generate a file and the user is prompted for a filename.

Function
Performs one of the set of specially defmed actions if the appropriate licences are

installed.

Control Structures

There are two types of control structure provided:.

While
If then

WhileConstnlcts
The While construct allows a series of instructions to be repeatedly executed
while the specified condition is true. It takes the form:-

While <condition> (alternatively While Not <condition»
other statements
End While

While Statement
The While statement is part of the While construct. If the condition defmed is
true then the next instruction in sequence is executed, otherwise execution
continues after the End While statement.

Stereoscan 440 Operator Manual



I3-26 Chapter 3 Advanced Operation

While Not Statement
The While Not statement is part of the While construct. If the condition defined
is false then the next instruction in sequence is executed. otherwise execution
continues after the End While statement.

End Whlle Statement
The End While statement is part of the While construct. When this function is
executed it resets the statement counter to the corresponding While or While Not
statement. Each While or While Not statement must have one and only one
End While statement.

If Constructs

The If consb"uct allows selection of the appropriate set of instructions based on a
condition. It takes the fonn:-

If <condition> (alternatively If Not <condition> then)
other statements
optional else
other statements for else clause

End If

H <condition> then
The If statement is part of the if construct. If the condition is true execution
continues at the statement after the If. If the condition is false execution
continues after the Else statement if one exists, or after the End If if there is no
Else clause. I

IIf Not <condition> then
The If Not statement is part of the if construct. If the condition is false execution
continues at the statement after the If. If the condition is true execution continues
after the Else statement if one exists, or after the End If if there is no Else clause.

Else statement
The Else statement is an optional part of the if construct and is used to indicate
the start of the Else Clause. ~

I
End H statement
The End If statement is part of the if construct and identifies the end of the
conditional sequence. Each If or If Not statement must have one and only one
End If statement.
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Editor Facilities

The macro editor is selected from the TooIs->Macro menu option. The name of
the macro is displayed in the window caption together with the mode. The macro
instructions are displayed in the window in the sequence in which they will be
executed. The menu offers a range of options which are described below:

Reset
The reset instruction clears the macro window and name (setting the name to
ANON) and inserts a comment defining the time and date in the macro window.

New
This option perfonns the same action as reset, except that the user is prompted
for the name of the new macro.

Rename
Allow the user to change the name of a macro.

Insert
Initiates the dialog which adds an instruction of the specified type into the macro
after the current instruction. The type of instruction is selected from a list box,
then according to the type of instruction, the user is presented with further
options to specify the instruction.

Edit
Some but not all instructions may be edited. Selecting edit allows the text of an
instruction to be changed. If an instruction is not editable. delete it and insert an
new one.

Delete
The delete functions deletes the currently highlighted instruction.

Load/Save
A macro may be saved in a file with a .MAC extension by the save option. The
user is able to specify the filename for the ftIe. Any .MAC files can also be loaded
into the macro editor for further alteration or for execution with the load option.

Save as Text
This option allows a macro ftIe to be written in text format. The default. TXT
extension is used and the resulting file can be read by the notepad editor. It is not
possible to load a text macro file.

Fetch/lnstall/Remove
The fetch. install and remove options all relate to the subject of macro libraries
which are described below.
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Execu teJS top/Co ntin ue
The Execute command causes the current macro to be executed from the
beginning. Execution can be intemlpted at any point with the Stop function. It is
then possible to edit the macro before selecting Continue which will resume
execution of the macro from the currently highlighted instruction.

Record
The record option allows a sequence of user interface operations to be converted
into a macro. All operations between selecting Record and the subsequent
selection of Stop are recorded as a macro.

To reduce redundant instructions only the final value of analogue
parameters is insel1ed as an instruction. There is no sense of time delay in
the recorded sequence. each instruction follows directly after its
predecessor. To introduce time delays. Wait For and Delay instructions
must be insel1ed with the editor.

Libraries

A library is a collection of macros. The Stereoscan 440 comes with a standard
library which contains the macros required by the user interface for standard calls
from menus and panels.

AIl macro libraries must contain the standard macros as a subset.

Once a macro is in a library it can be assigned to a toolbar icon (see Section 3.7.4
The Toolbar Editor) or called from one of the user defmed function keys.

The assignment to function keys is made entirely by the macro name. For
example, macro FS is assigned to function key 5, while macro Shift F6 is
assigned to the shifted function key 6.

The following operations may be performed on macro libraries:-

Install
A macro can be installed into a library, which means that it will appear in the list
of macros which can be selected. If a macro of the same name already exists in
the library, the user is asked whether the old macro should be overwritten.

Fetch
Fetching a macro from a library, loads it into the edit window where it can be
executed or edited.
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Remove
Removing a macro from a library deletes that macro from the library.

Save/Load
Macro libraries may be saved as files as well as individual macro files. Libraries
have the .MLF extension. Note that the standard library calls should not be
altered as this could cause unexpected side effects when loading macro libraries.
The Load->Standard option is provided to allow an easy route back to the
default macro library should it be required.

Example

This macro will enable the operator to select operating conditions suitable for
adjusting the fmal aperture, by selecting function key F5.

Click on words in normal type, enter text and values in bold type on the
keyboard: -

Tools, Macro, Macro, New, FS, OK
Insert. Insb'uctions, Analogue, M, Mag, OK. 2000, OK
Insert, Instructions, Command, R, Reduced, OK
Insert. Insb'uctions, Analogue, R, Red. Raster pasn X, OK. 384, OK
Insert, Insb'uctions, Analogue, R, Red. Raster pasn Y, OK, 156 OK
Insert, Insb'uctions, Analogue, R, Red. Raster height, OK, 256, OK.
Insert, Insb'uctions, Analogue, R, Red. Raster width, OK 156, OK
Insert, InSb'uctions, Command, P, Pixel average 4, OK
Insert, Instructions, Command, F, Frame average
Insert, InSb'uctions, Digital, F, Focus wobble, OK, On, OK
Insert, Insb'uctions, Digital, W, Wobble rate, OK. Fast, OK
Insert, Insb'uctions, Analogue, C3W, C3 Wobble Amplitude, SO
Install, Yes

Press function key F5 to see it working.

Now to save this macro:-

Click on Macro->Save, then delete the default name and enter
WOBBLE.MAC. You can then FETCH the file from the macro library
or load it from the file and EXECUTE it if required.

Saving and Loading Conditions

A further use for macros is in saving and loading instrument conditions. The
Restore macro has already been described (Chapter I Getting Started Section 1.4
Common Operating Routines). It is initiated from the run up icon and restores

Stereoscan 440 OlJerator Manual



3-30 Chapter 3 Advanced Operation

the previous operating conditions. Those conditions are saved when the system is
closed down by the macro generator.

The macro generator builds a macro which when executed restores the previous
condition of the instrument. It can be selected at any time from the Flle->Save
State menu option and can be made to generate a macro to restore any
combination of the following:-

. Configuration

. Setup. Gun Conditions

. Application Conditions. Display LUT

The user is prompted for a LUT file name (if that option is chosen) and a name
for the macro.

~The Standard option is provided to set the instrument to a default state
should the restore macro be saved as some undesirable state.

IAny instrument conditions macro may be loaded directly in and executed with
the Load State option. However the Preview State option has the advantage that
the conditions can be examined before the macro is executed. The preview menu
also allows the conditions to be executed (OK), edited (Edit) or changed for
another set (Fetch).

I
Any macro of instrument conditions that is created by the File->Saye State
menu option is saved with the file extension .APP and not .MAC so that it is
easier for the operator to separate the two types of macro.

I3.7.3. The Status Display

The status display was introduced in Chapter I. There is a little more to it than
meets the eye. It is of course a window for displaying instrument parameters
which can be chosen using the Select menu option. But it also provides certain
control facilities which will be described in this section. The basic operation of
the display will be covered first.

Selecting a Set of Parameters

IThe status display can be cleared at any time using the Reset menu option. The
Select option is used to add or remove individual items from the display. When
select is chosen, a select box will appear containing a list of all the possible
system parameters which may be displayed. Highlighting a value means that it
will appear in the display when OK is selected.
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The position in the list can be controlled using the scroll bar or by typing the first
one or two letters of the required parameter in the text entry box. When all the
required parameters are selected, the OK button will cause the status display to be
reconfigured to reflect the new selections.

Some of the parameters in the display may appear greyed out which means that
in the current operating mode, that parameter cannot be altered by the user.

Saving and Loading Status Display Files

It is likely that the user will require different parameters in the status display for
different activities. To avoid the need to constantly reconfigure the display, a file
save and load facility has been provided. Selecting FUe->Save from the menu
will cause a dialog box to appear allowing the user to specify the filename before
the file is saved. All status display files are saved with the .SSL extension.
FUe->Load works in the usual way (overwriting the current status display
configuration).

Adjusting Parameters from the Status Display

The way in which a parameter can be adjusted from the status display varies

according to the parameter type. Parameters may be read only, analogue, binary

digital (boolean) or multi value digital. The methods of adjusting them are

summarised below:-

Left

Button

AssignlO
LeftM~
Parameter
T Ie
Select Box

Middle
ButtOII
Assign to
Right Mouse
Parameter

Right
Button
Preset
Values

~ Double
CIkk

Analogue Dialog Value

En1l'y~" uIti v~~

"tal
Keyboenl Only Dialog Val~

Entrv
Dialog Val~
En1l'V

Dialog Val~
Entrv

I Read OnlY

The actions listed above are defmed as follows:-

Assign to Mouse
Control of the parameter is assigned to the mouse (and navigation box if
present) for adjustment.

Dialog Valoe Entry
A dialog box appears which allows the new value for the parameter to be
entered.
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Preset Valus
A select box appears which displays all the previously defined preset
values for that parameter. A new preset value can be defined as a label
for the current ~ter value. or a previously defined value can be
used. The preset values are labels which can be used to set an individual
parameter to a fIXed value.

Toggle
A binary digital parameter has only two states (Off/0n, Yes/No,
Fast/Slow, etc). Selecting such a p~ter simply changes it to its
alternative state.

Select Box
A select box appears with all the possible values for the parameter in
question. A value is selected from the list and the parameter is set to it.

~ Whenever a double click is perfomaed the relevant left or middle single
click action is perfomaed before the double click action.

3.7.4. The Too/bar Editor

The fmal option available for modifying the user interface is the toolbar editor. It
allows the actions and appearance of the icons in the toolbar to be modified.
Icons may be added. deleted or edited using the toolbar editor which is selected
from the Toolbar option of the Edit menu. Different toolbars can be loaded and
saved and a new toolbar can be installed from the editor.

Too/bars

A toolbar is a sequence of icons with their associated bibnaps and actions. A
popup menu controls the changes to the icons in the editor. Some operations
apply to the whole list, others apply to individual icons. The fonner are
considered in this section.

Relet
The reset command deletes the current icon list.

Fetch
This command loads the current toolbar into the editor, overwriting any icons in
the editor at the time.

LoadJSave
A toolbar can be saved as a file (with an .rrB extension). A toolbar file can be
loaded into the editor overwriting its current contents.
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Install
The install option copies the icon list from the editor into the toolbar area. The
current icon list is then lost. The current toolbar is saved when the system is
shutdown.

~
~

Should the distribution toolbar be inadvertently lost, it can be restored by
selecting Novice or Expert mode (as appropriate)from the File menu.

Icon Order
The order of the icons in the toolbar can be changed simply by dragging an icon
to another position, this will swap the icon with the one currently occupying that
position. Identical icons may appear several times in the toolbar to ensure that
any given icon is always visible.

Icons

Individual icons in the toolbar can be defined to appear and behave in certain
ways. There are two types of icons, Buttons and Toggles. A button executes an
action when it is selected, whereas a toggle changes state (for example, image
inverted to not inverted or vice versa). New icons of either type may be created
and also deleted (by selecting an icon then delete on the popup menu).

A red border is used to indicate the currently selected icon. The following
properties of the selected icon may be edited:-

Size
There are two sizes of icon available large (64 x 64 pixels) and small (36 x 36
pixels). Selecting the smaller icons allows more icons to be displayed.

Bitmaps
The bitmap associated with any given icon may be altered using the Next and
Prev options on the popup menu. Repeated selections will cycle through the set
of installed bitmaps for that type of icon.

Actions
Each icon has an action associated with a selection with the left mouse button
and one associated with the middle or right mouse buttons. The actions can be
selected using the Edit option on the popup menu. The choices available for an
icon depend on its type, but will be from the following list:-. Command

Executes the low level command
. Panel

Displays the panel.
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I

Macro
Executes the defined macro
Mouse
Assigns the selected parameters to mouse conb"ol
Function
Executes the high level function
State
Toggles the state of the binary parameter

Icon Example

I

I

This example shows how to add an icon to the toolbar which blanks and unblanks
the beam on selection:-

I. Select Edit->Toolbar.
2. Select right mouse button (to bring up popup menu).
3. Select Fetch.
4. Select New Toggle.
5. Select Next (until desired bit map is selected).
6. Select Edit (on popup menu).
7. Select State.
8. Select Beam Blank~ OK.
9. Select Panel (for right button action).
10. Select Gun Align (or any preferred panel), OK.
II. Select OK on the edit panel.
12. Select Install, Off.

Selecting the new icon with the left mouse button will cause the beam to be
alternately blanked and unblanked.

I

I
.II

I
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3.8. Trouble-Shooting
~~~Sb8r.-. - !(C)-

~ FiD8I ~ ()uIity

IcAue ~u~
~ Aorigmlli-- - ~

«~
MacuetM: fields (fnxn ~ «
exIaDI1

PIx." of fcx:us

Too IDJc:b Dolle

~-::~-.;-~--;-.;; ~«of-
1X*-iaI~

I§~i~~~

1(8) II-.e ~ ~l"--~
~~ lC~'J~

I =- ~ I::-~~~ =~ low
... eJeI:In.I coIIecIor

FaaIty.,;nr;11 8MI/cxo

- --

~~-

rs~~
--

I~;:~~'~ ~~

I ~ms~~~
I ~ IIIIIJIetic fields

,~~
Table .Stlnmary of Image Defects.
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I(A) I~Error

I DEFECT 'CAU~

I~1~ Low contrast, lack of video signal (if

JX'Ibe cuneDt too low), possible

~ of . shift

whenfc:JCUsiDa

IIK:Omc:tlXtiJecuneot

(2) IDCOm!Ct tiDal aperture a1i~

(3) I ~ image sbarpoess in ~
~J)OOr resolution

IDSufticient a.~8JJIatism ~

Wrong scanning perlOO(4) Noisy image, beam detJcdiOD 00

IevelIdecWJd
1.:Iec:Iedon . on aod g ax:e voIIaae

charging I

1
(8) I Extema1lDOueia ~~ -'

I lDEFECIj I (CAUSE)

1<1) Image distortioo,jagged edges in
imaRe --

~cfields

(2) IJa&&ed.-iD imaae Ivitx'moil I(C) I s...pIe TY1Je aDd Peuetratioo

1DBl!Ect- j CAUSE

~U) Reflected and secondary electron
images brighten with increasing
atomic nwnber

Atomic number effect

I(2) I Image shift and distortiOl!; ~ I ChaI'ge-up
contrast and unstable ~

'(3) :

J
~
i(.1) I

DefOnJlatioo and Cl¥king of
I~ coatina ~Iina

CharRe-UD or samole ~-

~g (kV or probe ~t too high)

lnconect or inadeQUate ~ coaIine
Surface coating leading to poor
imaee a~itv

Contaminabon

roo Sample deformation, damaF- &lid
charRe-uo

Incorrect sample preparation (especially

soft Iiss~ etc)

Table "Image Defect Causes"

1
~
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I PARAMETER I En"ECT OPTIMUM
CONDITIONS

COMMENTS

I Mounting on to

soecimen stub

OIarging:V~-oa-.l-sea:irely attacbed u~ quick - drying adhesive

(oreferablv conductin~)
! ConductivitYaDd
eroundine

Charging Good rooductioo to eanh u~ cooducting paint (Dag)

Spec~ distortionSensItiVIty to

Deamdamage

u~:- Low beam ~t
and/oc low tV. short frame
~od. Focus away {rQn
- of iDrerat

~ culditioos ~y IaUh in
ooorSNR

Coating CoIxIuctivity No charging OIaIJiDg - as: local ideIISity

changes; astigmatism; image
distu1ioo; dark micrographs

, ~ meIal co8iDa I If too thick can mask Iktai1ICoatin2 IS.E.Si~
, Carbon coaIin2 I If too thick will absorb si2Dal

-~~~~~~Carbon, aluminium coatin
Carbon, aluminium coating Avoid intcrfereIx:e with e~s)

of interest

!Coating

ICOating

IMecbanical
~tv:_-

---
Resolution: Cracks
in coatin~

'
I Vibration amplitude less

than reQuired resolution

Reduce k V. aDd beam cuneDt

I EIK:eDtric Position 1= : ~ I No transIati-oo-iJlc>tion

durin9; tiltina

u~ EIx:eDIric gooiormer stage
f~ best results

I S~ Tilting I TOPO.P8Ph~' sigDa! I About 45° f« SEt ~. I FcxIIMI by expt.

WDOIseral10 . _~_BSD ~onsample

I~ Tilting I Stereo Viewing Tilt difference 5-100 u~ low BIllIes for Imp MiJbt

~
j Workina Distance Resolution

~ of f(K:US
Sample - BSD
DistaIK:e

~.
, ~ of finalleos dama2e
I Limit = Loss of ~utiOll

Working~
Long - Best forTopog and

Crystal Orientation
SOO1t - Best for Z-ContIast

Table "Specimen Parameters"
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Hard Disk Directory, Structure and Management

The LEO UIF runs under the Microsoft@ WindowsTM operating system. This
graphical operating system is loaded on top of a base disk operating system
known as DOS. The DOS operating system is responsible for storing and
handling ftIes on the system.

If you are new to computers or DOS, you may have trouble understanding
certain tenDS used in this manual. This section provides you with a brief
overview of the following DOS concepts and functions.

This information is by no means a complete explanation of the OOS operating
system. If you need more details, please refer to the MS-DOS@ users manual
that was delivered with the system.

What is DOS?

As mentioned above, DOS is shorthand for Disk Operating System. MS-DOS@
is Microsoft's@ version of DOS, while DR-DOS and PC-DOS are renditions
from Digital Research and IBM. DOS is the b'affic co-ordinator, manager, and
operator for the transactions that occur between the parts of the computer system
and the computer system and the user. DOS operates in the background, taking
care of low level computer tasks for example, the flow of characters between the
keyboard and the computer, between the computer and printer, and between
disk(s) and internal memory (RAM).

Other transactions are initiated by entering commands on the DOS command
line; in other words, immediately after the DOS prompt. The DOS prompt
probably looks like one of the following:-

A>
B>
c>

The capital letter refers to the active disk drive (the one DOS is using right now).
For instance, if the prompt is A>, it means that drive A is active and that
commands given to DOS will refer to that drive. When another disk is required,
the only command needed is the letter of the disk, followed by a colon and
Return (usually the key marked .J). For instance, to switch to drive A, just type

A: Enter
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4.5. Good Housekeeping, i.e. keeping sufficient
free disk space

As the LEO User Interface operates as a WindowsTM Application, it relies on
sufficient system resources from the WindowsTM operating system itself. In this
case, system resources refer to both free physical memory, and free hard-disk
space.

If either of the above resources are in short supply, system performance can be
impaired. As the physical memory fitted in the machine is managed by the
system software itself, little can be done to improve system performance in this
way, other than ensuring that only the applications that are required are loaded
into memory at anyone time.

Because WindowsTM provides a 'virtual machine' environment to its applications,
generally an application can demand as much memory from the system as it
needs. When physical memory is full, WindowsTM will temporarily swap 'chunks'
or 'pages' of it onto the hard-disk using a process known as paging. If the hard
disk is nearly full, this reduces the size of the temporary fIles Window~ creates,
and thus increases the frequency at which these files are accessed.

As free hard-disk space is a premium. there are a number of good housekeeping
strategies the system administrator can employ to ensure maximum software
efficiency. All the functions shown below can be performed using the
WindowslM File Manager:-

. Ensure that any unused user directories are backed up and
removed from the system

. Remove any unwanted image files from the system regularly by
backing the fIles up then deleting them from the hard-disk

. Check that any temporary files from the \ Windows \ TEMP

subdirectory are deleted
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There are a few frequently used DOS commands which it is necessary to be
familiar with :

To erase a fileDEL or ERASE

To see a list of files on the logged diskDIR

To copy files from one disk or disk area
to another

COpy

To rename a fileREN or RENAME

DOS is not case sensitive, so commands can be entered in upper or lower case as
preferred by the user.

The remainder of this chapter assumes familiarity with the above commands.
refer to the DOS manual for further information about them.

Directories, Subdirectories, and Directory Structure4.1.2.

A directory is a convenient way to organise floppy or hard disk files. Directories
allow the disk to be subdivided into sections, in a similar manner to
conventional paper filing systems with draws and files. For example, a "Reports"
subdirectory could contain a document template for a standard report, together
with images to be included in reports and even spreadsheets containing
additional information to be included.

On the system. it may be convenient to create a directory to hold all SEM image
files, another for reports, another for notes, and so on. That way, it isn't
necessary to wade through hundreds of files looking for the right one. Only the
files from the current directory are listed with the OIR command or in a file
selection box.

Although directories can be created on either floppy or hard disks, they are used
most often on hard disks. Because hard disks can hold a greater volume of data,
there is a greater need for the organisation and compartmentalisation.

At the DOS level, rather than in for example the LEO User Interface, DOS can
be told to create directories, move files around between directories, and display
which files are in a particular directory. See Section 4.2 Creating and Using
User Directories for a practical example.
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4.1.3. Subdirectories

For a greater degree of organisational structure it is possible to create
subdirectories, or even subdirectories of subdirectories. There is no limit to the
number which can be created, but too much structure may make it difficult for
the user to keep track of where files are stored.

To set the currently logged directory. use the CHDIR or CD command followed
by the name of the directory.

The DOS prompt indicates the current directory. If a subdirectory of IMAGES
called TIFF, which is in turn a subdirectory of drive C is the current directory,
the DOS prompt will look like:-

C:\IMAGES\TIFF>

Notice the backs lash (\) before the directory names. When moving from one
directory to another unrelated directory, type the name of the directory preceded
by a backslash. The parent of any subdirectory is the directory immediately
above it. In the example above, the parent of nFF is IMAGES- nFF is the
subdirectory, IMAGES is the directory.

A backs lash inserted directly after the drive characters refers to the top-level or
root directory. The root directory does not have a parent directory.

. To switch to the root directory, simply enter CHDIR \
followed by Return. To enter the IMAGES directory, type
CHDIR \ IMAGES, to enter the nFF subdirectory, type CHDIR
\IMAGES\TIFF and so on.

. DOS always works relative to the currently logged directory. In
IMAGES, to go to nFF, simply enter CHDIR TIFF. To go
straight to the root directory type CHDIR \ or CHDIR C: \

. Fmally, to move from a subdirectory to its parent directory, for
example to move from nFF to IMAGES, specify '..' as the
directory in the CHDIR command
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4.1.4. The LEO Directory Structure

Below is a graphical representation of how the files are arranged for the LEO
User Interface-LEO UIF. Each directory is shown as a 'folder'. This format is
compatible with Window~ File Manager: ~

I

.c:\

CJ applics
I:Jdos
CJ gsputils
C:J hrru
CJ leo

~ a help
~ I:J res

CJ licence
CJ lo~

CJtiga
l:Juser
CJ windows

~

In addition there are two generic directories:-

CJ images
C:Juser

c:J ---
LJ ---
C:J ---

Except where specifically defined, riles or directories should NOT be
modified in any way. Leica Cambridge will not be responsible for
consequences if the above riles or directories are modified.
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4.1.5. Directory Contents

I \nGA i This directory is used to hold the 2raohics DroceSsor files.
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Creating and Using User Directories

From DOS

In the examples that follow, it is assumed that the hard disk is the current drive
so that the prompt on the screen is similar to C: \>. To create directories on
floppy disks, substitute A or B for C in this example.

To make directories for USER fIles, do the following:-

Select the MS-DOS@ Prompt icon from the WindowslM Main Group-
as shown below.

2 Type CHDIR \ USER and press Return. The CHDIR command tells
DOS to move into the USER directory. See above for an explanation on
directories and subdirectories.

3. At the c: \ USER> prompt, type MKDIR NEWUSER and press Return.
The MKDIR command tells DOS to make a directory called NEWUSER
in subdirectory USER. To create additional directories, simply substitute
NEWUSER for the new directory name. For example, try MKDIR
HENRY or MKDIR DAVE.

If you make a mistake. simply remove the directory with the command
RD NEWUSER Return. where NEWUSER represents the directory you
wish to delete.

4.

That's all there is to it. A directory should be treated in the same way as a disk
drive: To access any specific DOS file such as a saved nFF image for example,
the correct directory must be specified, or DOS won't be able to find the file.

From WindowSrM

The concept and final results are the same as in DOS when creating directories
from within WindowslM. Simply click on the File Manager icon instead of the
MS-DOS@ Prompt icon--shown below. Refer to the WindowslM on-line help, or
the Windows User Guide for File Manager operation.
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4.3. The User Directory Concept

A user directory is simply a convenient way of separating the frequently
changing LEO User Interface configuration parameters, from the system
software data files. It can also be used to keep each user's files separate. If each
user has their own configuration parameter directory, the system can be
configured to suit each user in tenDS of tool-bars, menus, modes of operation etc,
without having to re-configure the User Interface each time it is loaded.

As mentioned above. a subdirectory of the \USER directory is selected on system
startup which is used to hold these customised or user specific files. The
directory may be subsequently changed from the Top Menu. This is the directory
that should be entered into the dialog box displayed during LEO UIF
initialisation: -
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Such files found in this directory may include:

APP .LF.O:i.A yotiTlEo, MACROS.LEO, OU11.PTS.LEO, OU1LU1L.LEO,
STA1WIND.SSL,TOOLBAR.LEO, *.ANN, *.ITB, *.MAC, *.M!.F, *.OLT,
*.PRE, *.SSL, *.TIF, *,ULU,*.XYZ

Refer to the section on file types for an explanation of the various uses for each
of the file types listed above.

4.3.1. Backing Up The User Directory

It is advisable to make frequent backups of this directory onto floppy-disk for
safe keeping. In this way, any unwanted changes to the User Interface
configuration or operating conditions can be partially restored by copying the
files back as required. See the Microsoft@ WindowsTM. User Guide for details
on copying files using the WindowsTM File Manager.
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File Types, e.g. T/F, OL T, MAC etc.

LEO Files

F"de type: Description:

Standard Annotation These are files with the extension ANN. They contain annotation
~ls for measurement (e.g. angular. radial. profile etc.) and
datazone.
The master copies are held in \LEO. if required modified versions

I may be saved in the user directory where they will be used in
nreference to the master copies.
For further infonnation use context help on the annotation and
measurement u menu.

V-=uum System These fi1es are specific to tile vacuum system and electron optics ot :

the SEM. They bold calibration infomlation essential to the

operation of the microscope.
DEFAULT. V AC is used for initialising tile vacuum system Non
Volatile RAM (NVRAM) and DATA. V AC holds a backup copy or
the NVRAM current data.

CONAG.LEO This file holds configuration infomlation specific to the

microsCOlJe. --
Annotation font These files widt extension FNT are Foot files for use in the SEM

overlay plane !;5!!annotation and meas~t functi~-
POINT .8MP

I This file COOtaiDS the bitmap used for point to point meas~t.
If requ~this may be reolaced by an alternative ~~~,

!Licence These ~ files with the extension LIC which ~ used to install
licences which enable mi~ functions to be used.
A licence file is specific to a microscope and may only be installed
by the LEO licence install application.
A copy is held in the \LICENCE directory for reinstallation should

this be reql!i~.

UceDCe report These are text files with extension REP which contain the Mport
generated by the LEO Licence Install application when a licence
file is installed.
~y~V be ins1)eCted usine NOTEPAD. --

I LOG.LEO I This is a text file which records~ficant events on the.
microscope.
Note that while the interface is nmning this file is being ~sed
and panial contents may still be in memory.
This file is for use by Leica Service personnel.
For further information use context sensitive help on the

~!!fi2uration menu.

11.OO.oLD This is an archived log file.
This file is for use by Leica Service personnel.
For further infomlation use context sensitive help on the
Confi2uration menu. "--
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4.4.2. Machine Specific Interlace Files

Description:IFiIe :

These ftIes contain !be EXPERT. NOVICE and SERVICE
user interface panels

'These ftIes CODtain die EXPERT. NOVICE and SERVICE

toolban_-
This file contains the installed m-=ro library. The standard
macro library file is located in the \S44O directory.
On system shutdown a copy of the current installed macro
library is saved as MACROS.LEO in the user directory
On system starttlp the macro library is loaded from file
MACROS.LEO in the user directory if one exists. otherwise
the standard m-=ro library is loaded.

EXPERT .LA Y .
NOVlCE.LA Y.
FI'EST.LAY

EXPERT .n"B.
NOVlCE.n'B, FI'EST.rI'8
MACROS.LEO

APP.LEO This file is located in the user directory aDd records the user
customisation on shutdown (e.g. window positions).

This file is located in the user directory aDd records the
current set of user oanels on shutdown.

LAYOUT .LEO

Ou-n.Prs.LEO I This file is located in the user directory and records the
- ~~PJ!.y~ ,,?!indow points list on shutdown.

Olm.U1L.LBO This fiJe is located in the user directory aDd contains the

disolav Lur~~~~~~utdown. 0- -- -
This rue is 1(K:ated in the user directory and contains the
Slattls selection list for the status window on shutdown.

STA1WIND.SSL

I'I'OOLBAR.LEOI This fiJe is located in the user directory and contains the
cunent TOOLBAR on shutdown.

.ANN files These ~ annotation panels or complete overlay infonnation
saved bv the annotation/measurement function

.I1Bfiles These are files containing Toolbar seq~nces (Icon Toolbar)
CIe_3cted with the Toolbar Editor.

I.MAC files I These are mxro files created bv the macro editor.

I These are Macro Ubrarv files saved bv the macro Editor.

I.OLTfiles These are files containing actual display LUT coDtaIts saved
by the display LUT Window

These are files containing display LUT points lists saved by

~~s~y _~tr:r_'!Iindow

.DLU files

.ULU files IThese are files containing a User defined points list generated I

!!y-.!!!e~out Ltrr Window -
.PRE files These ~ files containing predefined values for specific

parameters. The file ~ is derived from the parameter
~monic.

.XYZ files These are files of stage position infomlation generated by the
staRe window.

.11F files These are files in 'nFF fOmlat

I.SSL files These are status selecti~_l~~.!n_~_~~-~~-~
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~6-12 Chapter 6 Fault Diagnosis

The printer can only print Grey or binary files.

CLIPBOARD BITMAP CREATE ERROR

IThis failure is given when cutting an image to clipboard.

This is typically caused by inadequate PC memory (or disk swap file). Close any
other applications.

CLIPBOARD - BITMAP DATA ERROR

IThis error indicates that the data in the bitmap is corrupt.

CLIPBOARD CONVERSION MEMORY ERROR

This failure is given when cutting an image to clipboard.

This is typically caused by inadequate PC memory (or disk swap fIle). Close any
other applications or free up space on hard disk. (N .B. swap fIle must be
contiguous space). rn

ICLIPBOARD FETCH FAILED

This failure is given when pasting an image from clipboard.

The call to the clipboard returned a failure.

CLIPBOARD - GET CONTEXT FAILED

This error indicates that a display context could not be obtained.

Inadequate resources. Close other applications.

CLIPBOARD - UNKNOWN BITMAP TYPE

IThe clipboard contains a bitmap of a type which cannot be handled by die LEO
software.

rn
CONFIG FILE READ ERROR - USING DEFAULT

This error occurs when an attempt is made to access a parameter or state which is
currently disabled by the operational rules.

~
This error is given when a file error is detected on reading the configuration file
CONFIG.LEO or when a fomlat error is detected.
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Chapter 5

User maintenance on this series of instruments is very limited, and is resbicted to
items that .Q.Q..nQ! require any panels to be removed in order to gain access to
them.

THERE ARE NO USER SERVICEABLE PARTS BEIDND THE PANELS,
AND REMOVAL OF A PANEL EXPOSES mGH VOLTAGES AND
mGHL Y SENSITIVE ELECTRONIC CIRCUITRY.

User serviceable items are as follows:-. Firing Unit
. Anode Cleaning
. Final Aperture replacement
. Desiccator Silica Crystal replacement
. Liner Tube Cleansing and Aperture replacement (if suitable

cleaning facilities exist). Rotary pump oil changes

ALL other maintenance operations, including these, if required. should be
carried out by Leica Service Engineers, or authorised agents, and will be done on
Service and Period Maintenance visits. These include:-. Turbo pump maintenance (as well as the rotary pump)

. Collector system maintenance (including light pipe change IF

required)
. Cleaning of fans
. Full column cleaning - if necessary

5.1. Routine Basic Maintenance

5.1.1. Rotary Pump Oil Level

Check the oil level in the sight glass on the pump. The minimum oil level is the
lower edge of the sight glass. The maximum level is 25mm below the top of the
glass. When necessary top up with oil of the type specified for the particular
pump in use (ie Edwards no 15 for Edwards pump, or Alcatel VPl for Alcatel

pumps).
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5-2 Chapter 5 Maintenance

5.1.2. Air Admittance Drier Assembly

If the air drier is allowed to become ineffective the pump down time of the
Stereoscan 440 will become longer than normal. The assembly is mounted on
the rear panel of the plinth. The colour of the desiccant in the assembly should
be checked daily and if it shows signs of becoming saturated ie turning from to
pink or white, it should be replaced or reactivated. To renew the desiccant:-

Unclip the drier from the rear of the plinth.

Unscrew the large knurled retaining ring from one end of the assembly
and remove the end cap. Remove the filter wa..~her beneath it. The
desiccant can now be poured out and either dried or discarded. Remove
the remaining filter washer and the perforated metal support.

2:

3. Clean the parts by washing in a suitable solvent. eg liquid detergent.
after which each part must be thoroughly rinsed and dried.

Replace the perforated metal support with the concave side facing away
from where the desiccant will be. Cover with two filter washers (shiny
side away from the desiccant). Fill the assembly with new or reactivated
desiccant. Fit a filter washer with the shiny side towards the desiccant.
Fit the end cap and kurled clamp ring.

4.

5. Refit the assembly to the rear of the plinth.

5.2. Six Monthly Maintenance

5.2.1. Changing the Rotary Pump Oil

It is recommended that the rotary pump oil is changed after the first 100 hours
operation and thereafter at 6-monthly intervals, with intemlediate checks on the
oil level.

To change the oil:-

J Select CHAMBER vacuum vent and wait for the rotary pump to stop.

2. Place a container of not less than 2.5 litres capacity under the oil drain
plug at the bottom of the pump. Remove the plug and drain the oil.

3. Replace the drain plug and remove the filler plug at the top of the pump.
Refill the pump with the oil recommended in the pump manufacturers
handbook.
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4. Replace the filler plug. Refit the '0' ring carrier, '0' ring, pump hose
manifold clamp ring and 2 screws.

5. While pumping the system down, check the condition of the oil mist
flIter (if fitted). If a strong smell of oil vapour can be detected the
elements of the filter must be changed. In addition if the oil within the
filter reaches the maximum mark, it should be drained. The pump
should be switched off for both of these operations.

Column Servicing

The periods between cleaning will depend on the frequency of use, type of
specimens and environmental conditions, etc. As a general rule, if the required
perfonnance can be achieved then leave well alone. Cleaning is only necessary if
the resolution deteriorates and cannot be improved by adjustment. The degree of
cleaning needed can only be detennined by inspecting the column components.

Routine cleaning consists of cleaning the grid and anode and inserting clean
apertures. If this does not restore the performance, then the whole column must
be dismantled and cleaned. The extent of this depends on the severity of
contamination, which can only be found by inspecting the column as it is
dismantled.

Cleaning Recommendations

All swabs should be made from clean, absorbent. lint free material which will
leave no dust or particles on the cleaned surfaces. A low power binocular
microscope is useful to enable dust particles to be seen. All cleaned components
must be covered to protect them from dust in the atmosphere. Great care must be
taken when handling any part of the column since all parts are machined to close
tolerance. Nylon gloves must be worn when handling all polepieces, gun parts
and other components exposed to the electron beam.

An aerosol of compressed gas is very useful for blowing the dust off each
component as it is replaced in the column. Commercial compressed air should
not be used as it contains oil vapour.

Do not allow any liquid to come into contact with the gun ceramic. It is
essential to avoid magnetising any part of the column. The steel used
for components in the magnetic circuits (ie polepieces) is of a very soft
type and will rust very quickly if left in the atmosphere. Where
possible the column should be kept under vacuum.
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STEEL AND ST ~S STEEL, COPPER AND mDURAL
CO~NENTS. (Hidural is the coppery looking metal.)"

ALUMINIUM AND ALUMINIUM ALLOY COMPONENTS

These components may be cleaned with Hyprez diamond compound
grade l-W-47 or, in the case of severe contamination, grade 4-W-47.
Wash off all Hyprez with the solvent recommended by the local Service
Centre (see Appendix D), preferably in an ultrasonic cleaner, and dry off
using a hot air blower.

DO NOT USE QUADRALENE ON ANY COMPONENTS
CONTAINING ALUMINIUM.

MOL YDENUM SPRAY APERTURES AND PLATINUM f1NAL
APERTURES

2.

Molydenum spray apertures may be cleaned by Method 1 above. It is
recommended that the platinum final apertures are replaced when they
become dirty or discoloured.

MU METAL These components should not be cleaned except for the
removal of dust. It is important that the metal is not strained or dropped
as this will reduce its effectiveness as a magnetic screen.

3.

'0' RINGS '0' rings may be cleaned with, a lint free tissue. The use of
'0' ring grease is not recommended on any '0' rings, but a small amount
may be used, if necessary, on moving seals eg in the specimen stage and
aperture changer micrometers. The grease must be applied with a lint
free tissue to avoid contamination with natural oils, using only enough
grease to just put a shine on the '0' ring. High vacuum (eg FOMBLIN)
grease is recommended.

4.

'0' RING GROOVES AND FACES should be cleaned using the
appropriate solvents for the particular material.

5

Any component with '0' ring grooves and/or mating surfaces, and
which is to be ultrasonically cleaned, should be placed in the cleaner
tank in such a way that the groove or face does not touch the walls of
the tank, or any other components.
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5.3.2. Routine Column Cleaning

The numbers quoted thus (23) refer to the identification markers in the diagram
below (Figure 5.1):-

Figure 5.1 77Je Column

Certain screws in the column are connected with the electron optical
alignment of the column. If these screws are touched, the column
alignment will be affected, leading to time consuming realignment.
Therefore only those screws identified in the following instructions
should be adjusted or unscrewed.
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Cleaning the Gun Assembly

1. Vent the column and chamber to air.

Open the gun.

3. Loosen the three filament assembly clamp screws (1) and remove the
filament assembly (2).

Lift out the anode (3). Take care, as the anode is a very good fit on the
top of the alignment coils (4).

4.

"~, Close the gun while the components are cleaned. Take the filament
assembly and anode to a clean area for cleaning.

Using the flat metal key unscrew the height adjustment ring and remove
the filament carrier.

6.

Loosen the four screws (see Figure 5.2) holding the filament into the
carrier and remove the filament.

8. Clean the grid and anode.

9. Replace the anode on top of the alignment coil making sure that it is
correctly seated into its location boss. The anode should sit level on the
alignment coil and be free to rotate, but not loose.

10. If necessary change the filament, centre it in the grid and replace the
assembly in the gun (as described in Section 2.2.4 Changing the
Filament).

Pump down the column and chamber and run up the gun, not forgetting
to check the filament saturation and gun alignment, as these may have
changed with the new filament.

11
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Figure 5.2 The Firing Unit

Stereoscan 440 Operator Manual



Cleaning the Aperture Assembly

Vent the column and chamber to air.

Remove the four M3 screws holding the aperture changer (11) into the
column and remove this assembly from the column.

2.

Take the aperture assembly to a clean area for cleaning.3.

Remove the three screws holding the aperture clamp plate onto the
aperture blade (see Figure 5.3). Lift off the clamp plate and remove the

apertures.

4.

Clean the aperture clamp plate.5.

Insert new apertures into the aperture blade and fit the aperture clamp
plate and screws.

6.

Clean the '0' ring on the aperture changer and replace the assembly into
the column and secure with the four screws.



Cbaoter6

The Stereoscan 440 has been designed to achieve a high standard of reliability.
However as with any complex system faults 00 occur from time to time. When
they do the key requirement is to identify the fault and rectify it with the
minimum possible inconvenience to the user. This chapter is provided to assist in
diagnosing faults and identifying the correct course of action.

In the event of some difficulty being experienced with the instnlment, it is
strongly recommended that the HELP messages available are read. With the aid
of these it should be possible to either identify and rectify the problem, or to be
able to provide enough infonnation to the local service centre for them to be able
to remedy any fault speedily and efficiently.

Please note that in the event of having to contact your local service centre, the
following infonnation will be required:-

Instru~t serial number
Order number
Software version number
Description of error messages

Any given fault in the system is either a PC fault or a fault within the Stereoscan
system. Because the error messages and symptoms of these fault types differ. they
will be tIeated separately. But flnt it is necessary to review the diagnostic
information available from the system.

6.1. Diagnostic Aids

There are various aids available to help in diagnosis of any problems, these are:

The Front Panel illuminated switches
The StabJs LEDs at the rear of the insttument
The various Error Messages generated by the instturnent
The effect of various controls on image quality

They should all be noted when b"oubleshooting, and the results passed back to
your Service Centre, if you do not manage to clear the fault from this
iofonnation.
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PC Related Faults

PC related problems are usually diagnosed by the BIOS (Basic I/O System) when
the machine boots up. There are two ways in which such problems are reported to
the user, by "BEEP" codes or by BIOS error ~sages.

Beep Codes

If an eITor occurs during the Power On Self Test (POST) routines, this is usually
communicated to the user through a series of audible beeps. In the event of any of
the BEEP codes sounding, it is highly likely that the PC card will have to be
replaced, although some may help identify a more simple problem.

The following is a list of BEEP cooes with possible causes:-

I BEEPS I ERROR MESSAGE I POSSIBLE CAUSE

R8fI88f1 Falure
Error

B88e64KBMemory
Falin
Tineroot
PI ~ Error
~ - Ga. Fdure

p~ EX(:8pIM
Inenu Error
Displayu.nory
Aead/Write Error
ROM Checksum Error
CMOSShutdown
~r Read/Write
Error

~
3 Memory fault - d1eck SIMMS are

sealBdCXlrrecdv
4

~
~
7

~ Fault ?

VGA Card Fault ?8

~
10

All these faults will prevent the system from booting up, with the exception of
No.8. This error will allow boot-up to be completed and cause an error message
to be printed on the screen.

BIOS E~r Codes

In the event of a non-fatal error occurring, the BIOS diagnostic system provides a
series of error messages. These error messages are displayed in the following
format:-

ERROR Message Li~e ;t,

ERROR Message Line ~
Press <Fl> to RESUME
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The non-fatal error ~ssages are displayed fust, and then

Press the <Fl> key to continue with the boot procedure

is displayed. The < F 1 > prompt message is not displayed if

~ait for <Fl> if any Error

in ADVANCED CMOS SET-UP has been DISABLED. For most non-fatal error
~ssages there is onJy one message. If a second ~sage appears it will be :-

RUN SETUP t1I'ILITY

If this message occurs, press <Fl> to run AMI BIOS SE1UP

Overleaf is a listing of all the AMI Non-Fatal Error Messages

6.2.3. AMI BIOS Non-Fatal e~r Messages
ERROR MESSAGE EXPLA.~AnON

~Gat8A20EntX' Gare A2O 00 die keyboani controller (8042) is mX working.

~ the *>42

Addr.- Une Shoru An Error has ooaJrr8d In U1e ~ decodng drcultry

The BK)S is not ~ any ;-eepc;, - ~ from hard cI8k

drive C:. Run ~ Hard DIsk UUIity to oon8d"5
problem. Also. d18ck the C: hard disk type In tie
S1andard CMOS ~ ~ m8f8 sure

C : DrIve Enor

C: Drive FaikAre The BIOS cannot get a r88pc.18e from tt1e hard dl8< C
~"H8rdDlsk

Cad18 Memory Bad. Do not Enable Cache Memory Is defedIve. Run a Diagnostic UUUty
Cache sudI as AMI DiagnostIc.

CH-2TknerEnor An AT ay8tem has two timers. There Is an error with
timert2

CMOS Battery Sta1e Low CMOS RAM is powered ~ a bau.y. The batIBry pCM'8r
is kJW. Replace tie bat8Iy.

CMOS Chasum Failure After Ct.«)S RAM ~ 818 s.-, a ~ v8ue
Is ~ for 8m)!' d""~IIij. 1he message appears if
~ prevtOOS vakI8 Is dfter8nt from ~ CUrlW1t value.
~ s-.Jp.

CMOS Sy8I8n 0pMcx18 nd let The values stored In CMOS RAM are either oorru~ «
na1-exI8I81t. Run ~.

CW>SDepaytypeMsrnatd1 The video type In CMOS RAM dO88 not maEh V18 type
de8c:8d 171 V18 BIOS. ~n 58114).
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, .". ",~",~" ""'" . -,

The amount of memory found tr)' tie BIOS is different
from the amount in CMOS RAM. Run Setup. ICMOS Memory size Mismatch

Run tt'8 Standard CMOS Setup to eet h da1B and Wne
In CMOS RAM

CMOS 11me & Date Not Set

IThe BIOS is not receiving any response from the hard
disk drive D:. Run the Hard Disk UtIlity. Also check 1I1e
D: hard disk type in Standard CMOS Setup to make
sure 1hat 1I1e hard (j8k type is correct.

D: DrIve Enor

The BIOS canoot get a respoose from hard disk drive
D:. ReplaC» I1e hard dsk.

D: Drive Failure

The ~ diskette In IIoppy drive A: Is CXJrrupt. It cannot
be used to boot tie system. U- another boot dskette
and follow the screen inslructloos.

DIk8tI8 Boot Falure

IScxne systems require that a video switch be set to
either ooIour or monochrome. Tum the system off, set
tie ~ property, tt1en JX7W8r on.

DIsplay Switd1 not ~ set

IAn error has ooourred W\ tie DMA Controuer.DMA EffOr

An error has occurred in tt'8 first DMA Ctlannel.DMA #1 Error

An error has ooourred WlI1e ~ DMA Channel.DMA #2 Enor

The BIOS can read the dskette in floppy drive A:, but it
cannot boot the system with it. Use another boot
diskette and follow the screen Instructions.

Invalid Boot DIskette

Keyboard Is IoQ(8d . Unlod< It

I
The keyooard lock on U1e system is engaged. The
system must be unlocked to oontinue the boot prcx:ess.

There Is a timi'tg problem with the keyboard. Make sure
an AMI Keyboard BIOS Is installed. Set "Keyooard" In
the S1andard CMOS to "Not Installed", whk:h skips the
keyboard POST rootInes.

KeyiX)ardError

IKeo,.board Interface Error n.re Is an error ~ the keyboard CXJnnector.

Cannot find a proper ~ sector on ehr diskette
drive A: or hard disk Drive C:. The BIOS cannot find
ROM Basic.

No ROM BASIC

I
I
I
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OFF Board Parity There Is a parity error with memory Installed In an 1..0
(BUS) slot. The message fonnat Is

OFF BOARD PARrrY ERROR ADDR = XXXX

where xxxx is U1e addless (in Hexadedmal) where ttle
em>r has oa:urred. Off Board means ttlat It is part of ttle
memory installed via an adaptor card in an 1..0 (bus)
slot. Run memory ciagnosllc software, such as AMI
Diag, to find and correct memory problems.

ON Board Parity There is a parity error wItt1 memory installed in an 1.0
(bus) slot. The message format Is

ON BOARD PARITY ERROR ADDR = XXXX

Parity Error 111

where XXXX Is the address (in Hexadedmal) where the
error ooourred. On board means that It Is part of the
memcxy attad1ed drecliy m the BIOS. Nn memory
clagnostic software, such as AMI Diag, to find and
oonect memory problems.

n18re Is a parity error witt! the sysmm memory, 00t the
address of the error cannot be detemined. Roo memory
diag1OStic software, such as AMI Diag, to find and
CXJrrect memory probisns.

Stereoscan 440 Faults

The Image Processor

The Image Processor, together with the PC, forms the heart of the entire system.

.

.

It conttols all the other modules, supplying both data and
timing signals
It accepts all the various input signals i.e. SE, BSD, 4QBSD,
CL etc, and processes them for display on the monitor
It provides the display video
It provides all the graphics in the form of annotation and PC

WindowslM

Therefore, if there is a problem with an entire sub-system, for example, no
Electron Optical control at all and vacuum system problems, or no EHT
operation, the possibility is that the Image Processor is at fault.

If there is no video signal of any kind on the monitor. or if the video or display
are corrupted in any way. the Image Processor is suspect.
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The Image Processor has it's own power supply, and this is monitored by LEDs 4,
6 and 8 at the rear of the instrument. Therefore it is important to check their
status and inform the Service Centre when reporting any problem.

6.3.2. The Vacuum System

Most major vacuum problems are communicated to the operator by error
messages internally generated by the instrument. In the event of a vacuum
problem that does not generate an Error message, here are some hints and tips
that may help locate the source of the problem. and either resolve it, or give your
Sevice Centre adequate infonnation with which to rectify it.

Check the vacuum seals that have been broken since the fault appeared, these are
usually the stage door or the gun "0" rings, to ensure that they are clean and free
of any particles of dirt or hair and that they are not in any way damaged.

If an "0" ring is found to be dirty. carefully remove and clean it. When replacing
an "0" ring it is essential to ensure that the inner face where the "0" ring sits is
perfectly clean and free of dirt and hairs and that the seam of the "0" ring itself
does not lie across the sealed surface.

~
~

The use of grease is not recommended. as this can cause contamination of
the column leading to degraded performance. It has been found that the
action of cleaning an "0" ring with fingers applies enough grease to
provide adequate lubrication.

Ensure that any samples that have been put in the chamber are not porous and
that the fiXative used, is not outgassing. If in doubt about the samples, remove
them in order to check that the system vacuum returns to a nonnallevel without
them after about 4 hours pumping.

Check that the cooling fans for the plinth are operating correctly. If the turbo
pump is too hot it will not be able to pump efficiently.

ConflrDl that the temperature and humidity in the room are not unusually high,
this would again adversely affect pumping efficiency.

Check the condition of the silica crystals in the dessicator to ensure that they are
still blue, pink crystals allow too much moist air into the chamber which would
increase the pump down time and also degrade the system vacuum.

Is there a vacuum reading available?

Does the turbo pump sound as if it is operating at full speed. or does a high
pitched whine suggest that it cannot reach full speed?
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6.3.3. Electron Optics

Most Elecb'on Optical (EO) problems will be evident by looking at the image on
the monitor. and are likely to be caused by one of three possibilities:-

A power supply failure
An internal communications problem
An EO failure

A Power Supply Failure

This can be identified by the condition of the Status LED's at the rear of the
instrument. They should be inspected, and a note taken of which LEDs are
illuminated in both the STANDBY and OPERATE modes, and this infonnation
passed to your Service Centre.

An Internal Communications Problem

Will probably cause a series of EO faults, that is a number of functions will not
work.. For example, there may be no SllGMA TOR correction AND no C3 LENS
control, or some other combination, BUT, all the STATUS LED's will be
illuminated. This, again, should be reported to your Service Centre.

An EO Failure

It is probable (though not defmite) that only one EO function will not work. such
as , one lens or that there is no Beam Shift available, or similar. This points to
the likelihood that the EO system has failed, and this should be reported to your
Service Centre.

6.3.4. The EHT System

An EIff set fault is likely to be shown by an En'Or Message generated by the
instrument, however, in the absence of any Error Message, it could well be
possible to identify a problem by the following symptoms:-

No electron beam possible, even though the filament is known to be OK.

No PM (photo-Multiplier) noise (or snow), even with maximum signal

brightness.
2.

Reduced PM noise, even with maximum signal brightness.3.
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4. Unstable beam, or filament current, especially noticeable in the emission
image.

5. EHT tripping out.

Image drifting out of focus.6.

7. Unacceptable change in the insb'Ument calibration.

1,2 and 3 could also be caused by:-

a) a vacuum interlock problem
b) the wrong (or NO) detector being selected
c) the aperture changer being out of position (especially no. 1)

4 and 5 can also be caused by:-

a) a cracked filament base
b) an incorrectly fitted or postitioned filament in the firing unit
c) dirty filament contacts either in the gun or in the EHT set.
d) a dirty firing unit, especially the grid aperture
e) an oldfilament
j) a dirty anode
g) an inadequate vacuum, especially when using high KY.

6 and 7 can also be caused by:-

a) a faulty Electron Optical system

Short Filament Lffe

If short filament life is experienced the following factors should be checked as
they will almost certainly shorten a filament's operational life.

Ensure that the vacuum is good before firing up a filament. Although a filament
can be fired up as soon as "Vac Ready" is achieved. the longer that it is possible
to wait for the vacuum to improve, before using the filament, the better for
filament life (and also signal quality!).

Filament positioning in the firing unit w
or worse, and the following tips may be
performance and fllament life:-
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Tungsten Emitter

Fitting a New Tungsten Filament

When fitting a new filament to a firing unit, insert the filament as described in
Section 2.2.4 Changing the Filament, ensuring the filament is visible in the
centre of the firing unit aperture. Once the filament is central, using the firing
unit tool supplied, screw the adjusting ring in until the filament is level with the
front face of the firing unit aperture. Then bring the filament back as far as is
required for your operating requirements according to the following guide:-

I High ResoIutioo/

~ SigDa!

turn back from front face of ~

I Medium Resolution!

General ~lications

turn bIM:k from from face of apertmc

~..! c". nams back from front fIK:e of aperture
I Low Resolutioo/

Maxinwm F1\8IICIIt Life
- --

Additionally, for maximum beam stability, essential for long EDX/WDX
analysis, as well as setting the filament back 11'4 turns, it is recommended that the
Beam Current be reduced from 4OOuA to about l00-200uA. This will increase,
still further, the life span of the filament.

Running Up a New Tungsten Filament

When nmning up a new Filament (Tungsten or LaB6) it is good practice to select
the New Filamentcheckbox on the Gun Set Up panel (Beam-> Gun Setup).
This will select a nm up routine tailored to the new filament. The field will
automatically be deselected when the run up completes.

It is advisable to run a new Tungsten filament up carefully for the fIrst time, if
possible starting at a relatively low KV (5-10 KV) and letting the filament get
warmed up, before gradually increasing to any working KV significantly above

5-10 KV.

t$.
~

That it may be noticed the filament position may drift having been heated,
and might need to be re-centred after being heated up for the first time.

LaB6 Emitter

The most important things to ensure long filament life with an LaB6 emitter are
basically the same as for Tungsten, but to remember that LaB6 requires far more
care and attention.

Stereoscan 440 Operator Manual



6-10 Chapter 6 Fault Diagnosis! "I

~
Fitting a New LaB, roament

The new emitter should be fitted, accurately, according to Section 2.2.4 Changing
the Filament.

IRunning Up an LaB6 Filament

ALaB6 emitter should also be run up using the instrument's automatic procedure
(selcting Beam On from the gun control box on the toolbar). The procedure is
designed to maximise the filament life. Similarly the Beam Off procedure
should always be used to run the gun down.

~

The only exception to this is when a Kimball LaB6 emitter is installed for the first
time. To ensure that the Kimball emitter is saturated at the correct filament
current (1.8-2.0A) it should be run up slowly using the Manual option and the
Gun Set Up panel. Once the filament has been saturated, the automatic routines
can be used safely. ~

I;i.'The most imrortant factor of all in maximising LaB6 life is to ensure that the
emitter has been fully cooled down before exposing it to air, as otherwise, the
LaB6 crystal is liable to be severely damaged, or even destroyed.

rI
t"lLaB, Beam Current.

The beam current is fixed for LaB6 operation, and not user changeable.

6.4. LEO Error Messages

There are many reasons why error messages may appears. With each message
on-line help is available. In addition an alphabetical list of all error messages is
included below.

~6.4.1. E"or Messages

ACQUIRE COMMAND ERROR IThis error is given when a signal acquisition command fails.

fI
Code numbers greater than 40 indicate the failure of an internal consistency
check. Contact Leica

rn
Code numbers less than 40 indicate that there is a failure in the communication
to the DSP subsystem.
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Please report the problem.

The code number given identifies the failing command as follows:-

I SET_ZONE_KI_CMD
2 SET_ZONE_K2_CMD
3 SET_ZONE_AI.PHA_CMD
4 SEr_ZONE_BETA_CMD
S SEr_ZONE_SUB_CMD
6 SET_ZONE_PORT_CMD
7 SET_ZONE_OFFSET_CMD
8 SET_ZONE_GAIN_CMD
9 SEr_ZONE_INVERT_CMD
A CREA TE_ffiENTITY _LUT
B CREA'rn_GAMMA_LUT
C CREATE_INVERT_LUT
D CREATE_USER_LUT
E COMBINE_USER_LUTS
F ENABLE_WINDOW _PLANE
10 SEr_DETECroR_MlXlNG
11 SET_FAVE_NOISE_REDN
12 SET_LINf_NOISE_REDN
13 SEr_FINT_NOISE_REDN
14 SET_WINDOW_SEL
15 SEr_FREFZE_CMD
16 COPY_USER_LUT
17 SEE_LUT
18 DEFlNE- WINDOW

BRIGHTNESS RLM FAILED TO INInALISE

This is an internal software error which should not occur.

If the fault should occur please contact Leica.

BRIGHTN~ RLM FAILED TO LOAD

This is an internal software error which should not occur.

If the fault should occur please contact Leica.

CANNOT PRINT COLOUR TIFF

This error is given when an attempt is made to print a TIFF file which contains a
real colour image.
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This file contains the configuration data (options etc) for the Right Hand Side of
the SEM (electronics).

When this error occurs a default minimum configuration is assumed.

CONFIG FILE WRITE ERROR

This error is given when a file error is detected on writing the configuration file
CONFIG.LEO.

This file contains the configuration data (options etc) for the Right Hand Side of
the SEM (electronics).

The most likely cause of error is inadequate disk space.

COULD NOT READ DATA FROM NVRAM, READ FROM DATA.VAC

Configuration and calibration infonnation relating to the column is saved in Non
Volatile RAM.

This data could not be read correctly. The standby copy of this data held in file
DATA.VAC has been used.

If the format of NVRAM data has been altered (check release notes) then on first
startup of the system this error will be given.

If this is not the first use after an upgrade please report the problem.

DEFAULT.VAC FILE USED

Configuration and calibration information relating to the column is saved in Non
Volatile RAM.

Due to a problem reading the NVRAM an attempt has been made to use the
standby DATA. V AC file and either the data is corrupt, an incompatible version
or the file could not be found. The file DEF A UL T . V AC has been used which
contains a default set of data. Any calibration data has therefore been lost.

Please report the problem.

EHT COMMS F All..ED TO OPEN/CLOSE

This error is given when there is a failure in the communications to the EHT set.
A Status code is given which will enable details of the fault to be determined.
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F All..ED TO AcrIV A TE:-

ACQ. PROCESS
DSP PROCESS
EDT PROCESS
EO PROCESS
STAGE PROCESS
V AC PROCESS

These are internal software errors which should not occur. If the fault should
occur please contact Leica.

FAILED TO LOAD:-

ACQUIRE RLM
DSP RLM
EDT RLM
EO RLM
IMEX RLM
OVERLAY MANAGER
STAGERLM
VACRLM

These are internal software errors which should not occur. If the fault should
occur please contact Leica.

FAILED TO WRITE DATA. V AC

DATA. V AC is the standby flIe containing the configuration and calibration for
the column.

An attempt has been made to update this file and has failed. This is typically due
to lack of disk space.

Please check free space on disk and discard or archive files as necessary.

FAILED TO WRITE NVRAM

Configuration and calibration infonnation relating to the column is saved in Non
Volatile RAM.

An attempt has been made to update this infonnation which has failed. The
infonnation will have been saved in the standby file DATA. V AC.
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Please report the problem.

F All..ED TO WRITE NVRAM AND DATA. V AC

Configuration and calibration information relating to the column is saved in Non
Volatile RAM.

An attempt has been made to update this information which has failed.

DATA. V AC is the standby file containing the configuration and calibration for
the column.

An attempt has been made to update this file and has failed. This is typically due
to lack of disk space.

IIRRU COMMAND ERROR

This error is given when a command to the HRRU fails.

Code numbers greater than 40 indicate the failure of an internal consistency
check. Contact Leica.

Code numbers less than 40 indicate that there is a failure in the communication
to the DSP subsystem.

Please report the problem.

The code number given identifies the failing command as follows:-

I HRRU_l'Tl-l~
2 TAKE_LEFr_STORED_PHOTO
3 TAKE_RIGHT_STORED _PHOTO
'4 T AKE_LlVE_PHOTO
S GAMMA_OVERLAY _HRRU_LUT
6 GAMMA_HRRU_LUT
7 SET_Fn.M_SPEED
8 SET_LIVE_REPEAT
9 SET_CAMBRA_TYPE
A SET_HRRU_FOCUS
B SET_iIRRU_BRIGInNFSS
C SET_HRRU_CON1RAST
D SA VE_HRRU_CONHG
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IMEX FAILED TO INITIALISE

This is an internal software error which should not occur.

If the fault should occur please. Contact Leica.

INCORRECT WENT CODE

This error occurs when the user interface attempts to access a system parameter
in the Master DLL using an incorrect identification code. Contact Leica.

INV ALm DEFAULT. V AC FILE

Configuration and calibration information relating to the column is saved in Non
Volatile RAM. The ftle containing the initial default data is COf111pt. an
incompatible version or not found.

Please report the problem.

INVALm PARAMETER RECEIVED BY EDT SET

This error is given when the EHT set receives a command with invalid
parameter( s ).

This may be symptomatic of a communications error.

Please report the problem.

INVALID STAGE COMMAND

This error is given when a command is issued to move the stage to an invalid
position (i.e. beyond the limits). This may be due to defining an invalid stage
scan pattern which would result in limit violation.

INV ALID STATE VALVE

This error occurs when the user interface attempts to set a system parameter in
the Master DLL to an incorrect state. Contact Leica.

NO BITMAP IN CLIPBOARD

This failure is given when pasting an image from clipboard.

The clipboard does not contain a bitmap.
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NVRAM DATA INCONSISTENT WI11I CONFIG FILE

Configuration and calibration information relating to the column is saved in Non
Volatile RAM.

The config file contains the configuration data (options etc) for the Right Hand
Side of the SEM (electronics).

This message indicates that an inconsistency has been found. A default
configuration is assumed.

This message should only occur where hardware changes have taken place (e.g.
new board installed).

If necessary please report the problem.

BOTH COPIES OF DATA HAVE THEREFORE BEEN LOST.

Please report the problem.

OPEN CLIPBOARD ERROR

This failure is given when cutting/pasting an image toIfrom clipboard.

PARAMETER OR STATE CURRENTLY DISABLED

This error occurs when an attempt is made to access a parameter or state which
is currently disabled by the operational roles.

PARAMETER RANGE ERROR FROM EHT SET

This error is given when the EHT set receives a command with parameter
value(s) out of valid range.

This may be symptomatic of a communications error.

Please report the problem.

READ TIFF DIRECTORY ERROR

This error is given when reading a TIFF file.

The error occurred when reading the llFF file internal image directory.

The file is corrupted.
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This is typically due to a partially written file. truncated due to inadequate disk

space.

READ nFF HEADER ERROR

This error is given when reading a TIFF file.

The error occurred when reading the TIFF header.

This error may be given if an attempt is made to read a TIFF file (e.g. to
determine it's header information) while the file is being printed.

Alternatively the file may have been corrupted.

This is typically due to a partially written file, truncated due to inadequate disk

space.

READ TIFF IMAGE ERROR

This error is given when reading a TIFF file.

The error occurred when reading a TIFF image structure.

The file is corrupted.

This is typically due to a partially written file, truncated due to inadequate disk

space.

STAGE COMMAND ERROR

This error is given when a stage command fails.

Code numbers greater than 40 indicate the failure of an internal consistency
check/queueing. Contact Leica.

Code numbers less than 40 indicate that there is a failure in the communication
to the stage/vac subsystem.

Please report the problem.

The code number given identifies die failing command as follows:-

1 SET_UP_STAGE_REQ
2 MANUAL_INIT_REQ
3 AUTO_INIT_REQ
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4 WWER_USER_LIM1TS_REQ
5 UPPER_USER_LIM1TS_REQ
6 TIGA_11MER_TICK_REQ
,... SPEED_MOVE_REQ
8 STAGE_POSmON_REQ
9 BACKLASH_REQ
A MOVE_MODE_REQ
B ABORT_REQ
C STAGE_PARAMS_V_START
D STAGE_PARAMS- V_INC
B STAGE_PARAMS_T_STEP
F STAGE_PARAMS_BACKLASH_SPD
10 STAGE_PARAMS_BACKLAS~DST
11 ST AGE_P ARAMS_MAXIMUM_SPD
12 GET_ERROR_STATUS
13 CHECK_STAGE_PSU

STAGE X -15V FAILED

Please report the problem.

swrAGE X +lSV FAILED

Please report the problem.

STAGE Y -15V FAILED

Please report the problem

STAGE Y +lSV FAILED

Please report the problem

STAGE Z -15V FAILED

Please report the problem.

STAGE Z +15V FAILED

Please report the problem.

TIFF ANNOTATION MEMORY LOCK ERROR

This error is given when attempting to lock in memory the image annotation
associated with a worksheet.

Stereoscan 440 Operator Manual



h~""-""';~" .c;"~",-",,~,, "~c~,c.c~,.,~,,""~... Chapter 6 Fault Diagnosis 6-21

This is typically caused by inadequate PC memory (or disk swap file). Close any
other applications or free up space on hard disk. (N.B. swap ftle must be

contiguous space).

TIFF FILE ERROR

This error is given when reading a TIFF ftIe.

Either the file could not be found or error in reading flfSt block.

nFF IMAGE SELECT ERROR

This error is given when an inconsistent image selection is defined (e.g. no image

selected).

UNKNOWN COMMAND RECEIVED BY EDT SET

This error is given when the EHT set receives a command it does not understand.
This may be symptomatic of a communications error.

Please report the problem.

VACUUM BOARD -12V FAll..ED

Please report the problem.

VACUUM BOARD +UV FAILED

Please report the problem.

VACUUM BOARD -SV FAILED

Please report the problem.

VACUUM BOARD +SV FAaED

Please report the problem.

VACUUM COMMAND ERROR

This error is given when a vacuum command fails.
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Code numbers greater than 40 indicate the failure of an internal consistency
check. Contact Leica. Code numbers less than 40 indicate that there is a failure
in the communication to the stage/vac subsystem. Please report the problem.

The code number given identifies the failing command as follows:-

I CONFIGURE_FRONT_PANEL_REQ
2 SYSTEM_PUMPING_REQ
3 CONFIG- VIEWING_WINDOW_REQ

". CONFIG_COLUMN_PUMPING_REQ
S COLUMN_PUMPING_REQ
6 COLUMN_ISOLN_REPL Y_REQ
7 EDX_CONflGURE_REQ
8 WDX_CONFIGURE_REQ
9 Fn..AMENT- ~H_REQ
A EDX- rnRESH_REQ
B SET- 4QBSD_QUADRANT_REQ
C SET- 4QBSD- VISmll.lTY_REQ
D SET- 4QBSD_GAIN_REQ
B SET_SCM_RANGE_REQ
F SCM_READINGS_REQUIRED_REQ
10 V ACUUM_TlMER_ROUTINB_REQ
II WRlTE- V ACUUM_DATA_REQ
12 READ_VACUUM_DATA_REQ
13 OPER- WDX- GA TE- VAL VE_REQ
14 AIRLOC~ CONFIGURE_REQ
15 SET_Tn..TO
16 SET_TOUCH_ALARM_OFF
17 GET - VACUUM_ERRORS
18 GET_COMMS_PSU
19 SPECIMEN CURRENT MONITOR MEASUREMENT

ERROR

The following errors refer to failures in the communications with the Vacuum
subsystem: -

21 Comms timeout
22 COmIns overrun
23 Unknown command
24 Invalid parameter
25 Out of range parameter
26 Command failed
27 Bad reply
28 Put Queue error
29 Get Queue error
2A Wrong parameter
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2B Space error
2C Reply parameter error

VACUUM SYSTEM LEAK

This error is given when the turbo pump takes an excessive time to reach its
maximum speed, which is indicative of a vacuum system leak or poor sample
preparation.

VAC SYm'EM PENNING GAUGE FAILURE

Please report the problem.

WRITE TIFF DIREcroRY ERROR

This error is given when writing a TIFF ftIe.

An error occurred while writing the directory portion of the TIFF file.

This is typically due to inadequate disk capacity. Delete excess files.

WRITE nFF HEADER ERROR

This error is given when writing a TIFF file.

Either the file cannot be created or an error occurred when writing the TIFF
header.

This is typically due to inadequate disk capacity. Delete excess files.

WRITE nFF IMAGE ERROR

This error is given when writing a TIFF file.

An error occurred while writing the image portion of the TIFF file.

This is typically due to inadequate disk capacity. Delete excess files.

6.4.2. Other Errors

In addition to the errors listed above there are two types of error which may (but
should not) occur. The usual explanation of such an error is a failure in the LEO
software.
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WINDOWSTM APPUCA nON ERROR

When a Window~ application error occurs the user is presented with two
options 1GNORE' or 'CWSE'. It is strongly recommended that the application
should be closed. Further to this it is also reco~nded that the system should
be powered off and on again to ensure that it is remmed to a consistent state.

Actor Error

When an Actor error occurs the options available are 'Deoog' or 'OK'. The only
valid selection in this case is OK, but before selecting it please note down the
information contained in the error window. Again a power off reboot should be
perfonned (even if the LEO application appears to continue COI1'ectly).

When either of the above errors are encountered please inform Leica Cambridge
of the circumstances leading to the error together with any information from the
error window.
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Function
HelD
Context Sensitive ~~

Keystrokes
i Fl
I
I Fl + Shift

~Fl+ Shift
F3

r~..:t~~!!~

~rfonns a hysteresis correction for Cl,~-

Toggles the PC Plane On/0ff
Step to next Mag Table entry, or undo centre feature
ma~ chan~e ---
t!..Xlts from mag table modeF4+Shift

FS.F6.F7
F9
Fi! ~~

Executes installed macros
Keys Help (Display this Infonnatic?°)

: Selects the Annotate/Measurement Function and
to es between Move and Edit Modes
To les the Datazone On/0ff

I Sta~e scan step to next field - ---~-~-~
i Fl1 +Sbift
I

Fl2
F12 + Shift
<Tab>
<Orl>
<Home>
<Scroll Lock>
<Pause>
.

A

S~e scan s!t?P to orevious field
To les coarse/fme ad.ustment
Centre point - - ..

Resets Beam shift to zero-T 1 F "1O~~le t'reezeje reeze . ,
- - ~~- - - - - - - -i, "'c!!

Pauses/Resumes execution of the macro c!
I Performs t'md Irna~e~!.
Performs combined auto-stigrnation and fme auto focus
routine
Performs an auto-sti.e;mation routine, A + Shift

E
Use ~Q~vs to control Beam Shift
Performs a fine auto focus routine--

Performs a coarse auto focus routine

~ Further keyboard shortcuts overleaf
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Introduction

As new Window~ applications are being created and updated from week to
week, it is impossible to keep track of each one as it becomes available.
Although a standard is slowly emerging for installing these third party
applications, each application usually still has a unique set-up procedure.

A general set of guidelines however should be considered before installing any
Window~ application on your system.

. Always back-up your system disk before modifying it. The easiest way
is to simply back-up you configuration files only; such as:

\CONFIG.SYS, \AUTOEXEC.BAT,
\ WINDOWS \ * . INI , WINDOWS \ * . GRP. Although this is not a

complete back-up, most of the old system configuration ftles will have
been saved.

Always read the application manual thoroughly before starting any
installation.

.
Always check that your hardware configuration is compatible with this

application.

Always check that you have at least the recommended hard disk space
free for the application - use WindowsTM File Manager.

With Microsoft@ Applications, choose Express Set-up if this option is
available.

. Only choose advanced. or custom installation options if you are
confident that you will be able to answer all the questions the
installation program may ask you. These options usually require a good
knowledge of how DOS, or the specific WindowslM Application works.

Below is a list of applications already installed and tested on Leica Stereoscan
400 Series SEMs. If you are in any doubt as to the coIi1patibility of a third party
application you wish to install, telephone Leica Customer Care Department (44)
223411411 or fax (44) 223 412776.
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Microsoft@ MS-DOS@ 5.0

Microsoft@ Window~ 3.1

Microsoft<8> Word for WindoWSnr 2.0

Microsoft@ Exce~ 4.0

Microsoft@ Visual Basi~ 1.0

Zenographics Super Print 2.2

Micrograrx@ Picture Publisher@ 3.0

Novell@ Netw~ 3.11

Adaptec ASPI SCSI Disk Module 3.0

This list is by no means a commitment of Leica Cambridge to support any of
the above.

It is most strongly recommended that only Leica supplied and distributed
and proprietary branded software is used with this instrument. Leica
will bear no responsibility for software corruptions or viruses caused by
using pirated or suspect copies of any software. Indeed Lelca reserve the
right to take any action they deem necessary. in the event of a virus
rmding its way back to the factory from a corrupted instrument we have
had to visit.

It is also highly recommended that back-ups are made regularly,
especially of important and valuable data such as images.
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Appendix ~

The Stereoscan 440 PC! AT backplane consists of six 16-bit standard AT bus
slots. two of which are used. If the Stereoscan 440 has any factory fitted options.
then some of the free slots may be occupied. for example the WORM drive
interface occupies one slot.

Each card that is installed must not interfere with the cards already installed on
the bus. There are four areas in which a card may interfere with the ex.isting
hardware. memory. I/O. DMA channels and interrupts.

The following sections deal with each of these areas in turn. Space is provided in
each table which may be used to record the settings of installed cards.

Memory

The standard PC memory map for DOS reserves space in the 640kB to 1 MB
range for ROM BIOS code and display memory. The gaps left between the
standard components are available for other options. For example a network card
may have a small amount of SRAM in which to buffer communicated data, this
SRAM would be configured in a spare address in the 640kB to 1MB range.

The following shows the memory map of a standard Stereoscan 440 in the 640kB
to IBM range:-

Address
AO(XX)-BFFfF
COOOO-C7FFF

C8000-C}o-pf'F-

~DFFfF
EOOOO-t!.I'-I-1'1'-

RXX)O-FFfFF

Descri
VGA
VGA BI- -

Leica Hardware

I System BIOS ROM

There are two regions available for use by optional cards, C8000 to CJ:'"J:'"J:'J:' and
EOOOO to EFFFF. Any extra cards fitted should therefore be configured to use a
range in these areas.
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One further complication is that on the Stereoscan 440 it is possible to map PC
DRAM into the C8000 to CFFFF area and load device drivers into this area. thus
saving space in the DOS application area. This will not happen if there is
hardware occupying this range and therefore the EMM386.EXE used to control
access to the area will have been loaded unnecessarily.

va Space

Expansion cards are most likely to include a set of registers with which to conb'ol
the card. These are usually I/O registers occupying space in the I/O map of the
Stereoscan 440 PC (as opposed to the memory map. see above).

The cards fitted must be configured not to clash with the existing registers.
There is however some scope for disabling registers on the PC card in the
Stereoscan 440's when other options are fitted, this is a trade off between items.
For example, if an internal modem card is fitted. then it is usual to configure it at
the address occupied by a serial COM port and to disable the existing serial COM
port.

The following shows the I/O map of a Srereoscan 440:-

Addftas
{XX}-O 1 F

020-03F
O4O-OSF
CWJ-O6F
070-07F
OSO-O9F
OAO-OBF
OCO-ODF
OEO-OEF
OFO-OFF
lOO-IEF
lFO-IFF
200-207

1- Device
I DMA Co~!l~_l
I IntemlDt ~ontroller 1
I Time~
I
K~~board Controller

I Real TID1e Clock
.I DMA ~e Re~rs

Interrupt Co~Uer 2
DMA Controller 2

j R~erved for maths~~sor

I Fixed Disk Coot!"aJJer
I Reserved for Games Port
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~
~

12 bits of VO address are decoded by the PC. whereas the 80 x 86 support.s
the use of 16 bit VO addresses. This means that the PC will respond to
addresses above the 1{)()() boundary.

DAtA Channels

There are 8 DMA channels on a PC. two of which are used by the PC. These are
as foUows:-

Channel
0

I De~-

I floppy ~ Cootroll« - =
2
3
4

L
6
7

- ~

Cascade for DMA ContrT>11~r 1

The free channels 0, I and 3 are available for 8 bit DMA transfers, channels 5,6
and 7 are available for 16 bit transfers.
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Inte~pts

The interrupt controller supports 16 interrupts, which are used as follows:-

The remaining interrupts are available for any plug in cards

Standard Options

The following is a summary of settings used by cards that are supplied with
options fitted by Leica:-

-:;;-~

L-5.~~~=
M_ory [.~: -jll*mptJ:a~ OOX>-BFfP

~PF

SCSI- -

NE'lWORK
LASERPIX
WSTRANm.lNx:
LPr2
SCREENMACHINE
COM3
OOM4
0nIER

280-291" 15
ij
,!
5

n
W
11

20)
278-27F

~
3B8-3EF
2El-2EF
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Appendix D

Reporting software problems, please report to:-

Leica Cambridge Ltd
Clifton Road
Cambridge
CB 1 3QH England
Tel: (44) 223 411411
Fax: (44) 223 412776

Please include software version number. system serial number together with a full description of the
symptoms and circumstances leading to the error.

Service Problems

Please report to your local Service Centre.

Service Manager - SEM
Leica Canada Inc
513 McNicoU Avenue
Willowdale
Ontario M2H 29C
Canada

Service Manager - SEM
Leica Instruments Pty Ltd
4S Epping Road. PO Box 21
North Ryde
New South Wales 2113
Ausb"alia

Service Manager - SEM
Leica Handelsges.M.B.H.
Koppstrasse 116
A-ll60 Vienna
Austria

Service Manager - SEM
Arotec Columbia SA
CRA 15 No 38-23
Apartado 050862
Bogota
Colombia

Service Manager - SEM
Micro Service
01 BP 1344
Abodjan 02
Cote D'ivoire

Zaf Sistemas
Rua Braganca Paulista 132
04727 Sao Paulo S.P.
Brazil
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Service Manager - SEM
Leica A/S
Sydvestvej 102
DK-2600 Glostrop
Denmark

Service Manager- SEM
Jam Ara
flat 6. No 1 2nd Street
Kouye Nasr
Tehran
Iran

Service Manager - SEM
Nilomark OY
Box III, Sinimaentie
FIN-0263 I &poo
Finland

Service Manager - SEM
SM Technology Ltd
7 Links View Close
Stanmore
Middlesex HA7 3AW
United Kingdom IService Manager - SEM

Leica Sari, Div LMG
Departernent SCI
86 Avenue du 18 Juin 1940
F-92563 Rueil-Malmaison Cedex
France

IService Manager - SEM
Saifan Precision Insb'Uments
4R Wallenberg Street
PO Box 13266
Tel Aviv 61130
Israel

EService Manager - SEM
Leica Verbieb GmbH
Lilienthalstrasse 39-45
Postfach 1651
64606 Bensheim
Gennany

Service Manager - SEM

Assing Spa
Via Edoardo Amaldi No14
000 16 Monterotondo
Ro~
ItalyService Manager - SEM

Leica Instruments Ltd
19th Floor North. Cornwall House
Taikoo Trading Estate
28 Tong Chong Street
Quarry Bay
Hong Kong

Service Manager - SEM
Leica KK
Sarugakuho Building
8-8 Sarugakuho, 2-chome
Chiyoda-ku, Tokyo 101
Japan

I
Service Manager - SEM
Branch Office-India
Leica Cambridge Ltd (UK)
401 Vikram Tower
16 Rajendra Place
New Dehli 110008
India

.Service Manager - SEM
Leica Insbuments Ltd
3FL, Dongsung Bldg
52-1 Samsung Dong
Kangam-Gu Seoul
Korea

I
.

.
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Service Manager - SEM
Harry M azal S A
Laguna De Tamiahua 204
Col Anahuao Del Miguel Hidalgo
11320 Mexico DF
Mexico

Service Manager - SEM

Leica Espana SA
Freixa 45
08021 Barcelona
Spain

Service Manager - SEM
Leica AB
Stromogatan 6
S-I6440 Kista
Sweden

Service Manager - SEM
Leica BV
Verrijin Stuartlaan 7
NL- 2288 EK Ri j s wi jk
PO Box 80
NL 2280 AB Rijswijk
Netherlands

Service Manager - SEM
Leica AG
Kanalstrasse 21
8152 Glattbrugg
Switzerland

Service Manager - SEM
Leica Mikroskopi AS
0sU'e Akar Vei 206F
Posdds 48 Veitvet
N-O518 Oslo 5
Norway

Service Manager - SEM
Saintech International Inc
12-2 A, No 57 Section 3
Sec 3, Taipei Ming-Sheng
Taipei
Taiwan ROC

Service Manager - SEM
Makkays Hi-Tech Services
Kulsum Plaza. Jinnah Avenue
Islamabad
Pakistan

Service Manager - SEM
Gulf and World Traders
PO Box 5527
Dubai
U.A.E.

Service Manager - SEM
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1.

Adjustable Reduced Raster

Introduction

This facility which is enabled when the Reduced raster licence is present allows
the user to adjust the size and position of the reduced raster.

Operation

Selection

Adjustable reduced raster is selected in the same manner as the fiXed reduced
raster.

Procedures

When in reduced raster scanning and raster coob'Ol (i.e. RASTER displayed in
the window caption) the shape of the cursor will change according to the element
of the raster which may be dragged (e.g. raster edge. corner or move whole
raster).

~
~

There are scan rate restrictions according to the width of the raster. The
software will reduce the scan speed automatically if this is necessary.

Advanced Annotation

Introduction

The advanced annotation software option provides the following:-

Alternative Fonts. The ability to select a greater range of annotation fonts

Bitmap annotation objects. A Bitmap Object is a bitmap loaded from a file
which may be embedded in an annotation panel or datazone.

Tag Annotation objects. A Tag object is a bibnap for use as a special
marker of areas of interest on the image.
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B-2 Appendix E Options- .

Operation

Selection

Annotation Fonts

When the advanced annotation licence is present Font2 dlrough Font6
may be changed via Top Menu - Edit - Ann Fonts.

Tags and Bitmaps

Select annotation/measurement mode (Special Function key FII or Top
Menu - Edit - Annot/Meas).

Display the Annotation/measurement Popup Menu by pressing the right
mouse button over the image.

The Tag and Bitmap entries are found on the popup menu under
'Ann~on'.

Controls

Annotation Fon~

As Standard the annotation logical fonts FontO through Font6 are the
fonts Leica24. Leical6. Leica29. Arrows2S. Arrows31. Math 16 and
Math24. Font2 through Font6 may be individually substituted with
other nGA fonts via Top Menu.

Bitmap

A Bibnap Object is a bitrnap loaded from a file, which may be any .BMP
fIle such as generated by Paintbrush or SDK Paint.

The use of the b'ansparent colour is determined by the Transparency
attribute.

A Bitmap is a non anchor object and may be embedded into annotation
panels.
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Tag

A Tag object is the same as a Bitrnap object except in the following
respects:-

A Tag is an anchor object and does not embed in panels.

The transparency attribute is initially set

Procedures

When a logical font is changed any annotation will be deleted.

Tags and Bitmaps may be moved and deleted in the same way as any other
annotation objects.

1.3. Advanced Measurement

Introduction

The advanced ~~nt software option provides the following:-

Angular Measure~nt
Radial measurement
Vector Profile

Operation

Selection

Select annotation/measurement mode (Special Function key FII or Top Menu -
Edit - AnnotlMeas).

Display the Annotation/measurement Popup Menu by pressing the right mouse
button over the image.

The ~urement entries are found on the popup menu under 'Measure'
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Controls

Angular Measurement

The angular measurement facility comprises a related pair of
measurement lines, a reference line (identified by the symbol AnR at it's
midpoint) and a measurement line (identified by An at it's midpoint).

Each line has a 'blob' at the end which identifies it's centre of rotation.
Each line may be adjusted in length, angle and position.

IAssociated with the objects is an annotation panel loaded from file
An.ANN containing the measurement parameter which is:

An Angle between the reference line and the associated line

Where n is the instance identifier (i.e. 1 for first object created, 2 for
second). I

Radial Measurement

The radial measurement object is a circle which may be adjusted in
diameter.

Associated with the object is an annotation panel loaded from file
Do.ANN containing the measurement parameter which is:-

IDo Diameter of circle

Where n is the instance identifier (i.e. I for flfSt object created. 2 for
second etc up to the limit pennitted).

The dimensional measurement is derived from the zone magnification
hence in situations where multiple zones are present (e.g. split or quad
modes) the bounding rectangle must lie wholly within a zone. If the
bounding rectangle is moved so that it spans zones the dimensional
value is set to zero and a 'BEEP' given.
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Vector PrortJe

Selecting the vector profile ~urement facility brings up the profile
display and creates a ~urement line (with the identifier 'Prof). This
line may be moved on the stored image and each end positioned
individually.

When the line is dropped the trace on the profile display describes the
grey levels lying under the line. Note that the lefnnost point of the line is
the leftmost position on the proflle display.

The profile display has a pair of cursors which may be IOOved
horizontally. The grey level at each cursor position is displayed on the

profile display.

Associated with the measurement line is an annotation panel loaded
from file PROF.ANN containing the profile width ~urement
parameter which is the distance (along the measurement line) reflected
by the cursor spacing.

As with other ~ment objects if the profile line crosses into
another zone the measurement is invalidated and displayed as zero. A
warning BEEP is given.

Procedures

The nonl1al operational procedures for measurement objects apply to these
~ure~nt objects:-

In Move mode the individual objects may be DX>ved about the image

In Edit mode selecting the object causes the 'handles' for the object to
be displayed. these may be dragged or moved using the 'precision'
technique described in the On-line Help. The object may be deselected
either by selecting escape on the popup menu or. if the popup menu is
displayed. by clicking the right mouse button over the image.
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Angular Measurement

Each measurement object has two handles; one at each end, these may
be moved to redefme the line.

Selecting the measurement parameter An in the annotation panel while
in Edit mode, or selecting the parameter in the status list, will prompt
for a new value. If a new value is entered the reference line remains
fIXed and the other line rotates to the specified angle.

Radial Measurement

Each measurement object has 9 handles; cenb'e, N, S, E, W, NE, NW,
SE, SW.

The centre handle moves the entire object without change in diameter.

The N. S. E. W handles adjust the diameter with the diametrically
opposed point remaining fIXed.

The NE, NW, SE, SW handles adjust the diameter with the centre
remaining fIXed.

Selecting the measurement parameter Dn in the annotation panel while
in Edit mode, or selecting the parameter in the status list. will prompt
for a new value. If a new value is entered the object is altered to the
specified diameter with the centre point remaining fixed.

Vector Prorlle

The measurement line has two handles; one at each end, these may be
moved to redefme the line.

Selecting the Profile Width parameter in the annotation panel while in
Edit mode, or selecting the parameter in the status list, will prompt for a
new value.

The profile cursors will be positioned to reflect the value entered. This is
achieved by first moving the right cursor. The left cursor is moved if
necessary.
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1.4. Derivative

Introduction

This Option allows an image to be enhanced by mixing it with the derivative of
itself. This has the effect of highlighting vertical surface detail and edges within
the image.

Operation

Selection

Derivative is selected from the GammalDiff option of the Image menu. This
brings up the Gamrna/Diff panel from which the derivative mixing can be
controlled.

Controls

The derivative value is adjusted using the slider bar on the Gamma/Diff panel. It
is also possible to enter the exact value by double clicking on the derivative value
on the Gamma/Diff panel.

Dual Magnification1.5.

Introduction

This option allows a zoomed image to be displayed in split screen mode without
having to freeze the image at the base magnification.

Operation

Selection

Dual Magnification can be selected from the Scanning menu or Dual
Magnification icon in the Expert Toolbar.

Controls

When Dual Magnification is selected. the left band image is enclosed by a green
boarder which can be sized in the same way as a normal Window~ panel. The
right hand image displays the area of the specimen enclosed by the box on the left
hand image. Thus the zoom factor is detennined by the size of the box.
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The position of the box can be adjusted in Raster mode by placing the cursor
inside the zoom box and dragging it to a new position. Raster mode is selected by
clicking over the image area with the right mouse button (bringing up the mode
popup menu) and selecting Raster.

Procedures

Dual magnification can be used to highlight a feature of the image while showing
a lower magnification view of the specimen, thus indicating how the feature is
positioned on the specimen.

1.6. Dynamic Stereo

Introduction

The dynamic stereo software licence provides:

Dynamic Stereo Imaging

This facility sets the scanning to generate alternate images as a stereo
pair which are ~rged into the image. The display Look Up Table is set
into stereo mode such that the left image is displayed in Red, the right
image is displayed in Cyan. The image is viewed using stereo glasses.

3 Dimensional Point To Point Measurement

This facility enables true depth measurement to be performed when
viewing the image in stereo mode.
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Operation of Dynamic Stereo imaging

Selection

Select Top Menu - Scanning - Stereo, this will display the Stereo Control Panel.

Stereo (L)- On

rStereo Adjustment

The Stereo Panel

Procedures

Set up

Set the magnification to a higher value than that to be used for stereo
viewing and focus the image.

Select Stereo mode by pressing the Stereo On button.

Set Stereo Tilt and Stereo Merge to zero.

Vary the Stereo Tilt and observe the direction of image separation.

Adjust the Stereo Rotate to give separation in the horizontal direction

Adjust Stereo Tilt to give the required angle (separation) between the
stereo images (N.B. the red image must be on left!).

Adjust the Stereo Merge to bring the images together.

Stereoscan 440 Overator Manual



I
Set the magnification to the required value.

To exit from Stereo mode press the Stereo Off button.

~Exporting Stereo Images

Stereo images may be saved in TIFF files using the 11FF Export.

IIf the file is for subsequent import for viewing as a stereo image it
should be saved as a Palletted Grey image. DO NOT select as seen.

IA Stereo Image may be saved in a TIFF file for colour printing as a
Colour TIFF file.

Operation of 3D Point to Point Measurement

Theory of Measurement I
This facility comprises a line (identified by the symbol 3Dn) with three location
points pI, p2, and p3. The image is focused on each point.

..
-

(a)
(b)
(c)
(d)
(e)

apparent distance
depth of plane
actual distance on plane
slope of plane
true depth of feature

Stereoscan 440 Operator Manual

m

-



Selection

Select annotation/measurement mode (Special Function key Ftt or Top Menu -
Edit - Annot/Meas).

Display the Annotation/measurement Popup Menu by pressing the right mouse
button over the image.

The measurement function is found on the popup menu under 'Measure'

Selecting the measurement will create a measurement object and select the
Magnification and Focus as mouse control parameters.

Because of the interactive nature of this measurement it may only be perfonned
on live images and may only be performed with Optibeam ON.

Controls

This facility comprises a line (identified by the symbol 3Dn) with three location

points

301

p1 p2 p3
The measure~nt object may be moved (dragged) when in move mode or the
individual measurement points (pl,p2,p3) may be adjusted in position.

Associated with the objects is an annotation panel loaded from file 3Dn.ANN
containing the measurement parameters which are:

3Dna : apparent distance
3Dnb : depth of plane
3Dnc : actual distance on plane
3Dnd : slope of plane
3Dne : true depth of feature

Where n is the instance identifier (i.e. 1 for first object created, 2 for second etc
up to the limit pennitted)

The dimensional measurements are derived from the zone magnification hence
in situations where multiple zones are present all points must lie in the same
zone. If a point is moved so that it is in a different zone the parameter values are
set to zero and a 'BEEP' given.
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Positioning the Poin~

In Move mode the measwe~nt object may be dragged about the image

In EdIt mode selecting the object causes the 'handles' for the object to
be displayed (one at each of pI, p2, p3). To indicate which 'handle'
would be selected if the left DX)U5e button is pressed the 'handle' will
change colour when the mouse cursor is in close proximity. These
handles may be dragged or IIX)ved using the 'precision' technique
described in the On-line Help. The object may be deselected either by
selecting escape on the popup ~nu or, if the popup menu is displayed,
by clicking the right mouse button over the image.

Recording Focus Distance for a Point

To select a location marker to record focus distance the measurement
object must be selected in Edit mode and the 'handles' displayed.

When the cursor is over the location mark (becomes coloured RED)
press the Ctrl key on the keyboard. You will see the location malt:er
change from a round shape to a square shape - this indicates that it is
now recording the focus position. Adjust the focus with the mouse (by
holding down the mouse middle key) until the surface point is in focus

As the focus is changed you will observe the parameters being updated-

Procedures

3D Point to Point Sequence

Position the location markers pI, p2, p3 at suitable positions on
the speci~n.

2 Select in turn each location marker and record the focus
distance.

Hint

For a quick 2 point depth measurement (surface is assumed horizontal) use only

pi and p3. Depth is given by 3Dnb, ignore 3dne.
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1.7. Image Maths

Introduction

The Image Maths option enables the contents of the image store to be
manipulated using by a 'Convolution Kernel", addition and subtraction of images,
detection of image levels, area fraction measurement and histogram equalisation.
This option requires the Image Maths Licence.

Convolution Transfonns

The following types of convolution kernels may be used to transform the image:-

.

..

.

.

.

.

.

.

Sharpen 1
Sharpen 2
Horizontal Edge Detection
Vertical Edge Detection
Laplace 1
Laplace 2
Prewitt
Sobel

Average
Gaussian

Image Manipulation

The following types of image manipulation may be used on an image:-

.

.

.

...

Copy Image A to Image B
Copy Image B to Image A
Exchange Image A and Image B
Add Image A to Image B
Subtract Image A from Image B
Subtract Image B from Image A
Find the minimum value of each pixel from Image A and
Image B
Find the maximum value of each pixel from Image A and

ImageB
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Image Detection

The following types of image detection may be used on an image:-

IBlack level Detection
White level Detection
Grey Level Detection
Area fraction

.

Histogram Equalisation

The following types of histogram equalisation may be used on an image:-

Output Display Look up table equalisation
Image Store equalisation

Operation I
Selection

ITop Menu - Image - Image Maths

Controls

IThis panel handles the transformation of the image.

I
rHlstogram Equallsatlon

I
Ilmage Detect- Black I !Image Filter" Sharpen 1 I

!Area Fraction- 0.0 % I

,;:;~:~:=;~;; .J I
.Image store A is the visible image store while image store B is the off screen

image store.
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Appendix E Options E-lS

Excb AB
This function freezes the image store and then exchanges the contents of
the off screen image store with the contents of the image store.

BtoA
This function freezes the image store and then copies to the image store
the contents of the off screen image store.

AtoB
This function copies to the off screen image store the contents of the
image store.

A+B
This function freezes the image store and then adds the contents of the
image store to the contents of the off screen image store and stores the
result in the image store.

If the result is greater than 255 then the result is truncated to 255.

A-B
This function freezes the image store and then subtracts the contents of
the off screen image store from the contents of the image store and
stores the result in the image store.

If the result is less than 0 then the result is truncated to O.

B-A
This function freezes the image store and then subtracts the contents of
the image store from the contents of the off screen image store and
stores the result in the off screen image store.

If the result is less than 0 then the result is truncated to O.

It then transfers the contents of the off screen image store to the contents
of the image store.

Reset LUT
This function will set the output look up table back to a linear transform.

AMinB
This function freezes the image store and then sets each pixel in the
image store to the minimum grey level from the corresponding pixels in
the image store and off screen image store.
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IAMaxB
This function freezes the image store and then sets each pixel in the
image store to the maximum grey level from the corresponding pixels in
the image store and off screen image store.

~

Image FOter
This function defmes which of the convolution kernels is to be swept
across the image store producing a result for each pixel. The result is
then normalised to the range 0.255.

This process can give effects such as High-Pass and Low-Pass filtering.

All the Kernels are a 3 by 3 matrix of signed integers.

~

Sharpen 1
Sharpens the image by combining a Laplace 1 edge detection with the
original image.

ISbarpen2
Sharpens the image by combining a Laplace 2 edge detection with the
original image.

ILaplace 1
Detects edges in the image by performing a Laplace b'ansfOfDl using the
4 neighbouring pixels. Laplace transfOfDlS are second order gradient
functions.

Laplace 1-

Detects edges in the image by performing a Laplace transform using the
8 neighbouring pixels. Laplace transforms are second order gradient
functions.

Bortz Edge
Detects horizontal edges in the image.

Vert Edge
Detects vertical edges in the image.

Prewitt
Perfonns a non-directional edge detection by using a combination of
horizontal and vertical edge detection.
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Sobel
Performs a non-directional edge detection by using a combination of
horizontal and vertical edge detection.

Average
Smoothes the image using a unity kernel.

Gaussian
Smoothes the image using a kernel with weights similar to a Gaussian
(bell) function.

Image Detect
This function defmes threshold criteria.

Black
Any pixel in the image store with a value less than the black threshold
percentage will be coloured red.

White
Any pixel in the image store with a value greater than the white
threshold percentage will be coloured red.

Grey
Any pixel in the image store with a value greater than the black
threshold percentage and with a value less than the white threshold
percentage will be coloured red.

Black Threshold
This slider bar controls how much of the image is detected when the
Image Detect is either Black or Grey.

White Threshold
This slider bar controls how much of the image is detected when the
Image Detect is either White or Grey.

Calc Area Fraction
This button initiates an area fraction calculation based on the detected
area defmed by the Image Detect State and the Black and White Slider
bars.

Area Fraction
The result of a calc area fraction is displayed as a percentage of the
image store.
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Histogram Equalisation
The histogram equalisation uses the contents of the image store to
calculate a look up table to b"anSfonn the image to stretch the contrast of
the image.

LUT
The image transformation is performed using the Output Lookup Tables,
this allows the image to still be live.

STORE
The image transfonnation is perf~ by converting the contents of the
image store so the image store has to be frozen.

1.8. Gamma and Input LUT

Introduction

The Gamma and Input LUT licence provides control of the Input Look Up
Tables.

There is ODe LUT for each zone (e.g. each quadrant in quad screen mode), the
LUT ttansforms the input signal according to the pattern loaded. The pattern may
be transparent (no transformation), a gamma transformation or other pattern as
defmed by the input LUT Window.
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Operation of Gamma Facility

Selection

Select Top Menu -Image - Gamma\Diff, this will display the Gamrna/Diff panel.

Procedures

To select the Gamma transfonn press the Gamma button.

Adjust the gamma parameter using the scroll bar.

To deselect the Gamma transforDl press the Transparent button.

~ If there are multiple zones the anchor symbol should be positioned in the zone

for which the LUT should be controlled. ~

Operation of the Input LUT Window

Selection

Select Top Menu - Edit - Input LUT

Controls

OUT

IN
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Overview

The input LUT is used to perform a translation on the input signal as defined by
the pattern loaded into the LUT.

The pattern may be ttansparent (no ttansfonnation). a gamma ttansfonnation or
a user defmed pattern created in the Input LUT Window.

The LUT pattern is represented by a set of lines connecting points. Each point
has as its co-ordinates the input grey level (X in the range 0.255) and the output
grey level (Y in the range 0.255). The minimum definition is two points at X=O
and X=255. Other points may be added at other X values, only one point may
reside at a specific X value.

The points list may be manipulated using the add, move and delete functions. In
addition patterns of points may be created using the steps or sawtooth functions.
The list of points may be saved or loaded from file. The width of the window
may be changed using the scale function.

Reset
This resets the points list to a transparent function (2 points 0,0 and 255,255).

Add
This function will add a point to the trace at the position of the mouse cursor
when the left mouse button is pressed, the point may be dragged to the desired

position.

Move
This function will select the nearest point on me trace to the mouse cursor when
the left button is pressed. The point may be dragged to the desired position. The
point is constrained to lie between the two adjacent points.

Delete
This function will select the nearest point on the b"ace to the mouse cursor when
the left button is pressed and delete it.

~ A minimum of two points must remain.

Scale
This function connuls the width of the window. either one pixel per grey level
(width 255) or 2 pixels per grey level (width 512).
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Save
This function saves the points list into a file with extension ULU (User defmed
Look Up table). By default the file will be saved in the user directory.

Load
This function loads the points list from a file with extension ULU (User defined
Look Up table). By default the selection will be from the user directory.

Steps
This points function generates a set of points forming steps.

The amplitude, period and offset of the steps may be selected and adjusted using
the scrollbar at the bottom of the window. The points generated may be
individually moved, deleted etc.
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Sawtooth
This points function generates a set of points fonning a sawtooth waveform.

Move
Scale
Save

Add

Step
Load

Del Reset

Sawtooth

Help

The amplitude. period and offset of the waveforDl may be selected and adjusted
using the scrollbar at the bottom of the window. The points generated may be
individually moved. deleted etc.

Procedures

The current mode may be selected from the menu as shown above.

Alternatively clicking the right mouse button over the window will toggle
between functions.

The current function is displayed in the window caption.

Pon Expansion from 4 to 81.9.

Introduction

The port expansion licence increases from 4 to 8 the number of signal sources
(e.g. detectors) that may be simultaneously connected.
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Operation

Selection

When the licence is present the total connection capacity is increased.

After the licence is installed it is necessary to define the configuration. this is
perforD1ed using the Configuration window which is displayed using Top Menu
Tools - Service - configure.

If a supervisor password has been defined it must be entered to gain access to
these facilities:-

Configuration - derme signal sources present

. Select detectors from the configuration menu

. Check the identities of the sources fitted. A detector presence may not be
altered if it is connected (see below)

. Select OK

Configuration - define any auxiliary inputs. Select Aux from the configuration menu. Enter the auxiliary detector characteristics (see below)
. Select OK

Configuration - define connections

. Select connections from the configuration menu

. Using the mouse manipulate the connections to achieve a suitable

configuration (see below). Physically connect cables to agree with configuration
. Exit from Configuration menu

Procedures

Auxiliary Detector Characteristics

This window is used to define the identity. resource requirements and signal
output for auxiliary detectors.

For infonnation the standard detector information is displayed.

Aux infonnation may not be changed if the user password has not been correctly
entered. if the detector is not present or if the detector is connected.

Stereoscan 440 Operator Manual



A group box at the top left of the window displays the detector identities,
selecting one of these with the IIK>use will display the resource requirements,
signal output and detector name which in the appropriate instances may be
altered.

The signal and resource information is used in the connections window
to detennine the suitability of plugging modules. Incorrect data may
result in damage for which Leica Cambridge will not accept
responsibility .

Connections Window

This window defmes the plugging of detectors

The components involved are connectors, detectors and reso~ which may
be selected by the mouse, dragged and dropped onto the receiving component or
a parking area to indicate graphically the plugging of the system.

Connectors

On the right of the window are a set of connectors.

Connector properties are:-

Identity e.g. Connector 1
Label e.g. PL13, the back plate label
Signal e.g. 5OmV, the signal level accepted

Each connector has a slot into which a detector may be plugged.

A configured det«tor may be dropped into an empty slot which has suitable
electrical characteristics. While a detector is selected suitable empty slots are
coloured RED.

A detector may be unplugged from a connector and dropped into the detector
parking area (centre screen).

Detector

The detector parking area is the centre portion of the screen,

U Dused detectors are parked in this area.
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A detector may require some reso~ in order to be configured and will have
empty slots where these may be inserted. If a detector is not fully configured it
cannot be picked up and suitable resources will be identified by a RED border.

If a detector is fully configured it may be picked up and a suitable empty
connector slot will be coloured RED if one exists.

~ The resource requirements of auxiliary detectors must be correctly
specified.

Detector Resources

Detectors may require none, one or two of the following:-. PMl, PM2, PM3 : Photo multiplier supplies from the EHT set. BSDA: Back scattered Detector Amplifier.
. SCMA: Specimen Current Monitor Amplifier.

The parking area for these objects when not in use is the left side of the screen.

A resource when picked up will cause the appropriate potential empty slots in
detectors to be coloured RED.

Resources may not be unplugged from detectors in use (i.e. plugged into
connectors) .

1.10. RS232 Remote Control

Introduction

This option provides remote control of the S400 via an RS232 input port. The
RS232 licence is required for this option. A document specifying the protocol
used is available under a non disclosure agreement.

Operation

Configuration

The communications characteristics of the port to be used should be defined in
WIN.INI

e.g.
[ports]
COMl:=9600,n,8,l,x
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" The communication port used by the Remote Control Application is defmed
in WIN.IN.

e.g.
[REMCON]
Primary = COM2
Secondary = COM4

Procedures

~~- The remote control application is started by double clicking the Remote
Control icon in Program Manager. The LEO software provides access
facilities for Remcon, LEO should therefore be running before starting
REMCON. Make sure Tools->Remote Control is selected.

Scan Rate (Expanded)1.11.

Introduction

This option allows a larger range of scan rates to be selected. ie pixel average
values from 1 to 32k (in powers of 2).

Operation

Selection

The additional scan rates can be selected in the usual ways, ie:-

The scan plus and scan minus icons
The + and - keys on the keyboard
Via the Scan->Speecis pull down menu

2.
3.

Procedures

Expanded scan speeds are used in exactly the same way as the standard set of
scan rates.
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Signal Mixing1.12.

Introduction

This option provides the ability to mix the live signals from two detectors.

The signals are referred to as Signal A (the normal signal) and Signal B (the mix

signal).

Each of signal A and Signal B may be chosen from any of the connected
detectors.

The mix proportions may be adjusted.

Operation

Configuration

If a Supervisor password has been defmed it must be entered to perform the

following actions.

Select the configuration window using Top Menu - Tools - Service - Configure.

Select Options from the Configure menu.

Select the Mixer state to Present.

Exit from the Configuration Window.

~ The functions below will only operate if the Mixer State is present and the
signal mixing licence is installed.
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I
Selection

The signal mixing panel is displayed using Top Menu - Image - Signal Mixing.

~

Ii ;

E

I
IControls

Signal A
To alter the signal source for Signal A click on the defmition and select from the
list displayed.

Signal B
To alter the signal source for Signal A click on the definition and select from the
list displayed.

Scan +
This increases the scanning speed by changing the pixel average dwell time.

Scan.
This decreases the scanning speed by changing the pixel average dwell time.

I
Mixing
The mixing controls allow the relative proportions of signal A and B to be
determined. If the Signal parameter is adjusted. then the Mix Signal parameter
will be changed so that the sum of the two parameters is always I (and vice
versa). .

.
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1.13. Stage Centre Feature

Introduction

This function allows the user to draw a box around an object in the field of view.
bring it to the centre and increase the magnification such that the object fills the
field of view.

The function is provided as part of the 'Centre Feature and Stage Map' software
option.

A prerequisite is a motorised stage.

Operation

Selection

The function may be selected as follows:-. From the Top Menu - Stage/Vac - Feature
. From the Stage Move popup menu (press the right mouse

button over the stage move window)
. Via the Centre Feature Macro function
. Via the Centre Feature Icon Function

Controls

There is a LINK facility (use Top Menu - tools -links) provided which enables

the user to inhibit the use of beam shift for this function below a specified

magnification.

Procedures

When this function is performed the initial magnification is saved, and may be
restored by pressing special function key F4. Note that subsequent presses of F4
perform Mag Table functions (until another centre feature function is performed).

When the function is selected other windows will be temporarily hidden and
messages in the image window caption area will guide you through the
procedure.
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Select one comer of the area required

Over the image click on one comer of the area of interest. Once this point is
selected there is no need to hold the mouse button down. A rectangle will be
drawn representing the area. If required you may cancel this function with the
right mouse button.

Select the opposite comer of the area required

Over the image click on the opposite comer to complete the selection of the area
of interest. Alternatively click the right mouse button to reselect the top left
comer.

The software will attempt to use the beamshift to move the area to the centre of
the screen. If the movement required is outside the range of the beamshift then a
stage move~nt will be used. with the positioning such that following the move
the beamshift will be zero.

The magnification will then be increased such that the defmed area fills the field
of view.

F4 will rewm the magnification to its previous value.

1.14. Stage Centre Point

Introduction

This function allows the user to point to an object in the field of view and bring it
to the centre. The function is provided as part of the standard software but
requires the stage motorisation option.

Operation

The function may be selected as follows:-. From the Top Menu - Stage/Vac - Centre Point
. From the Stage Move popup ~nu (press the right mouse

button over the stage IIK>ve window)
. Via the Centre Point Macro function. Via the Cenb'e Point Icon Function
. By pressing Chi Tab on the keyOOard
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There is a LINK facility (use Top Menu - tools - links) provided which enables
the user to inhibit the use of beam shift for this function below a specified
magnification.

Procedures

-+~...
,,!~1;i

When the function is selected the cursor will change to a foor arrow symbol
(see margin) and the caption of the image window will indicate that the
user is expected to select a point with the left mouse button or cancel the
function by pressing the right mouse button over the image window.

The software will attempt to use the beamshift to move the point to the cenb"e of
the screen. If the movement required is outside the range of the beamshift then a
stage movement will be used. with the positioning such that following the move
the beamshift will be zero.

1.15. Stage Control

Introduction

This facility provides the software control for a motorised stage. The
functionality is provided as part of the standard software but requires the stage
motorisation hardware option.

Operation

Configuration

The stage type and the axes that are motorised must be defined in the
configuration window options list.

The Configuration window is displayed by selecting Top Menu - Tools - Service

Configure.

Limits and Touch Alarm

On each axis there are 7 states:-

None

Low Outer Limit
Low Inner Limit

Low User Limit
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High User Limit
High Inner Limit
High outer Limit

.

.

.
The current limit state may be displayed in the Slams window by selecting the
parameters X limit hit. Y Limit hit and Z limit hit.

A user limit is a software limit. They may be selected in the status window (Stage
High X, Stage Low X, Stage High Y, Stage Low Y, Stage High Z and Stage Low
Z). To change a user limit click on the required limit and enter the value. Note
the limits may be set by a macro.

If a user limit is hit a warning is given and the stage slowed to a halt. Position is
not lost.

If an Inner limit is hit the motor is slowed to a halt and the axis may only be
moved away from the limit.

If an outer limit is bit the motors are stopped and may only be moved manually.
Position is lost.

If the touch alarm is detected a buzzer is sounded, an error is given, position is
lost and the motors must be moved manually until the buzzer is silent.

Controls

Stage Initialisation

The Stage lnitialisation panel is used to define the actual position and is
displayed by Top Menu - StageNac - Stage lnit. On initial installation, or if an
axis outer limit limit has been hit, or if the touch alarm has occurred the stage
position is unknown. The Stage lnitialisation panel is used to define the actual
position and is displayed by Top Menu - StageNac - Stage lnit.
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There are two methods of defining the stage position:-

Manual inftlalisation Click on Stage:Set X and enter the actual position by
reading the micrometer position (note that a line is drawn on the micrometer
showing the position of the decimal point).

Repeat for Y and Z axes. Then press Stage:Set Position.

Auto lnitialisation Click on Stage !nit, the stage will move until the inner limits
are found. this will determine the origin.

Stage Move Window

The Stage Move window is used to display the current stage position and to
provide a control interface.

The Stage Move Window may be displayed by:-

Top Menu - Stage/V ac - Stage move

The Icon Function 'Stage Move'

The Macro function 'Stage Move'
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The stage Move window comprises a square area which represents the XY c0-
ordinate space of the stage together with a scroll bar on the right hand side which
is used for stage Z control.

The stage may be in either Joystick or Goto mode. The caption indicates tile
CUn'ent mode. Initially the stage is in Joystick mode, Goto mode is only possible
when the stage has been initialised. These functions allow the stage to be moved
using the mouse.

Popup Menu

The stage window mode and additional functions are provided by a popup ~nu.
This menu is displayed by pressing the right mouse button over the Stage Move
Window .

Joystick Mode

-When in joystick mode the mouse may be used in the stage window as a joystick.
The current position of the stage is indicated by a RED dot. A BLUE dot
indicates the joystick position. The Joystick dot may be dragged away from the
centre causing the stage to move in the required direction. The further from the
centre the faster the stage speed. The speed is also adjusted according to
magnification. Releasing the mouse button causes the joystick marker to return to
the cenb'e and the stage to stop.
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In joystick mode the stage Z scrollbar thumb button is centrally positioned and
may be dragged up or down to move the Z ttavel. Again the further from the
centre the faster the movement, and movement is stopped when the button is
released. The scroll bar increment and decrement functions give a single shot
magnification related movement.

Joystick mode may be used before the stage is initialised (i.e. when it's true
position is entered) and in this case the position indication may be erroneous.

Goto Mode

The stage may only be selected to GOTO mode when it has been initialised (i.e.
when it's true position has been defined). In this nK)(Je the window represents the
XY co-ordinate space of the stage and it's current position is indicated by a RED
dot The mouse may be used to select a point within this space to defme the
absolute stage position required. A BLUE dot is used to indicate the required
position. When the required position is requested the stage will move to it. If a
stage request is made while the stage is already in motion then the current motion
will be aborted.

The stage Z scroll bar in GOTO mode indicates die cun-ent Z position by the
thumb button, this may be dragged to a desired ABSOLUTE position or the
coarse/fine scroll bar functions used to adjust the position of Z.

Backlash

Two functions are provided on the popup ~nu. a backlash state which toggles
on/off to indicate that backlash correction should be perfonned when in Goto
mode. and an Execute Backlash command which initiates a backlash correction
manoeuvre.

Off

This function on the popup menu closes both the Popup menu and the Stage
Window.

Quit

This function on the Popup Menu closes the POpip Menu
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Keyboard Control

The cursor (arrow) keys may be used to coDttol the stage as follows:-

Use of ARROW keys for Stage XY control

If S is pressed the ARROW keys are temporarily assigned to conb'ol the stage XY
position. While an ARROW key is held down the stage moves in the
appropriate direction. Steps may be coarse or fme as defined by the toolbar icon
or using the tab key.

If Esc is pressed while the stage is moving the movement is aborted.

~
. To Return to default use of the ARROW keys press I.

Use of ARROW keys for field stepping

If sbJft S is pressed the ARROW keys are temporarily assigned to perfonn field
stepping.

While in this mode pressing an ARROW key will step the image by an exact field
size in the appropriate direction. In SPLIT and QUAD modes the step size is
correspondingly sized. The movement is achieved by a combination of stage
movement and beamshift as used in the centte pointfunction.

To Return to default use of the ARROW keys press I.

Use of ARROW keys for Stage Z control

If Z is pressed the ARROW keys are temporarily assigned to control the stage Z
position.

While an up/down ARROW key is held down the stage moves in the appropriate
direction.

Steps may be coarse or fine as defmed by the toolbar icon or using the tab key.

If Esc is pressed while the stage is moving the movement is aborted

To Return to default use of the ARROW keys press L
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1.16. Stage Co-ordinate Store and Recall

Introduction

This option allows a list of stage positions together with magnification, focus and
beamshift to be saved so that the user may easily return to the positions.
Optionally the position may be given a symbolic name. Lists of positions may be
saved to or loaded from ftIe.

A prerequisite is a motorised stage.

Operation

Selection

The position recording functions are provided on the popup menu associated with
the Stage Move window. To display the Stage Move window select Top Menu
Stage/V ac - Stage Move. Pressing the right mouse button over the Stage Move
window will display the popup menu. The menu item Record provides the c0-
ordinate store and recall functions

~
~

17Ie stage must be initialisedfor the functions to be operational (i.e. the
correct position of the stage must be known).

Controls

The submenu provides the following functions:.

Mark
labels..
Plot
Hide

Load.

Working Distance
Uag
Beam Position
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In addition Macro functions are provided for Mark. Position, Goto First mark. and
Goto Next mark.

Procedures

The list of points is held in ~lrK)ry and on LEO start up it is initially empty

Clear
This function clears the points list. Confirmation is requested,

Mark
This function saves the CUITent stage position, working distance (focus),
magnification and beam shift position in the points list without a label. This
function is available as a Macro function.

Labels
This function displays the STAGE LABEL dialog box which is used to save the
current stage position, work.ing distance (focus), magnification and beam shift
position in the points list with a user defined label. It is also used to go directly to
labelled positions. For more detail see below.

Plot
This function displays a black dot on the stage window for each position stored in
the points list.

Hide
This function removes from the stage window the position markers displayed by
plot.

Fint
This function moves the stage to the first position stored in the list. The function
is greyed if the list is empty. This function is also available as a Macro function.

Next
This function moves the stage to the next sequential (chronological) position in
the list. The function is greyed out if the stage is not at the fIrSt position or is at
the last position in the list.

Save
This function saves the points list in a file with the extension XYZ. The file will
be saved in the user directory by default. Confirmation is requested if the file
already exists. See below for file format.
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Load
This function loads the points list from a file with extension XYZ. The previous
contents of the list will be overwritten.

Working Distance
The current working distance (focus) is saved whenever an entry is made into the
points list. If this function is selected then whenever the stage is moved to a
saved position the working distance is set to the stored value.

Magniftcation
The current base magnification is saved whenever an entry is made into the
points list. If this function is selected then whenever the stage is moved to a saved
position the magnification is set to the stored value.

Beam Position
The current beam shift distance (Beam offset) is saved whenever an entry is made
into the points list. If this function is selected then whenever the stage is moved
to a saved position the beam offset is added to the stage position (within the step
size limitations of the appropriate stage) and the beam shift set to the sub step

component.

~ The points list is not destroyed by closing the Stage Move or Stage Map
Windows. Confirmalion is requested on Shutdown of LEO if a points lists
exists which has not been saved.

Hint

Create macros for special function keys to call each of the Mark. FlfSt and Next
functions (e.g. F7 for mark). When roaming the specimen pressing F7 will then
record the position for you to revisit later.

Stage Labels DiaJog Box

The dialog box displays the cunently stored labels in a list box (in alphanu~ric
order). Below the list box is a text entry window, characters typed here will be
matched to the entries in the list box and the nearest match highlighted.
Selecting a list box entry will cause the stage to move to the stored position.
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Grainl
Grain2

actionedl

I

To indicate if the stage is currently positioned at the highlighted entry the legend
"actioned!" will be displayed when this is the case.

Stage Label : ADD
This function brings up a data entry dialog box into which the user may type any
string of text to identify the current stage position. OK will enter the position and
label into the list. CANCEL will remove the data entry box without action.

Stage Label :DEL
This function deletes the currently highlighted list box entry from the list.

Stage Label : UNDO
This function causes the stage to move to the position which was current when
the dialog box was requested.

Stage Label: OK
This function removes the stage label dialog box, all list entries are preserved.

FOe ForDlat
The fonnat of the XYZ file is as follows:

Fixed identifier
FIXed identifier
Fixed identifier
File details

XYZ
Stage XYZ
Stage Position
c: \u ser\defau It\three.XYZ
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3
Refere~
4.0 13e-OO2
2.956e-OO2
5.07e-OO3
0
0
0
16.55287743
2.643531375e-002
0
0

3.687e-OO2
3.163e-OO2
5.07e-OO3
0
0
0
16.55287743
2.643531375e-OO2
0
0

73.968e-OO2
3.281e-002
5.07e-OO3
0
0
0
16.55287743
2.643531375e-002
0
0

Number of points
Label for first point
X (meters)
Y (meters)
Z (meters)
Reserved
Reserved
Reserved
Magnification
Working Distance (Meters)
Beam shift X (Meters)
Beam Shift Y (Meters).
Second point - no label
X
Y
Z
Reserved
Reserved
Reserved
Mag
WD
Beam shift X
Beam Shift Y
Third point - no label
X
Y
Z
Reserved
Reserved
Reserved
Magnification
Working Distance (Meters)
Reserved
Reserved

1.17. Stage Map

Introduction

The Stage Map function enables a low magnification frozen image in Zone 0 (i.e.
the left half in split screen mode or the top left quadrant in quad screen mode) to
be used as a map for selecting stage positions.

Stereoscan 440 Operator Manual



The function is provided as part of the 'Centre Feature and Stage Map' software
option. A prerequisite is a motorised stage.

Operation

Selection

Stage Map is only operational if the stage is initialised.

Stage map may be selected by:-

Top Menu - Stage/V ac - Stage Map

Macro Function Stage Map
Icon Function Stage Map

.

.

Controls

To use this function:-

.

.

.

.

Select a mode (SPLIT or QUAD)
Adjust the stage position at a low magnification such that the
required area of the specimen is wholly displayed
Select Stage Map
This will cause the zone to be frozen and the current stage
position and magnification to be saved for the map
The stage map function requires accurate positioning of the
stage, hence a warning will be given if the backlash correction
is not enabled

Procedures

-.J;-
f

While over the map the cursor will be a four arrow symbol (see margin) but
normal elsewhere.

The magnification may now be increased and the other live zone(s) used to
observe features of interest. The mouse may be used to select a point on the 'map'
and the stage (and hence live image) moved to the required position.

To display the popup menu press the right mouse button over the map.

The Record functions (available if Stage
present) may be used to save and recall
used by the Stage Move Window.
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The map may be removed using Close map from the popup menu or by selecting
Normal mode scanning.

~
~

Any positions recorded are preserved and may be saved/used by the Stage
Move Window Record junctions.

Alternatively Remap from the popup menu will save a new stage position and
magnification for the map.

Hint

If on requesting stage map the stage backlash correction is off and you require
accurate positioning:-

Unfreeze the image (press scroll lock on the keyboard).

2. Select backlash correction to be on (V) from the popup menu.

'3. Select execute backlash from the popup menu.

4. Select Remap from the popup menu.

1.18. Stage Scan

Introduction

The Stage scan software option provides the facility of using the motorised stage
to inspect an area of the specimen as a series of fields.

There is a choice of four types of scan pattern, and several methods of defming
scan areas.

Once the scan pattern is defined commands may be used to step through the
fields.

The stage window also provides buttons which give access to the label and centre
point functions (if licensed).
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Operation I
Selection

~Operation of this facility is only enabled when the stage has been initialised.

The Stage Scan Window is displayed by selecting Top Menu - Stage/Vac - Stage
Scan.

I
I
I

Controls

Stage Scan Patterns
There are four different field patterns, for this example assume there are 9 fields
numbered 1 through 9.

I
.
.Stage Scan Start Position

These are the X, Y and Z positions at which the stage scan will start.

.The stage will move to this position on execution of the Start scan command.

The values may be defined manually (select the parameter with the mouse), by
the select area button or by the start here button. m

.
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Field Size
The X and Y field size parameters define the distance the stage will step between
fields.

The values may be defmed manually. or will be entered by the calculation
function.

Fields
The X and Y fields parameters define the number of fields the stage will step in
the appropriate direction for the scan pattern.

The values may be defmed manually. or will be entered by the calculation
function.

Stage Scan End position
This is the X Y position which will be used in the calculation function and
defmes the position at which the stage scan will end.

The values may be defined manually, by the select area button or by the End

here button.

At Field
The X and Y At Field parameters define at which field the stage is cunently
positioned. These parameters may be used as annotation so that the conect field
identity may be identified in video prints.

Field Overlap
This parameter may be set manually and is used in the calculation function to
detennine the amount of overlap between fields. A field overlap of 0% will result
in a set of fields which butt together.

Field 2overlap Field 1

D

c+50%

D
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Stage Scan Invalid
This indicates if the current stage scan pattern is invalid or not.

The scan will be invalid if the combination of scan parameters would take the
stage beyond the user defined stage limits (in X, Y or Z).

Stage Scanning
This parameter indicates the current state of stage scanning:-
Idle Stage scan has not been started
At Field Stage is positioned at a field in the scan pattern
Moving The stage is in motion as a result of a Next field Command
At End The scan pattern has been completed

Stage XY +Z
This state is used when tilt compensation is operative.
If the checkbox is empty then no Z movement is made.
If the checkbox is marked then movement in Z is made relative to the startZ
when movement is made in the tilt direction.

Backlash
If this box is checked backlash correction will be perfonned on each stage step.

Start Here
Executing this command will set the start co-ords to the current stage position.

End Here
Executing this command will set the End co-ords to the current stage position.

Calc Fields
This function performs the following calculation.
The field of view is determined from the current magnification (i.e. the physical
dimensions on the specimen of the image in nonnal mode).
The field of view is used with the field overlap to determine the field size.
Using the Start co-ord. the End Co-ord and the field size the number of fields
is determined.

Select scan area
This function is used to set the Start co-ord and End Co-ord when the whole of
the area to be scanned is visible at a suitable low magnification.
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It is used as follows:-

1 Press the select area button.
Messages will be displayed in the image caption area to guide you.

2 Select one comer of the area to be scanned
Over the image click on one comer of the area to be scanned. Once this
point is selected there is no need to hold the mouse button down. A
rectangle will be drawn representing the scan aJea. If required you may
cancel this function with the right mouse button.

3 Select the opposite comer or the area to be scanned
Over the image click on the opposite corner.

Stage Scan : Commands
There are three commands provided:-

Start scan
This moves the stage to the start position and sets the scan status to at
field.

2. Next step ( Button labelled -»
This moves to the next field in the scan pattern. If the current field is the
last field in the pattern the stage is not moved but the scan status is set to
end scan .

3. Previo~ step ( Button labelled <-)
This moves to the previous field in the scan pattern. If the current field
is the first field in the pattern the stage is not moved but the scan status
is set to end 1c:aD.

~ The special function key F 12 performs a Nut step function and shift F 12
performs a Previous Step function.

Procedures

Methods of derIDing the stage scan area

1

2.

Manually enter the start co-ords and end co-ords and then use calc
fields.

Manually enter the start co-ords . field size and number of fields.
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3.

4.

Position the stage at the location where the scan is to start (using the
stage move window or centre point then press start here. Then
position the stage at the location where the scan is to end and press end
here.

Where the whole area to be scanned can be viewed at a suitable low
magnification use select area.

The stage position represents the position of the centre of the image.

Hints

Stage macro functions

Examples of macros including stage functions are given below. associating them
with special function keys provides some useful functionality.

MacroFB
Comment: l-Apr-1993 8:49 Stage scan macro
If Stage Scan Invalid=No then
Stage start scan
While Not Stage scanning=end scan
Delay[5]:
Stage Next Field
End While
Else
Message:Scan is invalid
End If

If this macro is executing the paIlse key will cause the macro to be
temporarily suspended. Pressing pause again will resume the macro. This is
particularly useful with the window and overlay planes turned off, providing a
'survey' function.

Macros using the stage position recording functions.

Macro FS
Comment: l-Apr-I993 12:12
Func:Stage:Mark Position

This macro executes the mark point so that the location of fields of interest may
be recorded for future inspection.
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Macro Shift. F6
Comment: l-Apr-I993 12:13
Func:Stage:Goto First mark

This function moves the stage to the ftrst ~ position

Macro F6
Comment: l-Apr-I993 12:14
Func:Stage:Goto Next mark

This function steps to the next recorded position.

Static Stereo1.19.

Introduction

The Static Stereo option enables the user to eidler combine two stored images or
one stored image and one live image to fonn a stereo image in the image store.
This option requires the Static Stereo Licence.

Operation

Selection

Select Top Menu - Scanning - Static Stereo, this will display the Static/Semi Dyn
Stereo panel. This panel handles the production of static and semi dynamic
stereo images.
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Freeze
This function will freeze the image store.

Unfreeze
This function will unfreeze the image store.

AtoB
This function copies to the off screen image store the contents of the image store.

Exch. A B
This function freezes the image store and then exchanges the contents of the off
screen image store with the contents of the image store.

Semi Dyn. Stereo
This radio button will freeze the right hand part of a stereo image in the image
store, keeping the left hand part of the stereo image in the image store live.

Static Stereo
This radio button will combine the left hand image of a stereo pair of images
from the off screen image store with the right hand image of a stereo pair of
images from the image store.

Procedures

Semi Dyn. Stereo
Set the sample to one IK>Sition, press the Semi Dyn. Stereo radio button, this will
freeze the blue portion of the Semi Dynamic Stereo image, leaving the red
portion live.

Tilt the sample to produce a stereo effect

Static Stereo
The left hand image of a static stereo image can be loaded into the image store.

This can be copied to the off screen area using the A to B button

The right hand image of a static stereo image can be loaded into the image store

Press the Static Stereo radio button to combine the two images
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Tilt Compensation1.20.

Introduction

This option allows the image to be conected for the foreshortening effect of
scanning a tilted specimen. At high tilt angles the beam scans more of the
specimen in the tilted direction giving the image a squashed appearance. By
resizing the scans in the tilt direction this effect can be eliminated.

Frame
Distance

~"' "c' " The important angle is the angle of the specimen surface to the horizontal,
which may be different to the stage tilt angle (if the specimen is not flat).

Operation

Selection

Tilt compensation is selected from the Rotate I Tilt option on the Scanning
menu. Tilt compensation is enabled by selecting the check box.

Controls

The compensation angle is adjusted using the slider bar on the Rotate I Tilt
panel. It is also possible to enter the exact value by double clicking on the tilt
compensation value on the Rotate I Tilt panel.

Procedures

Tilt compensation should be selected when viewing samples at high angles of tilt.
The angle of compensation should be adjusted until the nonnal aspect ratio of the
specimen is restored.
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1.21 Trackerbal/

Introduction

This option comprises a 3-button trackerball which pemlits the user to control a
user definable selection of parameters. This option may be used in addition to
any of the other methods of parameter control. This option requires the Beta Site
Licence to be present.

Installation

.

The Trackerball may be plugged into any available serial port (COMI

through COM4)
Display the configuration window (Tools->Service->Configure) and select
the Options menu item

Select the Trackerball item and set the stat to the appropriate COMo.

Exit from the Configuration window.

The Trackerball Icon will appear and stay 'On Top'

Operation

The Trackerball Icon displays the identity of the parameter currently being
controlled. Repeated pressing of the same button will cycle through the
parameters in that button's list. When a different button is pressed the parameter
selected is the last one that was in use for that button.
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Hint

A useful set of parameters are:-

1.22. Window Mode

Introduction

This facility allows the user in Normal scanning mode to defme 'windows' within
the image to show an alternative signal.

Zones

In Normal mode the whole of the image are is defined as being Zone O.
In Split screen mode the left half is Zone 0 and the right half is Zone 1.
In Quad screen mode the quadrants are Zone 0 through Zone 3 for the
top left, top right, bottom left and bottom right respectively.
In Window mode the alternative signal is Zone 2.

Each zone may have it's own signal source (detector or mixed signal),
noise reduction coefficients, etc.

Operation

Selection

Top Menu - Scanning - Window mode.

Stereoscan 440 Operator Manual



Controls

Display the pop up control menu by clicking the right mouse button over the
image while in adjustment, raster or windowing control mode.

The windowing controls are available under windowing.

Windowing SizeJPosition

In this mode the mouse is used to manipulate the size and position of the
windowing elements. The cursor shape changes to indicate which
component (side, comer, whole raster) may be dragged.

When an item is dropped such that it overlays another item the last one
dropped overwrites the overlapped area.

Windowing New item

When this function is selected a new windowing element is created of
default size and position. On creation it will be defmed as Zone 2.

Windowing: Invert

This function selects a sub mode (indicated by the caption) in which any
windowing element's zone state is inverted. (i.e. if Zone 2 then switch
to Zone O. if Zone 0 then switch to Zone 2).

The zone state of the background may be inverted.

This sub mode may be cancelled by selecting another control mode.
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Windowing Reset

This function resets the list of Window elemenu to be the background
(as Zone 0) and a single rectangular window (as Zone 2). The Control
mode is selected to be position/size.

Procedures

Windowing Elements

When windowing is initially switched on, or if Reset is given, the
windowing list is reset such that the whole image area is zone 0 and
there is a single Zone 2 element of default size and position.

Each windowing element may be zone 0 (normal - green border) or
zone 2 (alternative - blue border).

Windowing elements may be superimposed one upon another.

To detennine which zone, or to select control for a zone, the anchor icon
may be positioned as required.

" reference point

1.23. X-Ray Dot Mapping

Introduction

This option provides the ability to display multiple presence dot maps or an
intensity dot map for EDX and WDX data.

When in Xray mode the image store is partitioned into two overlaid planes; one
for Xray data. one for grey Image data. The dot maps may therefore be displayed
grey backed if required.
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Operation

Configuration

XRay Interface Kit

The rear panel provides connection for a multiple dot map EDX cable
(130), a single dot map EDX cable (2201) and a single WDX dot map
cable (2202).

Internal to the electronics pod are two switches which are set on
installation by the service engineer.

. Siogie/Multiple EDX

.WDX/EDX
Defines if single or multiple cable is in use
Defines if the WDX input is used

Software

Top Menu - Tools - Service - Configure to display the configuration window
Select Options
Set the EDX Dots to None/Singie/Multiple as required
Set the WDX to Absent/Present as required
Select XRayNames
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This function enables the annotation of the Xray inputs to be related to the energy
window names used on the Xray system. these identifiers appear on the left side
of the Xray set up window. The dialog box shows the cable and connector pin
numbers of the signals. For ease of use two sets of identifiers are selectable, eXL
and ISIS. Other identifiers may be entered individually if required.

~ If the identifiers are changed the menu option default should be selected on
the next use of the Xray Set up window to utilise the changed identifiers.

Selection

The Xray set up panel is displayed using Top Menu - Detectors - Xray.

Save Load Start aear Default Help

EBU1 ~=~
EBU2 ~~=~
EBU3 ~=:=I
EBU4 ~=~
E B us ~~::J
EBU6 ~~=J

WDX ~~

[Orange.

'-Magenta.
1<>Ian .
IveUow 1:8

IBkJe .
IGreen .
IRed . 'c.BrAiil.. ., '" .-'. ~ ~c, C

'. "'

'Fe II

0 Grey Backed

@ Intensity

0 Presence

0 Unescan

Controls

This window provides set up and control for X Ray dot map input and adapts
itself according to the configuration (i.e. if WDX is present, if EDX is present,
and if so if single or multiple dot map signals are available). The example above
is for WDX plus multiple EDX dot maps.
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X Ray dot map inputs are connected to X Ray ports. At installation these ports
are given identifiers consistent with the XRay system in use, these identifiers
appear on the left of the window.

Each jX)rt supplies the count pulses for a selected energy window. These pulses
are accumulated on a pixel basis and used as source information for the Dot Map
function.

X Ray Data Identlfters
For convenience the text description of the port data (energy window) may be
entered by the user. These descriptions are in the column immediately to the right
of the input port identity. Just click the cursor in the edit box and the text may be
edited in the nonna] way (e.g. enter the chemical symbol). This new description
will be actioned when the DX)U5e is clicked anywhere else in the Xray window.

Dot Map Colour
Each of the Xray Ports data may be displayed in one of a number of colours. The
colour is shown in the Combo Box in the third column from the left. The colour
may be changed by clicking on the box and selecting the preferred colour.

Note that one colour is transparent, this may be chosen if the data for this X ray
port is not to be displayed, useful for presence dot maps. If the b"ansparent colour
is selected when data acquisition starts, data for that port will not be acquired.

Presence Priority
On the right of the Xray set up window is a box containing all the identities of
the non b"ansparent data sources. This window detennines the priority of the
presence dot when two or more occur in the same pixel. The top of the box is the
highest priority. The priority may be changed by selecting an entry with the
mouse and dragging it to the required priority position.

Once the data has been collected the priority may be rearranged interactively to
see the effect on the display. This is non desnuctive to the Xray data.

Grey Backed
Select grey backed if you wish to retain the grey image under the dot map.
otherwise this will be set to black.

Grey Intensity
This scroll bar adjacent to the Grey Backed check box conttols the intensity of
the grey image.
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InteDSity
This radio button selects the intensity dot map mode. Adjacent to this button is a
Combo Box to define which data is to be collected. The scroll bar in the same row
as the intensity radio button defines the count value which will represent the
maximum colour brightness. At it's left position only 2 counts will be required to
give the full colour value and at it's right position a count of 128 will be required
to give the full colour value.

Linescan
This button selects Xray Linescan if the Xray Linescan licence is present

Xray Menu: Save
This command saves the current Xray set up to a file with the extension XRS in
the user directory .

Xray Menu: Load
This command loads the Xray set up from a ftle with the extension XRS in the
user directory .

Xray Menu: Start/Stop
These commands start and stop the Xray acquisition.

Xray Menu: Cear
This command clears both the Xray and Grey planes

Xray Menu: Default
This function resets the Xray set up to the default state.

Procedures

General

On entry to the Xray set up window the normal mode display LUT contents are
stored and the display LUT switched into Xray nxJde.

There are three parts to the dot map function:-

a)
b)
c)

set up of the required function
data acquisition
colour coding of the display LUT

Closing the Xray window will give an XRayReset which stops X ray acquisition
and restores the display LUT to Normal mode.
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Intensity Dot Map Set Up

In dot map intensity mode the counts are collected from one energy window. if
the count is non zero then the intensity value is inserted into the image pixel.

. Select grey backed if you wish to retain the grey image under the dot
map. otherwise this will be set to black. Select the Intensity radio button

. Select the colour for the required energy window (non transparent)

. Select the energy window from the list adjacent to the radio button

. Select Start from the menu to acquire the Xray data

LUT Manipulations on Intensity Dot Maps

After data collection:-

. The colour of the energy window may be changed

. The Max. Intensity value may be changed

Presence Dot Map Set Up

In dot map presence mode the counts are collected from all energy windows
which are defined as having a non transparent colour. If there is a count in any
window then the pixel is designated as a dot and the presence information
replaces the image pixel.

. Select grey backed if you wish to retain the grey image under the dot

map. otherwise this will be set to black
. Select the Presence radio button
. Select the colours for the required energy windows (transparent if the

data is not to be acquired)
. Select Start from the menu to acquire the Xray data

LUT Manipulations on Presence Dot Maps

During or after data collection:

. The colour of each energy window may be changed. Note if the colour
was transparent when the data was acquired then the data will not have
been collected.

When a pixel contains non zero counts on two or more ports (energy
windows) which are not transparent then the one displayed is
determined by the presence priority which may be altered as required.
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Hint

It is important to choose the con'ect colours for dot maps if they are to be output
to rnonochro~ video printers. Grey TIFF files (as seen) or clipboard

RecolnlMnded colours are:

One map
Two maps
Three maps
Four maps

white
white, dark red.
white, orange, green
white, dark red, magenta. dark green

When exporting annotation for dot maps

If the grey intensity function is used to reduce the intensity of the grey
image it will also reduce the intensity of any annotation merged with the
image for export.

Registration of Xray Data with Image

Different Xray systems may have different internal timings which may give rise
to a slight mismatch in registration between the Xray data and the image. If this
is found to be the case reducing the data acquisition scan rate will reduce the
mismatch. It may be necessary to experiment to find the fastest acquisition rate
which gives a suitable registration where high accuracy is required.

X-Ray Linescan1.24.

Introduction

When in Xray Linescan m<xie the speed is automatically reduced to a maximum
pixel average rate of 1024 and the line position indicated by a green raster line
which may be moved using the mouse in Raster control mode.

On entering Xray Linescan mode the data acquisition is initiated. The data from
up to 7 energy windows (according to configuration) is simultaneously loaded
into an internal buffer. Data from successive line scans are accumulated.

Each Energy window is identified by a user defined identifier which is defmed
in the Xray set up window.
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The Linescan data is displayed in a profile window in the same manner as the
other line profiles (e.g. Linescan, live line scan etc.) . The profile display may be
user configured from the Xray Linescan control window.

If DDE support is configured copy-link is provided.

Operation

Selection

The Xray Linescan facility may be switched on either via Top menu - scanning -
Xray Linescan or by selecting the Linescan radio button in the Xray set up
window (Top Menu - detectors - Xray).

The Xray Linescan control window may be displayed by clicking the right
mouse button over the profile window.

Controls

The facilities conttolled by this window may be performed whether the
acquisition is active or not.

Facilities provided are:-

Number of Traces
The profile may display from one to four traces simultaneously as selected from
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the drop down box. Each trace is displayed in a different colour, as shown by the
colour of the current trace selection radio buttons.

Current Trace for Control
The trace offset and scaling functions operate on the current control trace. This
b'ace is indicated by selecting one of the four radio buttons on the left of the
window.

FUter Value
The current filter value used for all displayed traces may be set using the scroll
bar at the top right of the window. This may be done at any time and is non
destructive of the acquired data.

The filter value. which is in the range I through 16. is the number of adjacent
pixel values which are ~rged to provide the ~ of the pixel. i.e. with a filter
value of 8 the pixel value displayed is the ~ of the pixel at a position and the
8 pixels preceding it and 8 pixels following it.

Trace Source Selection
The drop down box associated with each tr8':e may be set to any of the 7 energy
windows acquired. Each window is identified by the user defined identifier (see
Xray Dot map description).

Auto Scaling
When data acquisition is started each trace defaults to Auto scaling mode.

In this mode a trace has it's data scaled for display such that the maximum value
in the line will give a full scale excursion of the trace.

~ Full scale for the trace is 256 pixels with yScaU = J,

If Scale Max. has been in use auto scaling may be reselected using the check box.

Scale to Trace Point

For the current trace this scaling mode may re selected using the radio button
on the right larelled Scale Max.

In this mode a blue line is displayed in the profile window which selects an X
position on the trace. The pixel value at this position is used to define the full
scale excursion of the trace, hence pixels with greater values will be truncated at

Stereoscan 440 Operator Manual



E-64 AppeDdjx E ~oos ... ~~

full scale. The X position marker may be dragged to a new position using the
mouse. The new value takes effect when the marker is dropped.

The scaling may be returned to auto scaling by selecting the auto scale check
box.

Superimposed or onset Traces

By default all traces are superimposed on the same Y axis

If required a ttace may be offset by selecting the move trace radio button. When
in offset mode the y size of the profile is doubled permitting up to full scale
offset. note that this does not increase the full scale excursion of the ttace.

When this mode is selected a marker is displayed on the profile window showing
the current baseline of the trace. This baseline may be dragged to a new position
using the mouse. If acquisition is currently on the new baseline only takes effect
when dropped at the new position. otherwise the baseline is continuously
changed.

The speed of response is affected by the scale values chosen - the greater
the screen area to be drawn the slower the response.

To revert to superimposed b"aces select the superimpose function from the menu.

The offset values are not destroyed in superimpose mode. clicking on move
trace will restore them.

Background Colour

Using the drop down box at the bottom of the window the colour of the profile
background may be selected from one of:-

Grey
Black
Transparent

The trace colours have been selected such that they will appear white
against a black or transparent background on monochrome hard copy.
Grey will appear as black.
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Data Acquire On/Off'

v

X Scale

Y ScaJe

Drawing Active/Static

Copy-Link

Linetime
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Annotation

A set of annotation labels may be created for Linescan b'aceS

Select annotation mode (press FII);

Display the annotation pop up menu (click right mouse button over image)

Select Annotation. Xray Traces. This will create one annotation item per trace
with the identifier text.

Move these items to suitable positions

1.25. 20 Ymod

Introduction

The term Ymod comes from the technique of Y axis modulation used historically
to generate a topographical image on a display tube.

The Y mod function draws a series of line profiles scanned across the stored
image to represent the signal level in the image. A hidden line removal
algorithm gives a reasonable topological representation, although any
interpretation must be carefully considered.

Operation

Selection

Top Menu -Image - Ymod

Controls

On selection of this function the Ymod window is displayed together with it's
popup menu.

If the popup menu is closed using the Quit command it may be re displayed by
pressing the right mouse button over the Y mod window.

Amplitude Scale
This value controls the scaling of the amplitude signal. A value of 2 means that
for a grey level of 200 above the threshold an amplitude of 100 pixels is drawn.
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Line Increment
This value defmes the separation between lines scanned over the image. A value
of 4 means that every fourth line is scanned.

Threshold
This value defines the threshold grey level value below which the b"ace is drawn
as a horizontal line. Correct choice of the threshold can greatly improve the
appearance.

Coloured
This conttol selects if the b'ace is monochrome or coloured. If coloured is
selected the range of grey levels above the threshold is divided into four equal
parts. The colour of the line drawn from the previous sample point to the current
sample point is determined by the grey level of the sample point.

Superimpose
This control determines if the display is to be in a separate window (in which
case the size is determined by the X scale and Y scale settings) or superimposed
over the image.

Transparent Background
This control detennines if the background to the Y mod display is to be

b"ansparent (i.e. the image is visible behind it) or opaque.

Procedures
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2.

2.1 Stage Motorisation

The stage motorisation kit is available for either X and Y or X Y and Z stage
axes. Included are over travel protection and audible touch alarm. This
accessory is required for the software options:-

Stage Conb"ol
Stage Co-Ordinate Store and Recall
Stage Centre Feature
Stage Cenb"e Point

Stage Map
Stage Scan

2.2 High Resolution Record Unit (HRRU)

Introduction

The Stereoscan 400 Series HRRU is a pod fitted to the right hand side of the
instrument. It is connected to the instrument internally by two fibre-optic
connectors, and externally by a mains lead which is plugged into the mains
connection block at the rear of the instrument.

The HRRU is capable of taking either a Stored or a Live Image micrograph with
or without an Overlay (Data Zone or other annotation), using a variety of camera
types at different record rates and with different film speeds. It is also ~ssible to
set the development time required for a particular type of film.

In order to operate, the system must know that an HRRU is actually fitted, and
this can be checked by looking at the Options section of the Configure menu.
This is reached by selecting from the Menu Line:-

Tools -> Service ->Configure -> Options

The HRRU line should read HRRU = Mark 2
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Operation

As the HRRU is so flexible, the system has to be told exactly what type of
micrograph the operator wants to take, using which type of ~ and film
speed etc. This can be done by selecting from the menu line:-

File -> Export! Photo setup

And from the panel that is then revealed select:-

Output To = HRRU followed by Set Up

This will then reveal the Photo Set Up Panel (see Figure I) and from that the
HRRU Settings Panel (see Figure 2) can be selected.

Using these two panels every detail of how. and on what medium the micrograph
is to be recorded can be set.

Photo Set up Panel

FIgUre 1 Photo Set Up Panel
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Camera Image
Select between Live, Stored, Cal Dr, Cal Con

Camera Overlay
Select between Yes or No

HRRU Settings ->
Will reveal the HRRU Settings Panel.

Photo No =
Displays the current Photo Number and allows operator to select (by clicking the
box) a new number.

Photo Time =
Displays the time a micrograph will take for particular settings of Film Speed and
whether Photo Fast or Slow has been selected.

Camera Status =
Displays either Busy or Idle.

HRRU To Do =
Gives indication between 100 and 0% of progress of record scan.

The button marked Photo will start a record scan, while tile button marked Abort
Photo will stop a record scan immediately regardless of it's progress.

By clicking on the Developing Time = 0 ms box, the operator can enter any time
required for developing the type of film being used, and once the button marked
Start Develop Timer has been selected, this time will count down to zero to
indicate that the film has been developed correctly.

If the Output Device has already been set to the HRRU, but the conditions for
taking a micrograph need to be changed for any reason, the Photo Setup panel
can be revealed by clicking on the photo Icon of the Tool Bar with the right hand
mouse button.

Also see note on next page.
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HRRU Settings Panel

.

Figure 2 HRRU Settings Panel

Film Speed = ASA
Allows selection of ASA 800.400,200. 100 and SO.

IIRRU Camera =
Allows the following to be selected :-

12Omm Camera
35mm Camera, and
either Polaroid Types 545 or 500.

HRRU Bri&ht. and HRRU Contrast enable the Operator to set the brighb1ess
and contrast settings of the HRRU as required. This can be tested. and if
necessary adjusted. using the Grey Wedge available in the Display LUT.

Caution should be exercised when adjusting these settings as excessive
brightness can bum the HRRU Tube!

Photo Fast Pix A vI. =
Sets the fast record rate.

Photo Slow Pix A vI. =
Sets the slow record rate.
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If the box marked Fast is selected, then a fast record speed is perfonned, and if it
is not, then a slow record rate will be perfonned.

~
~

It should be noted that once the various photo settings have been made it, is
not necessary to access these panels every time that a photo dump is
required. lithe Output Device has been set to be the HRRU, all that is then
required to initiate a Micrograph recording is to select the Photo Icon in
the TOOL bar with the left mouse button. Ensure that the image is frozen, if
a Stored image is required or NOT if a Live image is required.

HRRU Camera

The Stereoscan 400 Series can accommodate a variety of camera types. Each
camera type fits onto a camera assembly which slots into the HRRU CRT
assembly. To gain access to the HRRU. simply slide the top cladding away to the
rear of the HRRU CRT assembly.

. Polaroid 545
The lens unit is setup as shown in Figure 3. The lens unit is fitted to the c~ra
body using 4 M4 X 2Omm screws.

Figure 3 Polaroid Camera Lens Mounting

The camera unit is then inserted into the camera housing with the red spot
towards the operator. It is important to ensure that the unit has been inserted as
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far as it will go, if this is not done the focus will be incorrect. The unit is clamped
in place using the knurled head screws in the upper set of screw holes. The
camera back is then fitted to the casting ensuring that the key fits into it's slot,
and is locked in place using the two sliding clamps. If the aperture is set
correctly, the unit is now ready for use.

. Polaroid 550
The setup for this camera back is identical to that for the 545 above, except for
the fact that the camera unit is inserted into the camera housing with the rm spot
on top of the casting away from the operator.

. 35mm(RICOH)
This unit complete is inserted in place of the Polaroid camera unit and is locked
into place using the knurled head screws. The shutter remote cable is plugged
into it's socket on the rear of the camera and the shutter set to 'Bulb' ( see the
camera instruction booklet).

. The l2Omm camera back will usually be sent with it's own camera assembly,
but some early Stereoscan 4OO's may have a camera assembly that is
interchangeable between Polaroid and 12Omm. The procedure to change camera
backs with this type of assembly is shown in Figure 4 as follows:-

LagEnih~ 1~~
~

~x~
~S:1afIS

~~;
!}[

- Tr~
SutErrJ

RiMXJ
~

"
-j

R8r:id
Srf)

~,\b,It
S:Ja18:ttp
t> 1a> ~

Figure 4 12Omm Camera Lens Mounting
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Remove the Camera assembly from the HRRU assembly by pushing the
top cladding back towards the rear of the instrument (it may be
necessary to loosen the fIXing screws securing the cladding from within
the HRRU pod- if they are not already loose enough), and loosening the
4 knurled knoblets. The camera assembly should now be loose enough to
pullout of the HRRU CRT assembly.

2. The lens spacer itself will be currently screwed up against a lens
positioning stop ring, this must now be screwed clockwise up to the
alternative lens stop ring at the opposite end of the lens spacer body,
using the tool provided. These lens stop rings are preset and should
not be re-adjusted.

3. The lens spacer assembly which holds the lens in the correct position
must now be reversed. This is done by removing the 4 M4 alIen screws
securing it to the camera assembly and simply inverting the spacer
assembly before refitting it back to the camera assembly.

~, Refit the lens into the spacer assembly. ensuring that the aperture is set
to the correct position.

s. The 4 knoblets that secure the camera assembly into the HRRU CRT
assembly must be fitted to the lower set of holes (there are two holes per
screw) in order to ensure that the camera assembly can be secured into
the HRRU CRT assembly correctly.

6. Refit the camera assembly to the HRRU CRT assembly, ensuring that
the red spot on top of the camera housing is away from the operator. It
is important to ensure that the unit has been inserted as far as it will go
into the housing otherwise focus will be incorrect.

7. The camera should now be fitted onto the casting, ensuring that the key
fits into it's slot, and is secured using the two sliding clamps.

8. Ensure that the correct camera type is entered in the HRRU Camera
field of the HRRU Settings panel.

9. To swap back again the reverse procedure applies.
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2.3 laB,

As soon as a LaB6 filament has been fitted into the gun it is advisable to set the
software to recognise that a LaB6 is present. This can be done by calling up the
Gun Set Up panel from the kV adjustment icon. Click on the Filament Type =
box from within the Gun selections, to call up a list of different filaments. Select
the appropriate filament type, probably this will be Denka M3. Also, if
appropriate the New Filament box can be selected, see below. Setting the
fIlament type will prevent the filament from being turned on when the vacuum
conditions are incoITect.

~
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Figure 8 Identification of Isolation Valves

Alternatively, the valve need not be closed when Vac Ready has been reached,
and the system can be operated with the valve open and the LED flashing,
especially if the vacuum in the column is good. This has the advantage that if,
when the filament is being ron up, it outgasses, the vacuum system may
overcome the temporary rise in pressure without losing the Vac Ready condition.

Once Vac Ready has been achieved it is now possible to run the filament up.
Before doing this however, it is important to check that the correct type of
filament has been entered into the Gun settings within the Gun Set Up panel, ie
either Denka M3 or Denka M7, and also whether or not the filament is new or
old (this will change the run up procedure for the filament - a new filament will
be run up more slowly than an old one to maximise filament lifetime).

'New' ftlament means that the filament has never been used and run up to any
operating condition. 'Old' means that it has been used, although it should be
noted that if a filament has only been run at a low kV, care should be taken when
running at a higher kV. If, for example, a filament has only ever been run at
5k V and the new operating requirement is now 20k V, it would be worthwhile re-
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Running the Filament Up

Standard run-up macros for Denka and Kimball LaB6 filaments are provided by
Leica. These will set the EHT to 5kV and the filament current to a value
normally below the saturation point for the appropriate filament type. It is
recommended that these are used initially when running with LaB6 and then
when the desired operating conditions are achieved that additional run-up macros
are created for future use.

To select the appropriate macro select File from the top menu line followed by
Load state. This produced a list of application macros from which the
appropriate run-up macro can be selected. Select DenkaS.app for Denka M3
filaments and KimbS.app for Kimball Physics filaments.

~ Kimball filaments run with a much lower heating current so the selection of
an incorrect macro could result in the filament being destroyed.

Once Open has been selected the macro will be loaded and run up of the filament
will commence. If there is a conflict between the conditions in the macro and
those currently set on the system then the macro will halt and a warning will be
given and the Operator will be asked whether or not to proceed. It is advisable to
select No and to investigate the reason for the conflict. Once this has been
corrected then the macro can be loaded and run again.

Once the run up sequence is completed it is advisable to check for correct
filament saturation and beam alignment. Use the Gun Align panel to select
Emiaion Image mode and adjust the filament cuuent to produce the desired
emission image (see Figures 9,10,11,12).
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Figures 9,10,11,12 Emission Images

~
~

Changes to the filament current will be implemented slowly in order to
safeguard the filament.

Use the Gun TOt conttol to position the emission image in the centre of the
screen. Then with the magnification set to very low and Optibeam depth mode
selected, re-centre the emission image using the Gun shift conttols. Turn off
Optibeam depth mode and increase the magnification and fe-check the position
of the emission image, if necessary make adjustments using the Gun TOt
conttols. When the alignment has been completed the emission image mode can
be turned off by selecting the Nonnal button within the Gun Align panel.
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If preferred the beam alignment can be carried out by observing the screen
brightness while in nonnal mode and adjusting the gun tilt and shift controls to
produce the maximum screen brightness.

Once the filament has been saturated and centred correctly, the system can be
operated as normal and when, on SEM Shutdown, the Operating Conditions are
saved. the system can be brought back to these operating conditions simply by
pressing the RUNUP icon.

~:.- It is worth noting that when SEM Standby is selected. the EHT is removed
from the filament. but filament cu"ent continues to flow through it at a
reduced level. thus keeping the filament wann and improving stability.

Sample Changing

When changing the sample. it is only necessary to close the column isolation
valve before venting the chamber (the gun isolation valve should already be
closed). The filament will remain on during this operation. but the EHT. will be
turned off. When the chamber has been pumped out again and the vacuum ready
state achieved. the column isolation valve can be re-opened. whereupon the EHT
will be switched back on and the image restored. It is advisable at this point to
check the beam alignment by adjusting the Gun tilt for maximum signal
brightness.

2.4 Scanning Transmission Detector

From an Operators' point of view, the S'lEM attachment is comprised of three
main parts:

The detector assembly. which houses the BSD diode. and should be
fitted at the rear of the stage assembly. The detector assembly has a hole
cut out of a metal plate. beneath which can be seen the detector diode.

2. The STEM sample holder which fits onto the SEM ZTR module in place
of the standard SEM carousel. This is a circular assembly. with a series
of small holes on it's perimeter which accommodate the transmission
samples which are held in special holders.

3. The SlEM detector eleCbical feed-through, which is nonnally mounted
on one of the .. ears" of the SEM chamber. The Operator must connect

the cable coming from the SlEM detector to this feedthrough before use
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Assembly

Assembly of the STEM detector is a very simple procedure.

. Remove the ZTR module from the stage in the nonna] manner.

. Position the STEM detector assembly onto the rear of the stage.
Underneath the detector assembly are two pins, these help to locate the
detector assembly correctly onto the stage where it can then be secured
using the two M3 x 12 screws provided.

. Refit the ZTR module onto the SEM stage, ensuring that there is enough
Z clearance to allow the STEM sample holder to be fitted without hitting
and damaging the STEM detector.

Once the samples have been mounted into the STEM sample holder. this
can then be fitted in place of the normal SEM carousel. It is a good idea
to position an empty sample hole over the detector cut-out to aid final
positioning of the stage during operation.

. Partially close the stage door ensuring that there is adequate clearance
for the stage beneath the final lens and any other detectors in the
chamber, and carefully fit the cable from the detector to the feedthrough.
Ensure that this cable will not foul on anything inside the chamber
during operation before closing the chamber completely and pumping
the system down again.

Operation

To use the S1EM detector. it is first necessary to ensure that the stage with the
S1EM sample holder is con-ectly positioned over the S1EM detector to allow the
electron beam to pass through the sample holder and reach the S1EM detector.
This is the reason for leaving a empty sample hole over the detector during
assembly. Using the stage X and Y controls manoeuvre the stage in order to find
this empty sample hole whilst viewing the image with the SE detector. and once
found it is wise to record this position to simplify S1EM operation and assembly
on the next occasion. Typical figures should be about X = 49.2 and Y = 10.1.
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Now that the stage has been correctly positioned over the S1EM detector it is
now simply a case of providing the correct SEM operating conditions to provide
good S1EM imaging for the sample being investigated. Typical working
conditions would be

kV
IProbe
WD

20-40kV
5-5OpA
5 - 12rnm (WD is limited by the height of STEM Detector)

All of these parameters depend on the type of work being undertaken and the
resolution required.

The next step is to select the QBSD detector (the SlEM is a BSD variant using
the same input into the SEM) from the Select Signal A in the Detector pull down
panel selected from the Men" Line, and to ensure that the SlEM detector diode
quadrant configuration has been set correctly which is as follows :-

Ql = OFF Q2 = INVERT Q3 = NORMAL Q4=OFF

To achieve STEM imaging all that is now required is to set the Brightness and
Contrast settings to provide the correct video levels for your sample.

2.5 Specimen Current Monitor

The Specimen Current Monitor (SCM) is both a specimen current measurement
tool and an imaging device that can also provide an image of absorbed current
from a sample. It is mounted on the left hand side of the chamber and connects to
the specimen contact feed through on the stage door in place of the specimen
touch alarm cable.

Operation

Image Mode

Select the Specimen Current panel from the Detector menu (not
available on software version VO2.0l). Alternatively, select the
following from the Status! menu - SCM mode, SCM range, SCM
Image, SCM Measure and Specimen I.

2. Obtain a secondary electron image and bring it to focus.

3. Select SCM from the Select Signal A field in the Detector menu
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4. Select SCM Image from the Specimen Current panel or from the
Status! menu, set Brightness to 50% and adjust Contrast until an
image is seen. Then adjust Brightness and Contrast to obtain the
required image.

At low probe currents i.e. on SCM ranges lower than loA full scale, the image
can become degraded by mains field effects and other forms of interference. Also,
on these ranges, the signal bandwidth is very low. The use of long scan times will
overcome the bandwidth restrictions and will also help to reduce interference
effects, but image quality may not be perfect under these conditions.

Measure Mode

Because of the way in which the SCM is configured, selecting Measure mode
increases the Image mode signal level. If you wish to measure the specimen
current in a displayed specimen image, Freeze the image before proceeding.

Select SCM Measure from the Specimen Current panel or from the
Status! menu.

2. The specimen current measured will be displayed beside the Specimen I
legend in the Specimen Current panel or in the Status! menu.

3. To measure the current at one particular point on the specimen, select
Spot from the Scanning menu, click on the cross and drag it to the point
of interest.

Specification

Measurement mode

Measurement Range
Bandwidth
Resolution
Accuracy
Residual Error

lOpA to l00~ in 12 ranges (auto ranging)
5Hz
IpA
:t 2% of Full Scale
< IOpA

Image Mode

Image Range (Full)
Image Range (Useful) *
Bandwidth

3pA to IOJiA in 13 ranges (selected by Contrast)
InA to IOJiA
6kHz to 2MHz (see Table on next page)
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.

. Images can be obtained at currents below I nA. However, at such low currents,

images cannot be guaranteed to be free of mains field effects and other fonDS of
interference.
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Index

A
BEEPc<*s, 6-2
Binary images, 2-46
BIOS, 6-2

Error codes, 6-2
Blanking the beam. 2-23
Brightness, 1-19, 2-24
BSD,2-28

C

Cleaning
Aperture assembly, 5-7
Column, 5-5
Gun assembly, 5-6
Recommendations, 5-3

Clipboard,2-47
Copy to, 2-47
Paste from. 2-48

Collector bias, 2-28
Column, 1-1

Servicing, 5-3
Compo, 2-28
Compression, 2-44
Context sensitive help, 1-4
Contrast. 1-19,2-24
Critical point drying, see Specimen Preparation
Crosshairs, 2-39
Current zone, 2-26
Cycle time, 3-19

0

Datazone, 1-13,2-33
Defect causes, 3-38
Depth of focus, 2-18. 3-7
Derivative, see Appendix E
Desiccant, 5-2
~~..Qf

Conb'ol, 2-27
Menu, 2-2

Develop~t timer. 2-41
Diagnostic aids, 6-1
Directory, 4- 2
Display LUT, 3-20

Accelerating voltage, 2-17, 3-2
Adjustable ~ced raster, see Appendix E
Adjusting the aperture, 2-18
Advanced

Annotation, see Appendix E
Measurenx.l1t, see Appendix E

Air drier, 5-2
Air drying, see Speci8en PrepGnItion
Alignment. 1-21
Anchor symbol. 2-25
Annotation, 2-31

Files, 2-34
Modes. 2-32
Objects, 2-32

Anode spacer. 2-10
Aperture. 3- 7

Adjust. 2-18
Size. 2-18

Attributes, 2-36
Auto

Resolution mode, 2-17
Signal level, 2-24
Stigmation, 2-20, 2-21, 2-22

Auto Focus
Coarse, 2-20
Fine, 2-20

Auto focus, 2-19

B
Backscattered. 3-6

Detector,2-28
Elecb'Ons. 3-4

Beam, 1-24
Alignment. 1-24
Damage, 3-2
Menu, 2-2
Shift. 2-23

Beam alignment
Automatic, 2-15
Manual. 2-15
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DOS, 4-1
Dose rate, 3-12
Dual magnification, see Appendix E
Dynamic

Focus, 2-31
Stigmation, 2-21

Dynamic stereo, see Appendix E

E

Edge effect. 3-4
Edit menu, 2-3
EHT,2-17
Emission image, 1-22

F

G
Gamma and Input LUT, see Appendix E
Goto mode, 2-13
Graticule, 2-39
Grey dir, 2-46
Grey wedge, 3-22
Gun alignment, 1-22

H
Hard disk drive, 1-2
Hard samples, 3-16
Help menu, 2-4
Histogram. 2-30
Housekeeping, 4-11
HRRU, 2-39, 2-40, see also Appendix E
HRRU camera, 2-41, see also Appendix E

I

Icon, 1-12,2-4
Bitmaps, 3-35
Edit, 3-34
Selection, 1-5

Image
Defects, 3-37
Export, 2-43
Import, 2-45
Maths, see Appendix E
Menu, 2-2
Processing, 2-24
Window, 1-5, 1-12

Inputs, 2-25
Invert, 3-23

J

Joystick mode. 2-13

K

Fast, 1-24
Filament

Change, 2-8
Current, 1-21,2-14
Life, 6-8

Filament Setting
LaB6t 2-14
Tungsten, 2-14

File meDl', 2-1
Film speed, 2-40
Final aperture, 1-23
Find Image, 2-22
First peak. 1-21
Floppy disk drive, 1-2
Focus, 1-19

Scan, 2-20
Wobble, 1-24

Fonts, 2-35
ForD) feed, 2-42
Four Quadrant BSD, 2-28

Fast, 2-28
Gain, 2-28

Frame average, 2-29, 3-19
Frame corrected focus, 2-31
Freeze, 2-29

At end, 2-29
Freeze drying, see Specimen Preparation

Keys, 1-7

L
LaB6t 1-2, see also Appendix E
LaB6 emitter, 6-10
LEO
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Fine, 1-6
Left button, 1- S
Middle button, 1-6
Right button, 1-7

N

Navigation box, 1-14
New fil~t, 6-9
Noise reduction, 2-29, 3-19, 3-20

0

Directory SbUcture, 4-4
Error messages, 6-10
Standby icon, 1-16
UIF,4-1
UIF icon, 1-16

Line
Average, 2-29, 3-19
Cursor, 2-29
Scan, 2-29

Linewidth. 2-38
Links, 2-35
Live line scanning, 2-29
Load

Conditions, "3-31
Low mag, 2-23
LUT

atPoint, 3-22
Brightness and conb'ast, 3-23
Gamma. 3-23
Invert, 3-23
Level,3-21
Monochrome, 3-23
Points, 3-21
Save and load, 3-24
Steps, 3-24
Threshold, 3-21

M

Oil mist filter, 5-3
On-line Help, 1-3
Optibeam, 2-18, 3-7
Overlay plane, 2-32

P
Panel selection, 1-7
Panels, 2-33
Paper size, 2-42
Parameter adjustment, 1-6
Paste,2-48
PC plane, 2-47
Photo, 2-39
Photographic considerations, 3-1
Pins, 2-35
Pixel average, 2-29, 3-19
Point to point measure~t, 2-37
pop-up menu, 1-6
Port expansions from 4 to 8, see Appendix E
Power on self test. 6-2
Precision adjustment, 2-38
Probe current, 1-20,2-17,3-6

Q

Quad nxxIe, 2-26
Quarter screen DK)(ie , 1 - 12

R

Recording an image, 2-39
Reduced nxJde, 2-27
Remove hysteresis, 2-20
Replication, 3-17
Resolution, 1-20,3-6

Macro, 3-24
Control structures, 3-26
Editor facilities, 3-28
Execution, 3-29
Instructions,3-25
Libraries,3-29
Record, 3-29

Mag table. 2-23
Magnification, 1-19,2-22

Control window, 1-13
Measurement. 2-31
Micrograph. 2-39
Micron marker, 2.37
Motorised stage. 2-12
Mouse

Coarse, 1-6
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1-4 Index

Specimen Current Monitor, see Appendix E
Speci~n Preparation

Conductors, 3-14
Non-conductors, 3-15, 3-16

Split screen, 2-26
Spot nK)de, 2-30
Stage

Centre feature, see Appendix E
Centre point, see Appendix E
Co-ordinates, see Appendix E
Control, see Appendix E
Initialisation, 2-12, see Stage Control
Limits, see Stage Control
Map, see Appendix E
Motorisation, see also Appendix E
Move, 2-13, see Stage Control
Scan, see Appendix E
Scan patterns, see Stage Scan
Window, 1-14

Stage/Vac ~nu, 2-3
Standard, 3-31
Standby,I-16
Standby button, 1-15
Starting up, 1-15
Static stereo, see Appendix E
Status

Window, 1-13
Status display, 3-32
Subdirectories, 4-3
Surface detail, 3-3

T

Rotary pump
Oil. 5-2
Oil level. 5-1

RS232 remote control. see Appendix E
Run up. 1-18

S
Save

As text, 3-28
As 11FF. 2-43
Conditions. 3-31

Scan
Modes. 2-25
Rate. 2-29
Rate (Expanded). see Appendix E
Rotation. 2-26

Scanning ~nu. 2-3
Scanning Transmissio:l Detector. see Appendix E
Secondary electron yield. 3-10
Secondary electrons. 3-4
Shutdown. 1-16
Shutting down. 1-16
Signal

Invert, 3-23
Level. 2-24
Signal to noise. 1-20

Signal level
Auto. 2-24
Fmd. 2-24
Keep. 2-24
Mean. 2-24
Peak. 2- 24

Signal mixing. see Appendix E
Signal to noise ratio. 3-19
Soft samples. 3-17
Special characters. 2-34
Specimen

Chamber. I-I
Change. 2-6
Charging. 3-5. 3-9
Parameters. 3-39
Preparation. 3-13
Stage. 1-1
Tilt. 3-8

Text annotation. 2-34
Text attributes. 2-35
11FF file. 2-39. 2-43
Tilt compensation. see Appendix E
Time and date. 2-36
Tip position. 2-9
Toolbar.I-12

Edit. 3- 34
Icons. 3-35

Tools ~u. 2-4
Top window. 1-5. I-II
Topo. 2-28
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~
Index .5

Trackerball, see Appendi.J: E
Tungsten emitter, 6-9

u
User directory, 4- 7
User interfKe. 3-20
User serviceable items. 5-1

V

Vacuum. 2-11
Leak Detection, 5-9
System. 1-2

Vent. 2-7
Video print. 2-41
Video printer, 2-39
View ~nu, 2-2

W

Window ox)(je, see Appendix E

Window~
Applications, 1-3
error, 6-24

Woti>le, 2-18
Working distance, 3-6

X

X-Ray
Analysis, 3-6, 3-7
Dot Mapping, see Appendix E
Linescan, see Appendix E
Production, 3-5

y
Y mod, see Appendix E

Z
Zone, 2-25

Magnification, 2-37
Panels, 2-33
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Appendices

I ARRO~ ~ys to con~ Mag/FOCUS

s+Shift

ARROW keys to control Stage XY position (or stage
tiltlrotate position if ~hift Is used with ARROW keru
ARROW keys to control Step field-

T Displays d1e vacuum status informationff
~

1+ I Increments the scan rate
Decrements the scan rate

I Space ~lay PC plane if hidden by sbift-F3I

Followed by arrow key movements allow navigation of
the pull-down menus of the cunently selected window




